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Preface
Use the Informatica® Multidomain MDM Data Director User Guide to learn how to create, consume, manage, 
and monitor master data in Data Director. You can manage business entity records or subject area records. 
Learn how to manage records, manage relationships between records, and update records. This guide 
contains two parts that explain how to use Data Director with business entities and how to use Data Director 
with subject areas.

If a Data Director application uses business entities to organize the data, see the following topics:

Goal Where to Start

Chapter 2, “Getting Started” on page 26 Home page

Chapter 3, “Adding Business Entity Records” on page 35 New tab

Chapter 5, “Finding Records” on page 53 Search box

Chapter 7, “Editing Records” on page 67 Business Entity view

Chapter 9, “Resolving Duplicate Records” on page 89 Matching Records view

Chapter 10, “Establishing the Best Version of the Truth” on page 99 Cross-reference Records view

Chapter 11, “Investigating Data Changes” on page 103 History view

Chapter 13, “Investigating Data Change Events for Effective Periods” on page 119 Timeline view

Chapter 20, “Investigating Hierarchies and Relationships” on page 161 Hierarchy view

Chapter 24, “Participating in Review Processes” on page 188 Task Manager

If a Data Director application uses subject areas to organize the data, see the following topics:

Goal Where to Start

Chapter 14, “Adding Subject Area Records” on page 124 New tab

Chapter 16, “Merging Records in the Matches View” on page 132 Match Merge Comparison view

Chapter 17, “Unmerging Records in the XREF View” on page 137 XREF view

Chapter 15, “Investigating Data Changes in the History View (Legacy)” on page 127 History view

Chapter 18, “Search Queries from the Data Tab” on page 143 Data tab
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Goal Where to Start

Chapter 19, “Working with Records in the Data Tab” on page 154 Data tab

Chapter 22, “Importing Data” on page 177 New tab

For key concepts, see the following topics:

• “Business Entities” on page 17

• “Subject Areas” on page 17

• “Records” on page 16

• “Best Version of the Truth” on page 17

• “Search and Compare” on page 18

• “Merge” on page 18

• “Hierarchies Manager Relationships” on page 19

• “Review Processes and Tasks” on page 18

Informatica Resources
Informatica provides you with a range of product resources through the Informatica Network and other online 
portals. Use the resources to get the most from your Informatica products and solutions and to learn from 
other Informatica users and subject matter experts.

Informatica Network
The Informatica Network is the gateway to many resources, including the Informatica Knowledge Base and 
Informatica Global Customer Support. To enter the Informatica Network, visit 
https://network.informatica.com.

As an Informatica Network member, you have the following options:

• Search the Knowledge Base for product resources.

• View product availability information.

• Create and review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to find product resources such as how-to articles, best practices, video 
tutorials, and answers to frequently asked questions.

To search the Knowledge Base, visit https://search.informatica.com. If you have questions, comments, or 
ideas about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.
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Informatica Documentation
Use the Informatica Documentation Portal to explore an extensive library of documentation for current and 
recent product releases. To explore the Documentation Portal, visit https://docs.informatica.com.

If you have questions, comments, or ideas about the product documentation, contact the Informatica 
Documentation team at infa_documentation@informatica.com.

Informatica Product Availability Matrices
Product Availability Matrices (PAMs) indicate the versions of the operating systems, databases, and types of 
data sources and targets that a product release supports. You can browse the Informatica PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services 
and based on real-world experiences from hundreds of data management projects. Informatica Velocity 
represents the collective knowledge of Informatica consultants who work with organizations around the 
world to plan, develop, deploy, and maintain successful data management solutions.

You can find Informatica Velocity resources at http://velocity.informatica.com. If you have questions, 
comments, or ideas about Informatica Velocity, contact Informatica Professional Services at 
ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that extend and enhance your 
Informatica implementations. Leverage any of the hundreds of solutions from Informatica developers and 
partners on the Marketplace to improve your productivity and speed up time to implementation on your 
projects. You can find the Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center through the Informatica Network or by telephone.

To find online support resources on the Informatica Network, click Contact Support in the Informatica 
Intelligent Cloud Services Help menu to go to the Cloud Support page. The Cloud Support page includes 
system status information and community discussions. Log in to Informatica Network and click Need Help to 
find additional resources and to contact Informatica Global Customer Support through email.

The telephone numbers for Informatica Global Customer Support are available from the Informatica web site 
at https://www.informatica.com/services-and-training/support-services/contact-us.html.
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C h a p t e r  1

Introduction
This chapter includes the following topics:

• Data Director Overview, 15

• Key Concepts, 16

• Logging in to Data Director, 21

• User Interface, 22

Data Director Overview
Data Director is a data governance tool. Use Data Director to create, manage, and use the master data that is 
stored in an MDM Hub Store. Master data is the collection of records that represent the best version of the 
truth about the people, places, and things that are important to your organization.

A master data domain is an area of data critical to the organization that is managed at the enterprise level to 
support semantic consistency across the organization. Common master data domains include Customer, 
Supplier, Location, Channel, Partner, Product, Asset, and General Ledger Account. Multidomain master data is 
the mastering of critical data across multiple master data domains concurrently. Multidomain MDM 
encompasses related master data domains that are central to an organization's business and business 
processes. The observations that arise out of multidomain master data are of significant interest to business 
executives. For example, in a healthcare organization, the relationships among doctors and healthcare sites 
might reveal gaps in services.

Your MDM administrator configured the application you use within Data Director. The MDM administrator 
implemented the master data domains by building data structures with a name that is meaningful for your 
organization. For example, Patient is an implementation of the Customer master data domain. The data 
structure relates records within a tree structure, with a root record, nodes, and child records. The MDM 
administrator can use one or both of the following data structures: business entities and subject areas. Each 
type of data structure comes with its own set of views for Data Director. Ask the MDM administrator which 
one is used in your application, and follow the instructions in the matching part.

This guide is organized into two parts that tell you how to use the available views:

• Data Director with Business Entities

• Data Director with Subject Areas

Based on your user role privileges, you can use the application to perform the following activities:

• Add records

• Find and edit records
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• Verify that records contain the most reliable data from all source systems

• Identify duplicate records and resolve them by merging the records

• Investigate changes to the data in records

• Unmerge merged records

• Manage relationships between records

• Participate in review processes for new and changed records

Key Concepts
To work effectively in Data Director, you need a basic understanding of Informatica Master Data Management 
concepts.

Records
When you use Data Director, you are working with master records.

Master Records

A master record contains a root record and multiple child records. In Data Director, the structure and 
display of the master records depends on the structure defined in either business entities or subject 
areas.

Root Records

The root record contains the data that identifies the record. For example, the root record for John Smith 
contains data such as first name, last name, gender, and date of birth.

Child Records

A child record contains data that is associated with a root record. For example, a child record for John 
Smith might contain addresses while another child record contains phone numbers. Child records can 
have their own child records.

Active Records

Active records contain approved master data.

Pending Records

When you make a change to a record, the change might need to go through a review workflow before it 
can be approved as master data. While the record is pending approval, the record is called a pending 
record and you are restricted in the actions that you can perform on a pending record. When the change 
is approved, the record returns to the active record state.

Source Records

Source records contain the data that MDM used to create the master records that you see in Data 
Director. Source records are stored in source systems throughout your organization.
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Business Entities
Business entities are an implementation of master data domains in your application. For example, the 
Customer master data domain can be implemented in the following types of business entities: Person, 
Patient, or Policy Holder.

The business entity data structure maps to the base object tables in the Operational Reference Store 
database. The base object tables contain all the master records. For example, the root node of a business 
entity corresponds to the root base object table. A child node in the business entity corresponds to a child 
base object table. Business entities can have an unlimited depth, though the views that display the child 
records might not be able to show all levels in a meaningful way beyond a certain depth. 

Related Topics:
• “Records” on page 16

• “Adding a Record” on page 37

• “Adding a Person Scenario” on page 36

• “Editing Records” on page 67

Subject Areas
Like business entities, a subject area is an implementation of a master data domain. Subject areas are the 
original data structure used in Data Director.

The data structure supports three levels: parent, child, and grandchild. The parent level corresponds to the 
root base object table. The child and grandchild levels are child records.

Note: Some applications for Data Director rely on the subject area data structure and custom code, and 
therefore have not been migrated to business entities. If you have questions about your application, contact 
your MDM administrator.

Best Version of the Truth
When you view a record in Data Director, you view master data that is consolidated from source systems in 
your organization, including Data Director. The MDM Hub loads data from the contributing source systems. 
The load process uses a trust framework and rules to decide which cells from all the contributing source 
systems are most likely to contain accurate, up-to-date data. The consolidated record represents the best 
version of the truth (BVT) that is available across your organization.

Note: A BVT record is also known as master data, a golden profile, or a golden record.

For example, consider a car manufacturer that offers an incentive program to employees to buy cars. To 
construct BVT customer records, the data steward identifies the contributing source systems as the 
customer relationship management (CRM) system and the human resources (HR) system. The data steward 
trusts the employee address and telephone number from the HR system more than the same information in 
the CRM system, because employees are required to notify the human resources department of any changes 
to their contact information.

Data Director is a special type of contributing source system. Usually, data stewards set Data Director to the 
highest trust level of all contributing systems, which means that when a user edits data in Data Director, the 
edit is preferred over other source systems. You can also choose to override the automated BVT process and 
select a cell value you know is accurate.
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For example, the following table shows data coming from two source systems and from Data Director:

Source Last Name First Name Telephone Telephone Trust

HR System Brown Nancy 555-1235 80

CRM System Brown Nancy null 50

Data Director Brown Nancy 555-1234 90

Because Data Director has the highest trust score for telephone numbers, the updated telephone number is 
used. The data steward can add rules that cause the trust value to increase or decrease for a system. For 
example, if the telephone number is subsequently updated in the HR system, the system might prefer that 
telephone number because it was updated most recently.

Search and Compare
A best practice in data governance is to check for existing records before adding new records. When you 
begin adding a record, Data Director (IDD) searches for duplicate records.

You can preview the potential duplicate records as they appear and take one of the following actions:

• If more than one record is a potential match for the record you are adding, you can compare the records 
side by side. If you find that the records are duplicates, you can initiate a merge.

• If one record matches the record you are adding, you can open the record and begin working with it. In this 
case, the record that you started adding is discarded.

• If none of the records is a match, you can continue adding the new record.

The MDM administrator configures the fields to use in the search for potential duplicates. 

Merge
After you compare records, you can merge records that appear to be duplicated.

When you merge a record, the root records of the merged record are consolidated into a single root record. 
The child records from each of the root records become child records of the merged root record. 

Related Topics:
• “Resolving Duplicate Records” on page 89

Review Processes and Tasks
A review process is an automated business process. When a user adds, edits, merges, or unmerges records, 
the action can initiate a review process. A review process ensures that business managers or data stewards 
review and ultimately approve the data before it becomes master data. 

Your user role determines whether a change to the master data triggers a review. For example, if your user 
role permits you to add or edit data but not approve changes, then when you save an edit or merge records, 
the action triggers a review process.

A review process contains people activities. A people activity is a point in the review process when the 
process requires human participation. When an instance of a review process reaches a people activity, the 
review process sends a task notification. Business managers and data stewards receive task notifications in 
their task inboxes. 
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Related Topics:
• “Participating in Review Processes” on page 188

• “Example of a Review Process for Edits” on page 188

Business Entity Relationships
A relationship is a connection between two business entities. In Data Director with business entities, you can 
create hierarchy relationships and network relationships between business entities.

hierarchy relationship

A hierarchy relationship is a connection between two business entity records that is hierarchical. For 
example, the Informatica business entity the parent of the John Smith business entity.

network relationship

A network relationship is a connection between two related business entity records. For example, the 
John Smith record is related to the PX100 Keyboard record.

You use the Hierarchy tab in the entity tab to investigate hierarchy relationships for a record. You use the 
Network tab in the entity tab to investigate network relationships for a record.

The MDM administrator configures relationships between business entities. You can create relationships 
between records based on the relationships between business entities.

Hierarchies Manager Relationships
A record can have relationships with other records. When the Hierarchy view is enabled, you can view a graph 
that shows how a record is related to other records.

You use the Hierarchy view to investigate Hierarchy Manager relationships in Data Director with subject 
areas. You can view hierarchical relationships, such as an employer-employee relationship, as well as 
relationships that are not hierarchical, such as peer relationships.

Security and User Roles
An MDM administrator creates user roles, configures permissions to resources and privileges for the user 
roles, and assigns a user role to all user accounts. Based on your job requirements, your access to master 
data might be different than your colleagues.

Types of security for business entities records

The following types of security exist:

Access to records based on the type of business entity

A user role is granted permission to all types of business entities or some types of business entities. For 
example, you can see the types of business entities that you have permission to create in the New dialog 
box. You might have access to the business entities Customer and Product, but someone else might 
have access to the business entities Product and Supplier.

Actions you can perform on a record

Your user role grants you a set privileges to the records for each type of the business entities. For 
example, a business user might have permission to read and create Customer records, but a data 
steward might also be able to delete and merge Customer records. The privileges can be different for 
different types of business entities.
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In Data Director, your user role privileges control the types of actions you can perform:

• Create. You can create and save new master records.

• Read. You can view master records.

• Update. You can edit and save records.

• Delete. You can delete master records.

• Merge. You can identity and merge duplicate master records.

• Unmerge. You can unmerge a previously merged master record.

Access to records when a field contains a specified value

Your user role privileges might be constrained by field filters, which control whether you have access to 
the master record based on a value in a field. If a record contains a value specified in a field filter, the 
user roles are allowed or denied access to the record based on the rules that are defined in the filter.

Access to a parent record when a child node has no records

Your user role privileges might be constrained by node filters, which control whether you have access to 
a parent record when the node contains no child records.

Access to fields in a record

Some fields might be hidden from your user role. For example, a view of a Supplier business entity might 
show a DUNs number to people in the finance department, but not to people in the line of business.

Values you can input

Some fields might restrict the values that you can select or add based on your user role.

Values in reference entities

Some fields might restrict the values that you can select from a list of common values, such as country 
or gender, based on your user role.

Losing access to records

You might lose access to a record that you have accessed in the past.

A loss of access can occur under the following circumstances:

• You or someone else makes a change to a field value such that the record is now denied to your user role. 
For example, you add a European address to a person record and enable the GDPR check box. After you 
save the change, only the EU data stewards can access the person record.

• The MDM administrator creates new field filters or node filters on a business entity. One or more of the 
filters contain a rule that denies access to your user role.

• The MDM administrator changed the user role to which you were assigned.

• The MDM administrator modified the privileges for your assigned user role.
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Logging in to Data Director
To log in, you need the URL for Data Director and your user credentials. If your organization has created more 
than one application for Data Director, you also need the name of the application. If you do not have this 
information, contact your MDM administrator.

Note: If you cannot log in to the application and you are already running another MDM application in the 
browser, open a new browser window to log in to the application. The issue occurs because the application 
server that runs the MDM Hub uses the same session ID for both applications. 

1. Open a supported browser, such as Chrome. 

2. Enter the URL for Data Director. The URL has the following format: 

http://<MDM Server host name>:<MDM Server port number>/e360/mdm/entity360view/
The Log In page opens. 

3. Enter your user name and password. 

4. Click Log In. 

5. If prompted, select an application. 

The application opens and displays the Home page. Your username appears in the application header. 

Tip: From the menu beside your username, you can change your password and change the language of 
the user interface.

Configuring Microsoft Internet Explorer
If you launch Data Director in Microsoft Internet Explorer, to ensure that the data changes appear in the user 
interface, configure Microsoft Internet Explorer to reload the web pages. Otherwise, after a data change, you 
might see the cached data instead of the latest data.

1. Start Microsoft Internet Explorer. 

2. Click Tools > Internet options. 

3. On the General tab, configure the browsing history settings to check for newer versions of stored web 
pages every time you visit the web page. 

The settings ensure that the latest version of the Data Director pages appear.
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User Interface
The Data Director user interface contains a navigation bar with tabs.

The following image shows the user interface with the Home page displayed:

1. Navigation bar
2. Page area
3. Search box
4. User options

The navigation bar contains tabs that link to pages within Data Director. A tab contains a page area with one 
or more panels. In some tabs, you can switch between different views within the page.

Note: Some tabs might not be visible in Data Director. For example, if the MDM administrator configures an 
application for Data Director with business entities, the MDM administrator might remove the Data tab.

Data Director has the following tabs:

New

Use the New tab to create records, and, if configured, import data.

Note: In the New window, if you see both the Business Entity option and Subject Area option, ask the 
MDM administrator which one to use. The Business Entity option opens an entity tab while the Subject 
Area option opens the Data tab.

Home

Use the Home page as your MDM dashboard. Managers and data stewards can view a list of review 
tasks in the task inbox. You might see other components, such as social media feeds, external URLs, and 
charts. The MDM administrator configures the Home page.

Task Manager

Business users and task administrators use the Task Manager to review changes to business entity 
records and manage tasks. When you click a task on the Home page, the Task Manager opens and 
displays the record associated with the task.

Data

Use the Data tab to search for and view subject area records from different perspectives.

Note: If a Data Director application uses business entities and the Data tab is hidden, the records open in 
an entity tab that displays the name of the business entity type.
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The Data tab has multiple views:

• To find a subject area record, run a search query from the Data tab. Use search tabs to manage and 
use search queries to find subject area records.

Note: If a Data Director application uses business entities and the Data tab is hidden, use the Search 
tab or Search box.

• To view and edit a subject area record, select a record and click Open. The record opens in the Data 
view.

• To view the source of the record and pending changes, use the XREF view.

• To view past changes to the record, use the History view.

• To view a subject area record and potential duplicate records, use the Match Merge Comparison 
view.

• If the subject area record contains effective dates, you can view scheduled changes in the Effective 
Periods view.

• If the Hierarchy Manager is enabled, you can view the subject area record and its related records in 
the Hierarchy view.

Search

When you run a search from the application header, the Search tab displays the results of the search. 
You can open business entity records from the search results.

Entity tabs

In the search results, select a business entity record and open the record in a temporary entity tab. The 
name on the tab identifies the opened record, usually by the name of the record, but the tab name is 
configurable. You can view or edit the master data for the record in an entity tab.

Note: If a Data Director application uses subject areas only, the entity tab is unavailable and the records 
open in the Data tab.

In an entity tab, you can open the following views in a tab:

• To view and edit business entity records, use the Business Entity view.

• To view the source of the business entity record, use the Cross-reference Records view.

• To view past changes to the business entity record, use the History view.

• To view a business entity record and potentially duplicate records, use the Matching Records view.

• To view the hierarchy relationships for a business entity record, use the Hierarchy view.

• To view the network relationships for a business entity record, use the Network view.

• If the business entity record contains effective dates, you can view the scheduled changes in the 
Timeline view.

Note: If your MDM administrator created custom record views, you might see different tab names.

Other Tabs

The MDM administrator can configure other tabs.

Additional Pages

The MDM administrator can configure additional pages for a Data Director application that uses the 
business entity model. Additional pages are custom pages that are associated to a custom tab and 
display information that is useful to users.
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Record Views
Based on how the MDM administrator configured your application for Data Director, you might have more 
than one way to access master data. When you access master data in Data Director, you use record views. 
You might have record views for business entities or record views for subject areas.

Usually the MDM administrator configures an application to use either business entities or subject areas. If 
you do not see the Data tab in the navigation bar, you have access to record views for business entities. If 
you see the Data tab, you have access to record views for subject areas.

If the application supports both business entities and subject areas, you have a hybrid application and both 
types of record views are available. In this case, you see the Data tab in the navigation bar. Also, when you 
use the New tab to create records, the Business Entity option and the Subject Area option appear.

Regardless of how you add a record, the MDM Hub Store saves the record that makes up the business entity 
or subject area in the same way. A parent record contains the identifying information. Child records contain 
other types of related information, such as addresses or telephone numbers.

The following table describes differences between records views for Data Director with business entities and 
record views for Data Director with subject areas:

Elements Data Director with Business Entities Data Director with Subject Areas

Access to record view Use the tabs in an entity tab. Use the tabs in the Data tab.

Data in the record view Master data
Optionally, related data from external sources, 
such as social media.
Optionally, other panels, such as a Similar 
Records panel.

Master data

Core entities 
representation

Business entities Subject areasl

Nesting records Business entities can have an unlimited depth 
of descendant records.

A subject area can include descendant 
records up to the grandchild level.

Language in the user 
interface

You select the language to use. In the 
application header, select the menu beside your 
username and select Change Language.

You select the language to use. In the 
application header, select the menu 
beside your username and select Change 
Language.

Search Smart search, which performs a full-text 
search.
In the Search box in the application header, 
type your search term.
In the Search tab, type your search term in the 
Search box.
In the Search box in the Task Manager, type 
your search term.

Search queries, which searches for terms 
by field.
Click Data, and then use an existing 
search query or create a new search 
query.
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Elements Data Director with Business Entities Data Director with Subject Areas

Supported in Data 
Director version

10.0 and later All supported versions

Data Director 
applications using the 
record views

Applications developed for Data Director 
version 10.0 and later.
In addition, MDM administrators can update 
older applications.

Applications developed for Data Director 
version 9.7.x and earlier.
Note: Some applications based on 
subject areas include customizations 
that cannot be easily converted to 
business entities.

Related Topics:
• “Data Director with Subject Areas” on page 123
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C h a p t e r  2

Getting Started
This chapter includes the following topics:

• Getting Started Overview, 26

• Home Page, 27

• Start Page, 30

• Sorting and Filtering Tasks, 30

• Refreshing Data in the Home Page, 32

• Configuring the Columns for the Task Inbox, 32

• Localizing Your User Interface, 32

• Bookmarking Your User Interface, 33

Getting Started Overview
After you log in to Data Director, you see the Home page. The Home page is unique to your organization and 
to your user role.

Based on the Home page layout, you might be able to monitor data in reports, monitor social media feeds, run 
a search in an embedded search engine, and organize your task inbox.

Related Topics:
• “Adding Business Entity Records” on page 35

• “Editing Records” on page 67

• “Resolving Duplicate Records” on page 89

• “Establishing the Best Version of the Truth” on page 99

• “Investigating Data Changes” on page 103

• “Investigating Hierarchies and Relationships” on page 161

• “Participating in Review Processes” on page 188
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Home Page
Use the Home page as a data monitoring dashboard. A Home page can contain charts that display 
information about your master data and display lists of available tasks in the task inbox. The Home page can 
also contain content from other external sources, such as Twitter or a search engine.

Note: The MDM administrator configures the Home pages by user role. If you and a colleague have different 
user roles, your page might look different from your colleague's page.

Charts
A Home page can contain charts. Charts visually display information about business entity records, tasks, 
and other types of information.

You can select data in a chart and navigate to a drilldown chart that provides another layer of data 
granularity. You can select data in a chart and then navigate to another interface in Data Director that shows 
the relevant records or tasks.

Note: Your MDM administrator configures your charts, including links to drilldown charts or other interfaces, 
the look and feel of charts, and the source data used in charts. Contact your MDM administrator to request 
changes to your charts.

The following image shows a chart that displays the number of tasks based on the status of tasks:
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Social Media Feeds
A Home page can include social media feeds. Social media feeds can help you keep up with your 
organization's social media presence.

For example, the following image shows Twitter feed:

Search Engine and External URLs
A Home page can include an embedded search engine or other external URLs. With embedded external URLs, 
you can access the internet without leaving Informatica Data Director. For example, you might search for the 
internet for more information about a business entity or monitor competitor offerings.

The following image shows an embedded Bing search engine:

Task Inbox
A task is a request to participate in a review process. For example, you might need to approve a new record 
or review changes to a record. You receive task notifications in the task inbox. By default, the task inbox 
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displays the tasks based on the first quick filter. For example, if the first quick filter is My Open Tasks, the 
task inbox lists all your open tasks. 

The following image shows the task inbox with the My Closed Tasks filter selected: 

1. Quick filters
2. Column filter
3. Refresh icon
4. Table Settings icon

The following table describes the elements in the task inbox:

Inbox 
Element

Description

Filters Filters the tasks based on the filter criteria. You can use the following types of filters alone or in 
combination: 
- Quick filters. Filters the tasks based on the predefined filter that you select.
- Column filters. Filters the tasks based on the task properties that are visible in the list. 

View All Displays the details of all the listed tasks in the Task Manager.

Refresh icon Updates the contents of the task inbox. 

Table Settings 
icon

Opens a dialog box where you can configure the columns for each quick filter listed in the task inbox.

Task Title A link that displays a short description of the review task. To review the record and take action on 
the task, click the task title. The task opens in the Task Manager and displays the associated record 
in the review panel. If your role permits it, you can edit the record from this view before taking action 
on the task. 

ID Instance ID of the review process that generated the task. 

Type Name of a people activity within the process. 

Priority Priority of the task. The task priority can be Low, Normal, or High. When generating tasks, the review 
process assigns the same priority to all tasks of the same type. 

Due Date Date the task is due. The review process calculates a default due date based on the task creation 
date plus a predefined time period. 
The due date of each task is prefixed with one of the following colored dots:
- Green. Indicates that the task is not overdue.
- Red. Indicates that the task is overdue.
- Amber. Indicates that the task will be overdue in the next 24 hours.
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Inbox 
Element

Description

Status Status of the task can be Open or Closed. When the task status is Open, you can view the record 
associated with the task.

Owner Name of the signed-in user. 

Creator Name of the user who created the task.

Creation Date Date on which the user created the task.

Start Page
If the Data tab is enabled for your environment and a Home page is not configured for your role, use the Start 
page as a data monitoring dashboard. The Start page contains a list of review tasks in the task inbox.

The following image shows the Start page with the default task inbox:

If the Task Manager is not enabled, when you click a task, the task opens in the Data tab. If the Task Manager 
is enabled, the task opens in the Task Manager.

Sorting and Filtering Tasks
You can sort and filter the list of tasks in the task inbox. For example, you might want to review edited 
records before you review merge proposals.

The task inbox contains quick filters and column filters. You can use these filters in combination to get 
specific results. For example, to see high priority tasks assigned to you, select the My Open Tasks quick filter 
and set the Priority column filter to High. In logical terms, filters are joined by the AND operator.

Note: You can set one column filter at a time. For example, you can narrow your list to Organizations and then 
further restrict the results to show only the Merge tasks for organizations.

1. In the navigation bar, click Home. 

The task inbox appears. 

2. To sort the list of tasks by a field, click the column heading with that field name. 
For example, to sort tasks by task type, click the Task Type column heading. 
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Sorts the tasks based on the values in the selected column. An up arrow beside the column heading 
indicates that the values are sorted in ascending order. A down arrow indicates descending order. 

Note: By default, the task inbox sorts tasks case insensitively. If the number of tasks to sort is more than 
the value of the CompositePagerTotalRecords property, case-sensitive sorting is database dependent. 
For more information about the CompositePagerTotalRecords property, see the Multidomain MDM Data 
Director Implementation Guide.

3. To filter the list of tasks, set filter criteria in any order. 

• To filter tasks by the most commonly used criteria, select one of the following quick filters: 

Filter Description

My Open Tasks Shows your open tasks.

My Closed Tasks Shows the tasks that you closed.

All Tasks Shows all the closed, claimed, and unclaimed tasks that are assigned to your user 
group.

All Unclaimed Tasks Shows all the unclaimed tasks that are assigned to your user group. 

All Closed Tasks Shows all the tasks that the users in your user group closed.

All Claimed Tasks Shows all the tasks that the users in your user group claimed.

• To filter tasks based on the values of column headings, enter appropriate values for the following 
column headings:

Column Description

Task Title Shows tasks that contain the specified text. Enter the text that you want to search for in the 
task titles. 

ID Shows the tasks based on the value that you enter.

Type Shows tasks with the selected task type. Select a task type from the list, such as Final 
Review or Merge.

Priority Shows tasks with the selected priority, such as High. Select a priority from the list.

Due Date Shows tasks that are overdue or due in a specific period. Select a due date option from the 
list.

Status Shows tasks with the selected status, such as Open or Closed. Select a status from the list.

Owner Shows tasks that are assigned to the user. Enter a user name. 

Creator Shows tasks that the specified user created.

Creation Date Shows tasks that are created during a specific period of time. Select a creation date option 
from the list, such as Last 7 days or Custom range.

4. To remove filters, click the Clear Filter icon. 
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Refreshing Data in the Home Page
Before you perform an analysis of the data in the Home page, refresh the components to ensure that they 
display current data. You can refresh all components at the same time, or you can refresh some of the 
components individually.

Note: Third-party components might refresh themselves periodically. If so, the refresh rate depends on the 
API provided by the third-party component. For more information, contact the MDM administrator.

Perform one of the following tasks:

• To refresh all the components in the page, refresh your browser instance.

• To refresh only the task inbox, click the Refresh icon.

• To refresh a chart with current data, click Recalculate.

Configuring the Columns for the Task Inbox
By default, the task inbox displays the columns that the administrator configured for all the quick filters. For 
each quick filter, you can add or remove the available columns.

1. In the navigation bar, click Home. 

The task inbox appears. 

2. Select a quick filter for which you want to configure the columns. 

3. Click Table Settings. 

The Table Settings dialog box appears.

4. To add a column heading, in the Available Fields section, select a field and click Add. 

5. To remove a column heading, in the Selected Fields section, select a field, and click Remove. 

6. Click OK. 

Localizing Your User Interface
You can display all elements of the Data Director user interface in another language. All elements of the user 
interface are localized in the selected language. The localized elements are menus, buttons, navigation links, 
labels, error messages, and metadata.

1. Login to Data Director, and if prompted, select your application. 
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2. From the application header, click your user name, select Change Language, and select a language. 

The Data Director user interface displays the selected language.

Bookmarking Your User Interface
You can choose to bookmark the Data Director user interface.

When you open, share, or refresh the required bookmark in the Data Director user interface, the bookmark 
capability allows you to remain on the same page. Bookmark prevents you from redirecting to the home page 
provided that you have the required user access and the URL is valid.

Similar to the bookmark of any other browser-based application, you can launch the Data Director user 
interface and choose to select the star or bookmark icon in the address bar to save the bookmark with an 
easily identifiable name.

You can bookmark severalData Director user interface sections and tabs, such as Business Entity views, 
Layouts, Matching Records, Network, Hierarchy, Job Monitor, Task Manager, additional custom pages, File 
import, AdHoc match, and drafts.

When you bookmark the search page, the bookmark appears for the search query used. After you open the 
bookmark, you can run the search query to view the search results again.

You can share the bookmark in the Task Manager and its associated tabs. You can choose to include 
bookmarks in the notification emails from the Task Manager.
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Part I: Data Director with Business 
Entities

This part contains the following chapters:

• Adding Business Entity Records, 35

• Working with Draft Records, 50

• Finding Records, 53

• Exporting Business Entity Records, 66

• Editing Records, 67

• Importing Bulk Data, 76

• Resolving Duplicate Records, 89

• Establishing the Best Version of the Truth, 99

• Investigating Data Changes, 103

• Investigating Relationships, 106

• Investigating Data Change Events for Effective Periods, 119
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C h a p t e r  3

Adding Business Entity Records
This chapter includes the following topics:

• Adding Records Overview, 35

• Adding a Person Scenario, 36

• Adding an Organization Scenario, 37

• Adding a Record, 37

• Adding a Record with Data from DaaS Provider, 39

• Configure a Sibling Reference Lookup, 40

• Creating Records in the Data View, 47

• Copying a Record, 49

• Exporting a Business Entity Record, 49

Adding Records Overview
To add records based on a business entity, use the New tab with the Business Entity option and select a 
business entity.

Note: In the New window, if you see both the Business Entity option and Subject Area option, ask the MDM 
administrator which one to use. The Business Entity option opens an entity tab while the Subject Area option 
opens the Data tab.

The MDM administrator defines the business entities, including the data and structure. The administrator 
also designs the layout of the record view that opens when you create a record. Your application can have 
one or more record views.

You might see the following panels in your record view when you create a record:

Record Details panel

The main panel in the record view is the data entry form. Required fields have a red line.

Similar Records panel

If the record view contains the Similar Records panel, as you enter data in required fields, Data Director 
generates a list of similar records for your review. Review the similar records before finishing the form. If 
you find the record already exists, you can edit the existing record instead of adding a new record. If you 
are uncertain whether a similar record is the same record that you want to add, continue adding the new 
record. If you add a duplicate record, Data Director can find and consolidate matching records for you.
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DaaS Providers panel

If the record view contains the DaaS Providers panel, you can specify some basic information, such as 
the display name, and send the information in a request to a DaaS provider. The DaaS provider searches 
its database and returns a list of matching records. You can preview the data for each record. You can 
compare two or more records and specify which of the records you want to use to create the record.

Data Validation in the Business Entity View
When a user adds or changes data in the Business Entity view, Data Director checks the data against 
metadata and, optionally, validation rules. The metadata defines the expected format for the data, such as 
the data type or the number of characters permitted. The validation rules are cleanse rules or Informatica 
Data Quality rules.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

Validation processes run at the field level, section level, and entity level:

• Field level. When you add or edit data in a field in the Business Entity view, a client-side validation process 
verifies that the data satisfies the metadata. For example, when you enter a date in a Date field and then 
navigate away from the field, the process verifies that you entered the date in the expected date format.

• Section level. When you apply all changes in a section in the Business Entity view, a client-side validation 
process verifies that all data satisfies the metadata and that the required fields contain data.

• Entity level. When you save a record in the Business Entity view, a server-side validation process verifies 
that data satisfies the metadata, the cleanse validation rules, and the Informatica Data Quality rules.

If user input does not satisfy the metadata or the validation rules, you see messages about the problems with 
the data.

Adding a Person Scenario
You are an insurance agent for a large insurance company. You have a new customer, Anthony Lomax, on the 
phone. You want to add Mr. Lomax as a record.

To add Anthony Lomax, you perform the following steps:

1. In the navigation bar, click New. Select Person as the business entity type, and then click OK.

2. In the Last Name field, you type Lomax. In the First Name field, you type Anthony.

3. In the Similar Records panel, you see a potential duplicate, so you open the similar record.

Note: The Similar Records panel only appears if the MDM administrator has configured the application 
to display the panel.

4. You confirm with Mr. Lomax that he is not the same person as the existing Anthony Lomax, and then 
close the similar record.

5. You finish adding Mr. Lomax's information in the form.
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Adding an Organization Scenario
You are with the marketing department of a company. You have a new customer, Time Warner which is an 
organization. You want to add Time Warner as an Organization business entity record.

To add Time Warner, you perform the following steps:

1. In the navigation bar, click New. Select Organization as the business entity type, and then click OK.

2. Fill In the required fields for the DaaS provider. In the Display Name field, type Time Warner. The Display 
Name field is a required field.

3. Select the DaaS provider and click Go.

4. Review the search results that the DaaS provider returns. You compare two or more records in the 
search results.

5. Select the records that are a potential match and click Use this to create the record.

6. If you do not find any potential matches, you close the search results, add data in the data entry form 
and click Save to create the record.

Adding a Record
To add a record that uses the business entity model, start from the New tab in the navigation bar and select 
the type of business entity.

1. In the navigation bar, click New. In the New window, select a business entity type, and then click OK. 

An entity tab opens and displays the data entry form for the business entity. A red line on a field 
indicates a required field.

2. For each required field in the form, click the field, and type a value. 

Note: You can use the following conventions when adding text:

• Type the complete search string or the search string with the asterisk wildcard character (*) for the 
record that you want to find. You can use the wildcard character at the end of the search string or in 
between the search string. For example, if you want to search for John, you can specify Jo* or J*n.

• If the search is configured to suggest search strings, type a few characters of the search string, and 
select one of the suggested values as the search string.

Note: The values are suggested when you search within a single business entity type.

If the search string includes any of the following special characters, add a backslash as a prefix to the 
special character: + , - , & , || , ! , ( ) , { } , [ ] , ^ , " , ~ , ? , : , \ . If you do not add a backslash as a prefix to 
each special character, the search might return no results or incorrect results. For example, if you want 
to search for AT&T, the search string must be AT\&T.

The following image shows a sample data entry form for a Person business entity. The required fields 
are filled in.
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1 Navigation menu

2 Required field indicator

3 Changed field indicator

3. If the Similar Records panel contains a list of similar records, review them. 

Note: The Similar Records panel only appears if the MDM administrator has configured the application 
to display the panel.

a. In the Similar Records panel, click the information icon beside the name of a record. 

b. Check the other data values to see if the record is the same as the one you are adding. 

• If it is the same record, click Use this record. When prompted for confirmation, click Yes, 
proceed. The work-in-progress record is discarded and the tab closes. The selected record 
opens in an entity tab. You can edit data as required.

• If it is not the same record, click Close.

• To review child records for the previewed record without discarding the work-in-progress entity, 
click View Business Entity. The previewed record opens in an entity tab.

c. Review other similar records in the same way. 

d. If a record does not exist, return to the tab containing the work-in-progress record. 

4. In the data entry form, add data in the optional fields. 

a. Fill in the fields. 

b. Optionally, add an image. Type a valid URL in the image field. 

Note: For best results, use an image that is a maximum of 200 x 200 pixels. For images, the MDM 
Hub stores the URL, not the file. If the location of the file changes, you must update the URL.

c. Click the Apply icon. 

5. If the data entry form includes sections for child records, add child records to the sections. 

a. In the navigation menu, click a section name, such as Address or Phone. 

The view scrolls to the selected section.

b. Click the Create Child Record icon. 

Fields appear where you can enter data.

c. You can switch between a table view and a form view of the fields. Click the Form icon or the Table 
icon. 

d. Fill in the fields. 

The following image shows a sample Phone section in the form view:
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1 Table icon. Click to view the fields within a table.

2 Form icon. Click to view the fields within a form.

3 Create Child Record icon. Click to add a child record to the selected record.

e. Click the Apply icon. 

6. After you finish adding data, click Save. 

A message confirms that the record was created successfully. If your user role permits you to save data 
without a review, the application saves the record to the MDM Hub Store as an active record. Otherwise, 
the application saves the record as a pending record and initiates the review process associated with 
your role.

Adding a Record with Data from DaaS Provider
When you have Data as a Service (DaaS) integrated with the MDM Hub and configured for a business entity, 
the DaaS Providers panel lists the DaaS providers. Use the data provided by a DaaS provider to add your 
record. To add a record, start from the New tab and select the type of business entity.

1. In the navigation bar, click New. In the New window, select a business entity type, and then click OK. 

2. Fill in the required fields for the DaaS provider. 
For example, in the Display Name field, type Time Warner.

3. Move your cursor out of the Display Name field. 

You can now select a DaaS provider.

4. In the DaaS Provider panel, request information about the record from a DaaS service provider. 

a. Select the DaaS provider you want to use, and then click Go. 

The DaaS provider returns the search results based on the display name of the organization.

b. Investigate if a record in the search result is the one you want to add. 

1. Select the record and click Preview.

2. If the data values do not match the record that you want to add, click Go back.

3. Review all records in the same way.

c. Optionally, if you want to compare two or more records, select the records, and then click Compare. 

The Compare page displays the data from the selected records.

5. Based on the result of the previous step, perform one of the following actions: 

• To add the data from the DaaS provider, select one or more entities from the search results or from 
the Compare page, and then click Use this. All entities are merged to form a single record. Continue 
with this record.

• If the DaaS provider does not return results that match the entity you want to create, return to the tab 
containing the work-in-progress record, fill in the details, and click Save.
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Configure a Sibling Reference Lookup
You can configure a sibling reference lookup for Business Entity records in Entity 360.

Sibling Reference Lookup Overview
Use the Sibling Reference Lookup feature to navigate and associate related Business Entity Records 
seamlessly within Entity 360. Without having to refer to Search for each association, the Sibling Reference 
Lookup function reduces time and effort to locate the impacted records.

Consider the following rules and guidelines to create sibling reference lookups:

• When a root Business Entity Record, like Informatica has multiple child entities, such as addresses or 
contacts, you can easily associate any child entity with another.

• The possible associations can be Saved to Saved, Saved to Unsaved, and Unsaved to Unsaved records.

Note: For unsaved to unsaved records association, it is possible to associate at the same level and not 
one level down. For example, for an unsaved parent record, you can't associate it with unsaved child 
because it is one level down. If the parent field is not saved, then it can't be linked with the child entity.

• Supported associations levels are child to child, child to grandchild, and grand child to grand child.

• If there exists a foreign key relationship between the entities involved, you can create associations.

• For timeline-enabled child entities, similar associations apply regarding different versions.

Sibling Reference Lookup Configuration
For a sibling reference lookup configuration in a business entity layout, you can configure a root to child 
lookup or choose to configure an associate sibling lookup.

Configuring the Root to Child Lookup
The instructions explain how to configure the root to child look up when you have a business entity as a 
person having the person_party as root and with the electronic address as the child field.

1. Add a new field to Party Base Object through the MDM Hub console. 

a. Launch Hub Console. 

b. Select any Operational Reference Store (ORS). 

c. Navigate to the Schema from the Model. 

d. Expand the Party Base Object 

e. Click Columns > Acquire Write Lock 
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f. Add a new field. 

For instance, add a new field called person_email.

The following diagram shows a sample field creation:

2. Establish a relationship from the person_email to Electronic Address in the Party Electronic Address 
Base Object. 

a. Under Relationships, select Option > Acquire Write Lock. 

b. Click the Add icon. 

The Add relationship dialog appears.

c. From the Relate From panel, select person_email. 

d. From the Relate To panel, go to Party_Electronic_Address > rowID Object. 

The following image shows how you can add the relationship:

e. Click OK. 

f. Select Release Write Lock. 
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g. Run the met validation. 

The following validation image indicates the relationship created:

3. To reflect these changes in the Provisioning, create a new lookup and enable the Sibling Lookup option. 

a. Launch the Provisioning tool. 

b. Select the Operational Reference Store (ORS). 

c. Go to Modelling > Business Entities. 

d. Expand the root level lookup field folder from the middle panel. 

e. Create a new lookup. 

f. Enter the Sibling lookup name and label. 

g. Enable the Sibling Lookup. 

The following image shows how to enable the sibling reference:

h. Go to Objects > Select Emails. 

i. On the Lookup display fields, go to Select Electronic Address > Apply Changes. 

j. Publish the changes. 
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4. Log into Entity 360 to use the Sibling Configuration with the magnifying glass icon as seen in the 
following screenshot: 

5. Click on the magnifying glass icon to see the list of email IDs created for a specific person. 

The following image displays the list of email IDs created for a specific person:

6. Select one the emails added and click OK. 

In the example, since you selected the Lookup display field as Email Address in Provisioning, the value 
displayed in the Person_Email field is email1@gmail.com as seen in the following image:
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Configuring the Associate Sibling Lookup
To configure the associate sibling lookup, ensure that you create a new field in the Business Object that 
requires to be associated with its child or sibling.

1. As part of the creation stage, create a new field that you want to associate with its child or sibling. 

For example, you want to associate Party with Email.

The following image shows how to create the Person_email in the Party business object:

2. Set up a Foreign Key relationship in the Business Entity. 

For example, establish a foreign key relationship between the Person_Email and the Party Electronic 
Address Rowid Object on the Add Relationship dialog box.

The following image shows how to establish a foreign key relationship on the Relate from and Relate To 
sections on the Add Relationship dialog:
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The following diagram shows the foreign key table references that you create from Person_Email to the 
Party Electronic Address Rowid Object on the Add Relationship dialog box:

3. On the Provisioning tool, create a new lookup field with the new relationship. 

For example, create a new lookup field under the Business Entity that has the foreign key relationship 
with email, which is the Person_Email business entity.

4. Select the constraint as the new relationship configured in the MDM Hub Console before you apply the 
changes and publish. 

For example, the Sibling or Child reference in the new field added to the Provisioning tool.

The following diagram shows the Lookup display field selected whose value displays in the associated 
lookup field:

5. Add a new field in the Business Entity View. 

The following image shows how to add a new field in the Business Entity View:

6. Add a transformation for the newly created field. 
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The following image shows how to add a transformation for the new field in the Business Entity to View:

The following image shows how to add a transformation for the new field in the View to Business Entity:

7. Apply and publish the changes. 

8. Verify the associated sibling lookup field in the Informatica Data Directory. 

9. Create a new Person business entity. 

The following image displays the configured sibling lookup field:

10. Click on the magnifying glass icon to see the list of email IDs created for a specific person. 
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The following image displays the list of email IDs created for a specific person:

11. Select one the emails added and click OK. 

In the example, since you selected the Lookup display field as Email Address in Provisioning, the value 
displayed in the Person_Email field is email1@gmail.com as seen in the following image:

Verify the Associate Sibling Lookup
You can verify the associated sibling lookup reference in the Informatica Data Directory where you can 
create, associate, select, and view a business entity.

Creating Records in the Data View
To add a record based on a subject area, start from the New tab and select the subject area. The MDM 
administrator defines the subject areas and the types of data that you need to enter for the subject area.

1. In the navigation bar, click New. In the New window, select a subject area. 
For example, the application for an insurance company defines a Person subject area within a Customer 
subject area group. To add Anthony Lomax as a customer, a business user clicks New and then selects 
Customer > Person.

The Data tab contains a New Person tab with an empty data entry form. A field name with a red asterisk 
indicates a required field.

2. For each required field, click the field and type the value. 

3. For each optional field for which you have data, click the field and type the value. 

4. Optionally, type the URL to an image file in the image_url field. For best results, link to an image that is a 
maximum of 200 x 200 pixels. 
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Note: For images, the MDM Hub stores the URL, not the file. If the location of the file changes, you must 
update the URL.

The following image shows some data for a record:

5. Click Apply. 

The application validates the data. If there are errors, correct them.

6. Add data to sections in the Data view. 

a. Expand a section, such as Address or Telephones. 

b. Click the Add icon. 

c. Fill in the fields. 

The following image shows the Telephones section:

d. Click Apply. 

7. If you need to change the value of a field, click the Edit icon, edit the fields, and click Apply. 

8. After you finish adding data, save the data. 

• If your user role permits you to save data without a review, click Save. The application saves the 
record to the MDM Hub Store in active records.

• Otherwise, click Send for Approval. In the Create Task dialog box, review the task details, edit the 
details as required, and click OK. The application saves the record in pending records and initiates a 
review process.
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Copying a Record
You can copy a business entity record, modify it, and then save it as a separate record. To copy a record, you 
need to have permission to create records. When you copy a record, the values from read-only fields are not 
copied. Read-only field values are populated automatically with default values or remain empty. For example, 
a record can include a unique customer ID field that is populated automatically. When you copy a record, the 
customer ID value is not copied. The field remains empty. After you save the record, the customer ID value is 
populated automatically.

1. Search for the record that you want to copy, and then open it. 

2. From the Actions menu, select Copy. 

A copy of the record is displayed.

3. Change the values based on your requirements. For example, modify the name, address, or email 
address. 

4. Click Save. 

Exporting a Business Entity Record
In the Business Entity view, you can export a Business Entity Record and its related Business Entity records 
as a PDF.

To export a Business Entity, click Download as PDF.

The following image shows a sample Business Entity View.

Figure 1.
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C h a p t e r  4

Working with Draft Records
This chapter includes the following topics:

• Working with Draft Records Overview , 50

• Adding a Draft Record, 51

• Editing a Draft Record, 51

• Submitting a Draft Record , 51

• Filtering Draft Records , 52

• Deleting Draft Records, 52

Working with Draft Records Overview
If your user role has the create and edit permissions, you can create a draft of a business entity record. You 
can partially fill in the record, save it as a draft, edit and complete it later, and then submit it for approval. 
Your draft records are not visible to other users.

Use the Drafts page to access and open your draft records. To go to the page, click Drafts in the left 
navigation bar.

The following image shows the Drafts page:

50



Adding a Draft Record
You can partially fill in a business entity record, and then save it as a draft.

1. In the navigation bar, click New, select a business entity type, and then click OK. 

An entity tab opens and displays the data entry form for the business entity.

2. Add data to the record. 

3. To save the draft of the record, click Cancel. 

The Discard New Record dialog box appears.

4. Click Save as Draft. 

The record is saved as a draft. You can access the draft on the Drafts page.

Editing a Draft Record
You can edit a draft record to make changes and then submit it or keep it as a draft.

1. In the navigation bar, click Drafts. 

2. Select the draft record that you want to edit. 

The record opens.

3. Edit the data in the draft record. 

4. Perform one of the following actions: 

• To retain the record in the draft state, click Cancel and then click Save as Draft.

• To submit the record, click Save.

If your user role permits you to save data without a review, the application saves the record to the 
Hub Store as an active record. Otherwise, the application saves the record as a pending record and 
initiates the review process associated with your role.

Submitting a Draft Record
After you complete a draft record, you can submit it for approval. If your user role permits you to save data 
without a review, the application saves the record to the Hub Store as an active record. Otherwise, the 
application saves the record as a pending record and initiates the review process associated with your role.

1. In the navigation bar, click Drafts. 

2. Select the draft record that you want to submit. 

The record opens.

3. Click Save. 
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Filtering Draft Records
You can filter the draft records by the business entity type or title.

1. In the navigation bar, click Drafts. 

2. Click the Filter icon. 

3. Click Add Field, and select the filter that you want to apply. 

4. Perform one of the following steps: 

a. If you select Entity Type, select the type of business entity that you want to use as a filter. 

Data Director retrieves all the draft records that belong to the selected business entity type.

b. If you select Title, enter a value based on which you want to filter the drafts records. 

Data Director retrieves all the draft records that match the specified value.

For example, if you enter the alphabet b, Data Director lists all the drafts records that contain the 
alphabet b in the title.

Deleting Draft Records
You can permanently delete a single draft record, some draft records, or all draft records.

1. In the navigation bar, click Drafts. 

2. Choose from the following options: 

• To delete a single draft record, hover over the record that you want to delete, click the Delete icon, 
and then click Delete Draft.

• To delete multiple draft records, filter the records by business entity types or title, click Delete All, 
and then click Delete All in the confirmation dialog box.

• To delete all the draft records, click Delete All, and then click Delete All in the confirmation dialog 
box.
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C h a p t e r  5

Finding Records
This chapter includes the following topics:

• Finding Records Overview, 53

• Using the Search Box to Find Records, 55

• Using Queries to Find Records, 58

• Managing Queries, 62

• Migrating and Sharing Saved Queries, 64

• Filtering Child Records, 65

Finding Records Overview
To find a record, you can either enter a search text in a search box or use a query form. The search results 
show the most important details of the records. You can see more details by opening the records. 

You can use the search box to search and filter records. However, to repeatedly perform the same search and 
filter operation, it is efficient to create and save a query. 

Use the search box to perform a full-text search. Use a search query, which is a search form, to specify a 
criteria for your search.

When you use queries, you can search within a specific business entity for which the query is created. 
Whereas, when you use the search box, depending on your environment, in addition to searching within a 
business entity, you might be able to search across all business entities. 

Note: The search options that you see depend on what was configured by the MDM administrator. You must 
have the required privileges for the business entities within which you want to search for records.

Search Page
When you perform a search from the Search box in the application header, the Search page appears in the 
Search tab. A search returns a list of records that satisfy the search criteria.

Use the Search page to review the search results. You can expand a record in a search result to view the 
summary of record details. To refine the search results, you can use filters.

You can group the records that appear in search results based on the business entity types. If you group 
records, you can look for records in the relevant business entity type groups.

The following image shows a sample Search page:
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1. Results total
2. Search Results panel
3. Actions menu
4. Search box
5. Filter panel

The Search page includes the following sections:

Results total

Displays the total number of results found based on the search string that you enter in the Search box.

Search Results panel

Displays the total number of results found and lists the records that are part of the search results. You 
can group the records listed in the search results by business entity type.

Actions menu

Displays actions that you can perform on the record. For example, you can open the record in a view, 
such as the Business Entity view, or you can create a task for the entity.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

Filter panel

Displays the filter criteria to filter the search results. Use filters to refine the search results based on the 
filter criteria that you select or enter a value for. You can hide the Filter panel if you do not need to filter 
the search results.

Filter criteria

Filter properties that you can select or enter a value for to refine search results.
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Queries Page
Use the Queries page to create and run queries. A query returns a list of records that satisfy the criteria that 
you specify.

To open the Queries page, click the Queries tab. If you have a default query, the default query opens. If not, 
the Saved Queries panel appears, and you can create a query or select a saved query.

After you run a query, the Search Results panel lists the records that satisfy the search criteria.

The following table describes the user interface elements of the Queries page:

User interface element Description

Query panel Lists the saved queries or the query that is open. The query that you create appears in the 
query panel.

Run Runs the query that is open.

Save Saves a query.

Back to Saved Queries Displays the saved queries in the Saved Queries panel.

Query Results panel Lists the records that satisfy the query criteria.

Using the Search Box to Find Records
You can use the search box to perform search for records. You might want to search for records that you 
want to view, edit, or delete.

Your Data Director application must be configured to use Elasticsearch. When your application is configured 
to use Elasticsearch, you can search for records within a single business entity.

To find a record, enter a complete or partial search string in the Search box. A search string can include 
keywords, numbers, and operators. Stopwords, such as a, an, of, and with, are ignored in the search process.

You can use the wildcard operators * and ? in the search strings. The * wildcard operator is a placeholder 
that matches zero or more characters. The ? wildcard operator matches a single character.

The following table lists example search strings and explains how they function: 

Example Search 
String

Search Behavior

John Searches for records that contain John, such as John, John Smith, John Anderson, and 
John Anderson Smith.

John Smith Searches for records that contain John or Smith or both John and Smith, such as John Smith 
and John Anderson Smith.

John Anderson 
Smith

Searches for records that contain at least two of the terms that constitute the search string, 
such as John Smith, John Anderson, and John Anderson Smith.
When more than two terms constitute a search string, at least n-1 terms are present in the 
search results. In this example, at least 3-1 = 2 terms are present in the search results.
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Example Search 
String

Search Behavior

John* Searches for records that contain a value that starts with John, such as Johnson and Johnny.

Jo*n Searches for records that start with Jo and ends with n, such as Johansson and Jordan.

Al?k Searches for records with a single character between Al and k, such as Alek and Alok.

Ale? Searches for records with a single character after Ale, such as Alek and Alex.

Smith-Jones Searches for records that contain both Smith and Jones, such as Smith-Jones and Smith 
Jones.

Dave&Smith Searches for records that contain Dave&Smith, which contain the special character &.
You can search for records that contain special characters, such as &, +, =, and ~.

The Washington 
Post

Ignores the stopword The and searches for records that contain Washington, Post, or both 
Washington and Post.

Finding Records in an Elasticsearch Environment
Use the search box to find a record.

1. In the Search box, select a type of business entity from the list. 

Tip: The Search list contains the types of business entities that you have permission to view. If the list is 
empty, contact your MDM administrator to request permission.

2. In the Search box, perform one of the following tasks: 

• Type the complete search string or the search string with the asterisk wildcard character (*) for the 
record that you want to find. You can use the wildcard character at the end of the search string or in 
between the search string. For example, if you want to search for John, you can specify Jo* or J*n.

• If the search is configured to suggest search strings, type a few characters of the search string, and 
select one of the suggested values as the search string.

Note: The values are suggested when you search within a single business entity type.

If the search results must contain the words in the search string, add the + operator before each search 
word.

3. Click the Search icon. 

The search results appear in the Search Results panel.

4. To refine the search results, apply filters. 

Filtering Records
After you perform a search, you can refine the search results by using filters. For example, you can refine the 
search results for John Smith by filtering the results by the city name, Toronto.

1. Perform a search. 

The search results appear in the Search Results panel in the Search page.

2. In the Filter panel, select or enter a value for the filter criteria that you require. 
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Note: For a date and time field, you can specify the date in the filter, but not the time. The filter uses the 
default time as 00:00:00 UTC. Some numeric filters might appear in the scientific notation, even though 
the search results display the values in the decimal notation. For example, the filter might display 
10544444.6 as 1.05444446E7.

3. Click Apply. 

The search results contain only the records that match the filters that you applied.

4. To clear all the filter criteria, click Clear All. 

Customizing Search Results
You can customize the search results that appear in the Search Results panel to include only the fields that 
you want to view.

1. From the Search Results panel, click the Settings icon. 

The Customize Search Columns dialog box appears.

2. Move the fields that you want to display in the Search Results panel to the Selected Columns section. 

3. Optionally, change the order in which you want the fields to appear in the search results. 

4. Click OK. 

The Customize Search Columns dialog box closes. The search results include only the fields that you 
selected.

5. To sort the search results, click a field name in the header. 

The results are sorted in the ascending order, and an upward arrow appears beside the field. If you click 
again, the results are sorted in the descending order, and a downward arrow appears beside the field. If 
you click again, the results are not sorted based on the field value, and the arrow disappears.

Note: When you customize the search results, all the preferences are automatically saved for each business 
entity. When you perform another search on the business entity later, the search results appear based on 
your preferences.

Viewing and Opening a Record in an Elasticsearch Environment
You can open records from the Search Results panel in the Business Entity view, or any record view. Before 
you open a record, you can preview the record. The preview appears in the Record Preview window and can 
display up to ten levels of records, which includes both parent and child record levels.

1. From the Search Results panel, select the record that you want to open. 

Note: A description with the prefix [Pending] means that the record has pending changes that are not yet 
approved. You can open the record, but you cannot make further changes until the review and approval 
process ends.

2. To verify that you have the correct record, click the Show Preview icon. 

The Record Preview displays the record details.

3. To open the record, click the Open in a new window icon. 

The record opens in the Business Entity view. You can view and edit the record that is open.

4. If you want to open the record in any other view, click the More Actions icon, and then select Record 
Details. Select the tab that you want to view. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.
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The following views might be available in the Data Director application:

View Description

Matching 
Records

View the records that match the record that you opened. You can identify and resolve duplicate 
records.

Cross-
reference 
Records

View the records that contribute to the best version of the truth of a record. You can unmerge a 
record that was merged with another record.

History View data changes over the lifespan of the record. You can identify the data events that 
changed the data.

Hierarchy View a tree diagram that shows the hierarchy relationships for the record. You can add, edit, 
and delete hierarchy relationships for the selected record.

Network View a network diagram that shows how a record is related to other records. You can add, edit, 
and delete related relationships for the selected record.

The record opens in the view that you select.

Using Queries to Find Records
Use a search query, when you want to repeatedly perform the same search and filter operation. When you use 
search queries, you specify a criteria for your search. You might want to use queries to find records that you 
want to view, edit, or delete.

To create and manage queries, use the Queries page. You can create a query to search for records based on 
a specific business entity. To reuse the query that you create, save the query. If you use a query frequently, 
you can set it as the default query.

When you create a query with a lookup field that is dependent on other lookup fields, these other lookup 
fields are automatically included in the query. For example, the City lookup field is dependent on the State 
and Country lookup fields. When you create a query to include only the City lookup field, the State and 
Country lookup fields are automatically included in the query.

Types of Queries
You can use a basic or an extended query.

If a basic query does not return the results you are looking for, use an extended query. An extended query can 
find records that are missed by the basic query.

Basic Queries
Basic queries use simple text comparisons to find records that contain the query values. You can use text 
and the wildcard character (*) to query values.

The wildcard characters are special search symbols that you can use in basic queries to specify a text 
pattern instead of specific characters. You can use the asterisk (*) wildcard character to increase your 
chances of finding the records that you want. The wildcard characters are useful when you do not know the 
exact text or want to search for similar text.

58       Chapter 5: Finding Records



The following table lists example search strings and explains how they function: 

Example Query 
String

Query Behavior

John Smith Queries for records that contain John, Smith, or any variations of John or Smith as a field 
value.

"John Smith" Queries for records that contain John Smith or any variations of John Smith as a field value.

John* Queries for records that contain a value that starts with John. For example, Johnson or 
Johnny.

Jo*n Queries for records that start with Jo and end with n. For example, Johansson or Jordan.

* Returns all the records.

Note: Basic query is not case sensitive in Microsoft SQL Server environments.

Extended Queries
Extended queries use matching logic and match-enabled attributes to find records that contain the query 
values. You must enable a match rule set to use with extended queries.

Extended query results include fuzzy matches, which are more reliable. Fuzzy matches take into account 
spelling variations, and other differences to ensure that matching data that are not identical are not missed. 
For example, an extended query can match variations of the word "Street", such as "St." and "St".

Note: The extended queries use match rule sets. If an MDM administrator edits or deletes a match rule set 
from the Hub Console, the related queries are deleted from the Data Director application.

When you use extended queries, ensure that the following conditions are met:

• The business entity has match-enabled attributes.

• The match rule set used by the query is configured by the MDM administrator to use the Enable Search by 
Rules option in the Hub Console.

Creating a Query
You can create a query to search for records within a specific business entity. You are the owner of the 
queries that you create.

1. In the navigation bar, click Queries. 

2. In the Saved Queries panel, click the Add icon. 

The New Query dialog box appears.

3. From the Business Entity list, select the business entity within which you want to perform the search. 

4. Select a query type. 

Query Type Description

Basic Uses simple text comparisons to find records that contain the query values.

Extended Uses matching logic and match-enabled attributes to find records that contain the query values.
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5. If you selected the extended query type, from the Match Rule Set list, select a match rule set. 

Select the Default match rule set only when a suitable match rule set does not appear in the list. A match 
rule is generated based on the values that you specify.

The fields available for the selected match rule set appear.

6. Select the fields that you want to include as the search criteria for the query. 

The fields that you selected appear in the Selected Fields section.

7. In the Selected Fields section, drag to rearrange the sequence of the fields. 

The fields appear in the query form in the sequence that you set.

8. Specify the search results options. 

a. To make the query case sensitive, enable the Case sensitive option. 

b. To show pending records in the search results, enable the Show pending records option. 

c. To sort search results, from the Sort By list, select a field name by which you want the search 
results sorted. 

d. Select the sort order of the query to be ascending or descending. 

9. Click OK. 

The query is created and opens on the Queries page.

10. To save the query for reuse, click Save. 

The Save Query dialog box appears.

11. Enter a query name and description. 

12. If you want to use the query as a default query, enable Set as my default. 

The default query is the query that appears when you open the Queries tab.

13. If you want to share the query with other users, enable Share with all. 

By default, you own the query that you create. Other users cannot edit the queries that you own.

14. Click Save. 

The query is saved and appears on the Saved Queries panel.

You can run the query that you created, or save the query and run it when needed.

Running a Query
You can run a query to find records. To run a query that is not saved, enter the search criteria, and then run 
the query. To run a saved query, first, open the query.

1. In the Saved Queries panel, open the query that you want to run. 

a. If a default query is open, but you want to run a saved query, click the Back icon to navigate to the 
Saved Queries page. 

b. Expand the business entity to which the query belongs. 

c. Click the query name. 

The query form appears.

2. Enter the search criteria for the record that you want to find. 

3. Click Run. 

The query results appear in the Search Results panel.
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Viewing Query Results
After you run a query, you can view the query results that appear in the Search Results panel. 

Note: If you query for a record that contains multiple versions, the latest record version appears along with all 
the other versions. To view all the record versions, expand the latest version.

You can open records from the Search Results panel. Before you open a record, you can preview the record. 
The preview appears in the Record Preview window. 

The Record Preview and the Business Entity views can display the parent records and up to ten levels of 
child records. The top two child record levels are expanded. To view the child record levels that are deeper, 
expand the record levels. 

You can customize the results to view only the fields that are significant to your purpose. Also, you can 
export the results to a CSV file. 

Opening Records from Query Results
After you run a query to find records, you can open the records from the Search Results panel. 

1. From the Search Results panel, select the record that you want to open. 

2. Optionally, to verify that you have the correct record, preview the record. 

a. Click the Show Preview icon. 

The Record Preview displays the record details.

b. After you preview the record, click Close. 

3. To open the record, click the Open in a new window icon. 

The record opens in the Business Entity view. You can view and edit the record.

4. If you want to open the record in any other view, click the More Actions icon, and then select Record 
Details. Select the tab that you want to view. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.

The following views might be available in the Data Director application:

View Description

Matching 
Records

View the records that match the record that you opened. You can identify and resolve duplicate 
records.

Cross-
reference 
Records

View the records that contribute to the best version of the truth of a record. You can unmerge a 
record that was merged with another record.

History View data changes over the lifespan of the record. You can identify the data events that 
changed the data.

Hierarchy View a tree diagram that shows the hierarchy relationships for the record. You can add, edit, 
and delete hierarchy relationships for the selected record.

Network View a network diagram that shows how a record is related to other records. You can add, edit, 
and delete related relationships for the selected record.

The record opens in the view that you select.
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Customizing Query Results
You can customize the query results that appear in the Search Results panel to include only the fields that 
you want to view.

1. From the Search Results panel, click the Settings icon. 

The Customize Query Columns dialog box appears.

2. Select the fields that you want to display in the Search Results panel. 

3. Optionally, change the order in which you want the fields to appear in the search results. 

4. Click OK. 

The Customize Query Columns dialog box closes. The query results include only the fields that you 
selected.

5. To sort the search results, click a field name in the header. 

The results are sorted in the ascending order, and an upward arrow appears beside the field. If you click 
again, the results are sorted in the descending order, and a downward arrow appears beside the field. If 
you click again, the results are not sorted based on the field value, and the arrow disappears.

Note: When you customize the query results, all the preferences are automatically saved for each query. 
When you run the query later, the query results appear based on your preferences.

Exporting Query Results
If you want to view the query results in a CSV file, export the query results to a CSV file.

u Export the query results to a CSV file. 

• To export all the fields, including the fields that do not appear on the Search Results panel, click 
Actions > Export All Fields.

• To export only the fields that appear on the Search Results panel, click Actions > Export Current 
Fields.

Note: Before you export the query results, you can customize the results that appear on the Search 
Results panel to include only the fields that you want to export.

Managing Queries
After you save queries, you might want to modify a query or delete a query that you do not need.

To manage queries, you can perform the following tasks:

• Edit a saved query.

• Delete a saved query.

• Save an existing query as a new query.

Note: The extended queries use match rule sets. If an MDM administrator edits or deletes a match rule set 
from the Hub Console, the related queries are deleted from the Data Director application.
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Editing a Saved Query
Use the Saved Queries panel to edit queries. You can edit any query that you own. You own the queries that 
you create or import into your environment.

1. In the Saved Queries panel, expand the business entity, and click the query. 

The query opens.

2. Click Actions > Edit Query. 

The Edit Query dialog box appears.

3. Edit the query as required. 

You can make the following changes to the query:

• Add fields.

• Remove fields.

• Enable the query to be case-sensitive.

• Select a field name by which the query result must be sorted.

• Set the sort order to ascending or descending.

4. Click OK. 

The query is updated. You can save or run the query.

5. Save or run the query. 

Deleting a Saved Query
For each business entity, you can delete the queries that you own.

1. In the Saved Queries panel, expand the business entity. 

2. Select the query, and then click Actions > Delete. 

The delete confirmation dialog box appears.

3. To delete the query, click Yes. 

The query is deleted.

Saving an Existing Query as a New Query
Instead of starting from scratch, you can use an existing query to create more queries. You can either select 
or open an existing query, and then save the it as a new query.

1. In the Saved Queries panel, select the query that you want to save as a new query. 

2. Click Actions > Save As. 

The Save As dialog box appears.

3. Enter a unique name and description for the query. 

4. Optionally, enable any of the following query options: 

• Set as my default. The query becomes the default query.

• Share with all. The query is shared with other users.

5. Click Save. 

A copy of the query is saved with the new name, and the query opens.
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6. Optionally, modify the new query. 

a. Click Actions > Edit. 

b. Edit the query as required. 

You can make the following changes to the query:

• Add fields.

• Remove fields.

• Enable the query to be case-sensitive.

• Select a field name by which the query result must be sorted.

• Set the sort order to ascending or descending.

c. Click OK. 

The query is saved with the changes.

Migrating and Sharing Saved Queries
When an MDM administrator migrates a Data Director configuration from one environment to another, the 
saved queries are not migrated. You need to export the queries from the source Data Director application and 
then import the queries into the target Data Director application.

You can migrate all the saved queries in the application or migrate individual saved queries. When you 
migrate queries, if the target application contains queries that have the same names as the queries in the 
source application, the queries are renamed. For example, if a query with the name PersonQuery already 
exists in the target environment, the query is renamed to PersonQuery 1.

Also, you can share the saved queries with other users, who can import the queries into their application. You 
are the owner of the queries that you import into your application.

Migrating and Sharing all the Saved Queries
To migrate all the saved queries, export the queries from the source Data Director application and then 
import the queries into the target Data Director application. Also, you can share all the saved queries with 
other users, who can import the queries into their environment.

1. From the Saved Queries panel header, click the Export icon. 

A Queries.json file, which contains all the saved queries, is downloaded to the default download 
location.

2. Import the JSON file into the target application. 

a. Copy the downloaded JSON file to an accessible location in the target application environment. 

b. From the Saved Queries panel header, click the Import icon. 

c. Locate and import the queries JSON file. 

All the saved queries are migrated to the target environment.
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Migrating and Sharing a Single Saved Query
To migrate a saved query, export the query from the source Data Director application and then import the 
query into the target Data Director application.

1. From the source application, export the query that you want to migrate. 

a. In the Saved Queries panel, expand the business entity to which the query to export belongs. 

b. Select the query, and click Actions > Export. 

A Queries.json file, which contains the saved query, is downloaded to the default download location.

2. Import the JSON file into the target application. 

a. Copy the JSON file to an accessible location in the target application environment. 

b. In the target application, from the Saved Queries panel header, click the Import icon. 

c. Locate and import the JSON file. 

The saved query is migrated to the target environment.

Filtering Child Records
In a Business Entity view, you can filter records based on the field values of the child or grandchild records. 
Filters are enabled when the number of records in a child record section exceeds four records. Even though 
the child records might be listed in multiple pages, the filters are applied to the entire set of child records.

When you navigate away from the Business Entity view, the filters are cleared. When you switch between the 
form and table views, the filters persist.

Note: In the form view, when you filter by date, the records are filtered by date but not by time.

1. Expand a child record section. 

2. Click the Filter icon. 

Filters popup appears.
The following image shows a Business Entity filter.

3. Select the filter criteria, and click OK. 

The filters are applied, and the records that satisfy all the filter criteria are displayed.
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Exporting Business Entity Records
In the Business Entity view, you can export a business entity record and its related records as a PDF.

To export a business entity and its related records in the Business Entity view, click Download as PDF menu.

The following image shows a sample Business Entity view with Download as PDF menu:
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C h a p t e r  7

Editing Records
This chapter includes the following topics:

• Editing Records Overview, 67

• Editing a Single Record, 67

• Edit Multiple Records, 69

• Adding and Editing Related Records, 71

• Deleting a Record, 74

Editing Records Overview
You can add or make changes to information in records. You can change a single record or multiple records. 
To change records, search for the record, and open the records in the Business Entity view.

If your user role permits it, you can edit data within a record or delete a record. When you save changes, 
based on your user role, a review process might be initiated. In this case, Data Director saves the requested 
changes in a pending record until the review process ends. If the review ends in an approval, Data Director 
applies the change from the pending record to the active records.

When you edit a pending record, you can edit only the root record or a child record that does not have any 
pending changes.

Editing a Single Record
You might want to add or make changes to the information in a single record.

You might want to add information or make changes to the information in a single record. To make changes 
to a single record, search for the record, and open the record in the Business Entity view.

If your user role permits it, you can edit or delete a single record.

Note: When you edit a pending record, you can edit only the root record or a child record that does not have 
any pending changes.

When you save changes to a record, a review process might automatically initiate depending on your user 
role. In this case, Data Director saves the requested changes in a pending record until the review process 
ends. If the review ends in an approval, Data Director applies the change from the pending record to the 
active records.
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Scenario for Editing a Record
A customer named John Smith reports that he did not receive the product that you mailed to him. You want 
to check his address, correct errors, and redirect the product to the correct address.

You find the record for John Smith, which you select and open to view the address. You find that the address 
has an incorrect postal code. After you correct the address, you close and save the record. You ensure that 
you resend the product to the correct address.

Editing a Record
If your user role includes the edit permission, you can edit a record in the active state.

You can edit only the root record or child records that do not have any pending changes. A yellow pending 
icon indicates whether a record contains any pending changes.

1. From the Search Results panel of the Search page, open the record that you want to edit. 

The record opens in a record view.

2. If this is not your preferred view for editing, select a different tab. 

3. Click Edit. 

Tip: If the button is disabled, you may not have permission to edit the record or the record has changes 
that are pending approval.

The following image shows the record for Edward John McNair, in edit mode. The record also contains a 
child record that you cannot edit because it has pending changes.

4. Edit the data in the root record as required. 

a. Click anywhere in the top section. 

The section becomes editable.

b. Edit the data. 

5. Edit the data in child records as required. 

a. Expand the child section. 

b. Click the Edit icon. 

The section becomes editable.
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c. Edit the data. 

d. Click the Apply icon. 

6. Click Save. 

If your user role permits you to save data without a review, the application saves the record to the MDM 
Hub Store as active records. Otherwise, the application saves the record as a pending record and 
initiates the review process associated with your role.

Edit Multiple Records
You can perform a bulk edit to replace one value in a certain field with another value across multiple records. 
Use the Find and Replace option on the search screen to perform a bulk edit.

For example, a hospital reports that multiple patient records include the wrong gender identity. You want to 
confirm which records are affected and correct the errors.

You find the affected records and determine the values to replace. After you verify the change, you inform the 
hospital that you updated the records.

After users update records in Data Director, the change triggers a review workflow process.

Your MDM administrator must enable permissions for your user role to perform bulk edit operations.

Editing Multiple Records
If your user role includes the bulk edit permission, you can edit multiple records in the active state.

Note: You cannot edit a record that is in the pending state because the record has changes that are pending 
approval. You must wait until the review and approval process ends.

1. From the Search panel of the Search page, search for records that you want to change. 

The records appear in the Search Results panel.

Note: You can also use the Queries panel to search for previously searched records.

2. In Filters select filters to narrow down your search results. 

The Search Results panel displays the records that are directly related to the values that you input in the 
Filters panel.

3. Click the Find and Replace icon. 

The Find and Replace window opens.

4. In the Find in: drop-down list, select a column and enter the value to find in the column. 
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The following image shows how to select a column and enter the search value, Adam:

Note: To use the Find and Replace operation for lookup and dependant lookup fields, you must enter a 
value in both fields. For example, if you want to replace the Country lookup field and the State dependent 
lookup field, you must enter a search value in the lookup and dependent lookup fields.

5. Click Find. 

The search results show only the records that match the specified value.
The following image shows the search results.

6. In the Replace with: field, enter the new value. 

7. Click Replace All. 

A message confirms that you want to replace the records.

8. Click Replace All. 

A message displays the number of records replaced.

Viewing the Status of a Bulk Edit
You can use the Job Monitor to review the status of current and past bulk edit jobs. A Bulk Edit batch job 
runs when the Find-Replace Execute privilege is selected, in the Resource Privileges page in MDM Hub 
Console. When the privilege is not selected, the asynchronous job will not run.

1. From the navigation menu, select Job Monitor. 

2. Click the Bulk Edit tab. 

The bulk edit jobs are organized with the most recent job at the top of the list.

3. Find the job with the current date and time. 
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4. Review the job status. The following table shows the possible statuses. 

Status Message Description

Success All records updated successfully

In progress Records are updating

Warning Not all records updated successfully

Error Bulk edit job failed to initialize

5. If the job ends with warnings, expand the job details and click the number in the Failed column. 

A description of the errors appear in a .CSV file.

6. Correct the errors and run the bulk edit job again. 

Trigger the Bulk Edit Review Process
After you perform a bulk edit, the records update instantly. However, your MDM administrator can set up a 
workflow process to review and approve the records you want to replace. Any change to the records trigger a 
review process and saves the requested changes as pending for approval in the Task Manager.

Your MDM administrator or a user with privileges, such as, a manager, must claim and approve the records 
pending for approval. You cannot edit records pending for approval in the Task Manager.

The MDM administrator can also configure a bulk edit task to trigger a batch job. If the records to replace are 
below the value set by your MDM administrator, a batch job does not trigger. If the records to replace are 
above the value set by your MDM administrator, a batch jobs triggers.

For example, your MDM administrator sets one thousand records as the maximum value to trigger a batch 
job. If you update one thousand records or more, a batch job triggers. If you update less than one thousand 
records, a batch job does not trigger and the records update instantly.

Adding and Editing Related Records
Business entity relationships describe the affiliation between two entities. The MDM Hub supports one-to-
many and many-to-many relationships between business entities, in addition to hierarchical relationships 
between records in the same business entity. You can add, view, edit, and manage relationships between a 
business entity and the records related to the business entity.

In the Related Records panel, you can see the business entities that you have permission to view. To create 
relationships between different types of business entities, your user role must include the edit permission for 
both types of business entities.

When a relationship exists between two entities, you can add related records to a business entity. For 
example, Organization employs Person is a relationship that exists between the Organization and Person 
business entities. You can add Person records or employees as related records to the Organization. The 
Related Records panel lists the business entities that are directly related to the business entity that is open in 
the Business Entity view.

Note: If you do not see the Related Records panel when you edit a business entity, contact the MDM 
administrator.
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Scenario for Adding and Editing Related Records
A relationship is configured between the Organization and the Person business entity types, such that an 
organization employs persons. You have an organization, Informatica, to which you want to add the 
employees. John Smith is an employee of Informatica.

You search for the record for Informatica. You open the record. You search for the record for John Smith. You 
add John Smith as a related record to Informatica. After an appraisal, John Smith has a different job title and 
salary. You must update the relationship details to reflect the change. You open the record for Informatica 
and select the relationship between Informatica and John Smith. You update the relationship details.

Adding a Related Record
When a record has relationships configured, you can add related records to records. Search for and open the 
record in the Business Entity view. Search for the related record that you want to add as a related record and 
add the record in the Related Records panel.

Note: The Related Records panel must be present in the Business Entity view. To create relationships 
between different types of business entities, your user role must include the edit permission for both types of 
business entities.

1. From the Search Results panel in the Search page, select the record to which you want to add the 
related records. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. In the Related Records panel, click New. 

The Relationships dialog box opens.

4. Select the relationship type. 

5. In the Search box, type the complete search string or the search string with the asterisk wildcard 
character (*) for the record that you want to find. 

6. Click Search. 

The following image shows the search results and the filter panel: 
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7. In the Filters panel, select a value for the filter criteria that you require. 

8. Click Apply Filter. 

The revised search results appear in the Search Results panel based on the filters you set.

The following image shows the filtered records:

9. Select the record that you want to add as related record and click Select. 

10. If the relationship has additional attributes, specify the additional attributes. 

For example, for a PersonOwnsAutomobile relationship, you might have to specify the mileage and price.

11. Click Apply. 

The record is added as related record and appear in the Related Records panel.

The following image shows the related records in the Related Records panel: 

Viewing Related Records
You can view the related records in the Related Records panel. Each related record in the component is a link 
that you can open in the Business Entity view.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

1. From the Search Results panel in the Search page, select the record. 
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2. Open the record. 

The related records are listed in the Related Records panel.

Deleting a Related Record
You can delete the relationship between a record and a related record. Search for the record and then delete 
the related record in the Related Records panel.

1. From the Search Results panel in the Search page, select the record that you want to edit. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. Select the related record that you want to delete, and then click the Delete icon. 

A confirmation box appears.

4. Click Yes. 

Data Director deletes the relationship between the record and the related record and no longer displays 
the related record in the Related Records panel.

Editing the Relationship Details
You can edit the details of the relationship between a record and the related record. You can edit the 
additional attributes associated with the relationship. Search for the record and edit the relationship from the 
Related Records panel.

1. From the Search Results panel in the Search page, select the record that you want to edit. 

2. Open the record. 

The Related Records panel displays the records that are directly related to the record you open. There 
might be more than one Related Records panel.

3. In the Related Records panel, select the related record that you want to edit, and then click the Edit icon. 

4. Edit the additional attributes, and then click Apply. 

For example, assume that job title and salary are two attributes associated with the 
OrganizationEmploysPerson relationship. After an appraisal, you might edit the job title and salary for 
that Person record to reflect the changes.

Deleting a Record
If your user role includes the delete permission, you can delete records in the active state. You cannot delete 
a record that is in the pending state because the record is part of a workflow and is pending approval.

1. From the Search Results panel in the Search page, select the record that you want to delete. 

2. Open the record. 

3. Click Actions > Delete. 

A confirmation box appears.
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4. Click Yes. 

Data Director marks the record as deleted and no longer displays the record, but does not remove the 
record from the database.
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C h a p t e r  8

Importing Bulk Data
This chapter includes the following topics:

• Import Bulk Data Overview, 76

• Import Bulk Records, 77

• Import Bulk Relationships, 77

• Update Records, 78

• Field Mapping, 78

• Preview Records, 80

• Importing Data, 81

• Trigger the New File Import Review Process, 84

• File Import Summary Report, 85

• Match New Records with Existing Records, 86

Import Bulk Data Overview
You can import data and relationships in bulk from an Excel or a CSV source file into Data Director. Data with 
unicode characters, such as, Chinese, Japanese and Korean are supported. You can import up to 10000 
records at a time. However, your administrator can increase or decrease the maximum number of records to 
import in the properties file.

Before you import new data and relationships, the system identifies and maps the best target fields based on 
the columns in the source file or the value of existing records. You can compare the target fields and the 
source file and accept or reject the system suggested mapping.

After the import operation is complete, it generates an import summary that shows the number of imported 
and rejected records. If your user role permits, Data Director saves the imported records as active records. 
Otherwise, if your user role is configured to trigger a review process, Data Director saves the imported 
records as pending records and initiates the review process associated with your role.
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Import Bulk Records
You can import data with multiple business entities from an Excel or CSV source file. The import process 
helps you to create or update multiple primary records in a single operation. You can stop the import at any 
point while it is in progress. However, you cannot roll back the imported records.

You cannot import files that have special characters in the file name. For example, you cannot import a file 
with the following name: My:File.csv. The following special characters are not supported in import file 
names: / \ * ? % : | " < >

The following image shows the New File Import window with a CSV file imported:

The file properties populate based on the file you select to import. You can edit the import file properties. 
Refer to “Importing Data” on page 81

Import Bulk Relationships
You can import relationships in bulk and define new relationships. You can select previously mapped 
relationships or manually define relationships between business entities. For example, you can define a 
relationship between a Person business entity and a SecurePerson business entity.

The following image shows how you can define relationships in the Relationship panel:
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The system assigns icons to the mapped relationship fields. The icons indicate the level of confidence 
associated with each mapped relationship. You can accept or reject the mapped relationship based on the 
confidence indicators.

For more information about confidence levels, refer to “Field Mapping” on page 78.

Update Records
You can import data to update existing parent records, update child records and add child records. For 
example, you want to update a primary address field and add a secondary address to the record. You must 
import data to update the parent record and add the secondary address as a new child record.

Before you import data to update parent records, add the row ID primary key or the source key in the source 
file. To update child records, add the parent row ID, child row ID or the child cross reference primary key in 
the source file. To update cross reference records, add the cross reference primary key in the source file.

Note: When you import a file to update records using the source key and the source system, you must enter a 
value in all required fields. If you do not enter a value in the required fields, an error displays.

Field Mapping
You can map columns from your source file to suitable business entities and relationships in Data Director.

The following image shows the source columns and the identified business entities:
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Confidence icons are assigned to the most suitable business entities. The icons indicate the level of 
confidence associated with each business entity. You can accept or reject the business entities based on the 
confidence indicators.

The following table describes the confidence icons:

Confidence Icon Description

Indicates a high level of confidence. All source columns are mapped to the business entities. You 
can manually review and accept the mapping.

Indicates a medium level of confidence. All source columns are mapped to the business entities 
with a moderate level of confidence. You can manually review and accept or reject the mapping.

Indicates a low level of confidence. All source columns are mapped to the business entities with a 
low level of confidence. You should reject the mapping.

Setting Default Values
You can use the additional settings option to set default values for target fields. If a source field contains a 
null value, the target field is populated with the default value.

For example, you have set the default value for the social security target field to populate as 111-11-1111. If 
the social security source field does not contain any value, the system populates the social security target 
field with the default value of 111-11-1111.

You can also set a default value for the Date Format target field. For example, you set the default value as 
YYYY-MM-DD. If the source field has the date format as DD-MM-YYYY, the system populates the date format 
to the default value of YYYY-MM-DD.

Filtering Target Fields
You can use filters to view the required target fields and source columns.
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The following table lists the filter options:

Filter Option Description

Mapped Displays all mapped source columns and target fields

Unmapped Displays all unmapped source columns and target fields

User Mapped Displays all user mapped source columns and target fields

Auto Mapped Displays all system mapped source columns and target fields

All Displays all source columns and target fields

Filtering Source Rows
You can use the Filter Source Rows option to filter and manually map source rows to the target business 
entities or relationships. For example, the source file contains a CreditCard source row and you need to map 
this row to the correct target business entity. Drag and drop the CreditCard source row to the Filter Source 
Rows panel. A list of target business entities display with Credit Card as one of the options. You can map the 
CreditCard source row to the Credit Card target business entity.

1. In the New File Import panel, under Map Fields, click the filter icon. 

The Filter Source Rows box appears.

2. From the source columns, drag and drop a source row to the Filter Source Rows box. 

The source row appears in the Filter Source Rows box.

3. In the text box, enter a filter condition and click Apply. 

The target business entities appear based on the filter conditions you enter.

Preview Records
Before you complete the import file operation, you can preview the records to import.

Click the Show Preview icon to view details of the records to import. You can view the applicable root, parent, 
child, lookup and dependent lookup fields.

The following image shows the Record Preview panel with the records to import:
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Importing Data
You can import data in bulk into Data Director. The import operation allows you to import multiple records 
and relationships from a source file into Data Director.

1. In the left navigation pane, click New File Import. 

The New File Import page opens.

2. To select the file to import, drag and drop a CSV or Excel source file or click Browse and select the 
source file. 

The source file data uploads.

Note: You cannot import files that have special characters in the file name.

3. Click Next. 

The source file with the imported data displays.

4. In the File Properties panel, specify the following import file properties: 

Property Description

Delimiter Character that represents the break between data values in the import file. Select a 
predefined delimiter or select Other to define a custom delimiter.

Text Qualifier Symbols used in the file to enclose a string.

Code Page Select the unicode encoding standard.
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Property Description

Import Data from Line Select the row of the source file you want to import data from.

Column Header in Row 
1

Select the row header number you want a column.

Regional Settings Set the date and time formats based on your geographical location.

Date Pattern Date pattern for dates in the import file. For more information about the supported 
date patterns, see “Supported Date Patterns” on page 83.

Decimal Separator Decimal separator. Choose a comma or a period. Default is a period.

Thousand Separator Thousand separator. Choose no separator, a comma, or a period. Default is no 
separator.

5. Click Next. 

The Map Fields page displays the source file data, the system suggested targets and the confidence 
indicators.

6. You can perform the following actions: 

a. To accept the system suggested mapping, click Accept. The suggested mapping appears under the 
Business Entity. 

b. To reject the system suggested mapping, click Reject. 

c. To partially accept the system suggested mapping, select the checkbox next to the business entities 
and click Accept. 

7. Expand the business entities or relationships to review the list of mapped target fields. Filter the mapped 
target fields to view how the target fields were mapped. 

a. Click the Show drop down list. 

A list of filter options appear. Select one of the following options:

Filter Option Description

Mapped Displays all mapped source columns and target fields.

Unmapped Displays all unmapped source columns and target fields.

User Mapped Displays all user mapped source columns and target fields.

Auto Mapped Displays all system mapped source columns and target fields.

All Displays all source columns and target fields.

8. Click Next. 

The Preview and Import screen opens.

9. To specify the source system you want to import from, select an option from the Source System drop 
down. 

Note: If you see a preview error in any field, your source file might have an invalid value. For example, if a 
social security number field contains alphanumeric characters, a preview error appears. You must 
correct all preview errors in the original source file and import the file again.
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10. You can preview the records before you import the file. Click Show Preview. 

11. Click Import. 

After the import process is complete, the My Jobs window displays the number of imported records, 
rejected records and unprocessed records.

12. To download the list of rejected records as a CSV file, click Download. 

Supported Date Patterns
When you import data, if the date values do not match with the supported date patterns, the import process 
fails.

The following table lists all the date patterns that the import process supports:

yyyy-MM-dd'T'HH:mm:ss.SSS'Z' d/M/yy h:mm:ss a d/M/yyyy H:mm:ss

yyyy/M/d d/M/yy h:mm:ss a z d/M/yyyy H:mm:ss z

yyyy/M/d h:mm d/M/yy h:mm a d-MMM-yy

yyyy/M/d h:mm:ss d/M/yy h:mm:ss a d-MMM-yy h:mm a

yyyy/M/d h:mm a d/M/yy h:mm:ss a z d-MMM-yy h:mm:ss a

yyyy/M/d h:mm:ss a d/M/yyyy d-MMM-yy h:mm:ss z a

yyyy/M/d H:mm d/M/yyyy h:mm a d-MMM-yy

yyyy/M/d H:mm:ss d/M/yyyy h:mm:ss a d-MMM-yy HH:mm

d/M/yy d/M/yyyy h:mm:ss a z d-MMM-yy HH:mm:ss

d/M/yy h:mm a d/M/yyyy H:mm d-MMM-yy HH:mm:ss z

d MMMM, yyyy d MMMM, yyyy h:mm a d MMMM, yyyy h:mm:ss a

d MMMM yyyy h:mm a d MMMM yyyy h:mm:ss a d MMMM yyyy h:mm:ss a z

d MMM yyyy h:mm:ss a d MMM yyyy HH:mm d MMM yyyy HH:mm:ss

d MMMM yyyy h:mm a d MMMM yyyy h:mm:ss a d MMMM yyyy HH:mm

M/d/yy M/d/yy h:mm a M/d/yy h:mm:ss a

M/d/yyyy h:mm a M/d/yyyy h:mm:ss a M/d/yyyy h:mm:ss a z

M d, yy h:mm:ss a z M d, yy h:mm:ss a MMM d, yyyy

MMM d, yyyy h:mm:ss a z MMMM d, yyyy MMMM d, yyyy h:mm a

MMMM d, yyyy h:mm:ss a z dd-MM-yyyy h:mm:ss z a dd-MM-yyyy

dd-MM-yyyy h:mm:ss a dd-MM-yyyy HH:mm:ss dd-MM-yyyy HH:mm:ss z

d MMM, yyyy h:mm a d MMM, yyyy h:mm:ss a d MMM, yyyy h:mm:ss a z
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d MMMM yyyy d MMMM yyyy HH:mm:ss z M/d/yyyy

MMM d, yyyy h:mm:ss a MMMM d, yyyy h:mm:ss z a d-MMM-yyyy h:mm:ss a

d-MMM-yyyy d-MMM-yyyy h:mm a d-MMM-yyyy h:mm:ss z a

d-MMM-yyyy h:mm:ss z a d-MMM-yyyy d-MMM-yyyy HH:mm

d-MMM-yyyy HH:mm:ss d-MMM-yyyy HH:mm:ss z dd-MM-yyyy

dd-MM-yyyy h:mm a d MMMM, yyyy h:mm:ss a z d MMM yyyy

d MMM yyyy HH:mm:ss z d MMMM yyyy HH:mm:ss M/d/yy h:mm:ss a z

M d, yy MMM d, yyyy h:mm a MMMM d, yyyy h:mm:ss

dd-MM-yyyy HH:mm d MMM, yyyy d MMMM yyyy

M d, yy h:mm a

.

Trigger the New File Import Review Process
After you import a new file with bulk data, a review process triggers and saves the requested changes as 
pending records in the Task Manager. Your MDM administrator or a user with the correct privileges, such as, 
a manager, must claim and approve the pending records. You cannot edit records pending for approval in the 
Task Manager.

All bulk import tasks trigger a batch job. The MDM administrator must configure the maximum value of a 
bulk import task to trigger a batch job. For example, your MDM administrator sets one thousand records as 
the maximum value to trigger a batch job. If you import one thousand records or more, a batch job triggers. If 
you import less than one thousand records, a batch job does not trigger and the records are imported 
instantly.
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File Import Summary Report
When you import data and relationships into Data Director, the import operation generates a summary report. 
In the navigation bar, click My Jobs to view the list of imported files.

The following image shows the My Jobs page with the list of imported files: 

1. File Name

2. Start Date

3. End Date

4. Job Type

5. Status

6. Results

You can expand the file to view results of the imported file.

The following image shows a sample import summary report:

The following table describes the elements of the Results field:

Elements Description

Total Total number of records imported.

Persisted Number of imported records persisted without errors.

Load Errors Number of rejected records not imported due to load errors.

Parsing Errors Number of rejected records not imported due to parsing errors.

The import operation writes rejected records to an Excel or CSV file. You can download rejected records, 
update the records with the correct data and re-import the corrected records.
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Match New Records with Existing Records
Before you import a file, you can perform a match to compare the records you import with existing records. 
The match process identifies duplicate and unmatched records. You can select to import the matched 
records, unmatched records or import all records.

Match Rule Sets
A match rule set contains a logical set of match rules. Match rules define the criteria for the match process 
to determine whether two records are duplicates. Based on the requirements and the purpose of the match, 
the MDM Hub administrators configure match rule sets in the MDM Hub Console. The ad hoc match process 
uses a match rule set to identify the duplicate records.

For more information about Match Rule Sets, see the Informatica Multidomain MDM Version 10.4 Hub 
Configuration Guide.

Matching Records
You can import data in into Data Director and perform an ad hoc match to compare new records with the 
existing records.

1. In the navigation pane, click Ad Hoc Match. 

The Ad Hoc Match page opens.

2. To select the file you want to import, drag and drop a CSV or an Excel file. 

3. Optionally, you can click Browse. 

4. Click Next. 

The File Properties page opens.

5. In the File Properties panel, specify the following ad hoc match properties: 

Property Description

Import from Sheet Select the source file name. This option is applicable only for Excel files.

Import Data from Line Select the row of the source file you want to import data from.

Has Column Headers Select to display table headers for each column

Column Header in Row Enter the header number of the row that you want a column.

Regional Settings Select this option if records contain international characters.

Date Pattern Date pattern for dates in the import file. For more information about the supported date 
patterns, see “Supported Date Patterns” on page 83.

Decimal Separator Decimal separator. Choose a comma or a period. Default is a period.

Thousand Separator Thousand separator. Choose no separator, a comma, or a period. Default is no 
separator.

6. Click Next. 
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The Map Fields page displays the source file data, the system suggested targets and the confidence 
indicators.

7. You can perform the following actions: 

a. To accept the system suggested mapping, click Accept. The suggested mapping appears under the 
Business Entity. 

b. To reject the system suggested mapping, click Reject. 

c. To partially accept the system suggested mapping, select the checkbox next to the business entities 
and click Accept. 

8. Expand the business entities or relationships to review the list of mapped target fields. You can filter the 
mapped target fields to view how the target fields were mapped. 

a. Click the Show drop down list. 

A list of filter options appear. Select one of the following options:

Filter Option Description

Mapped Displays all mapped source columns and target fields.

Unmapped Displays all unmapped source columns and target fields.

User Mapped Displays all user mapped source columns and target fields.

Auto Mapped Displays all system mapped source columns and target fields.

All Displays all source columns and target fields.

9. Click Next. 

The Preview Match Resultsscreen appears.

10. To select the match rule set, click the Match Rule Set drop down. 

The source file data appears in the Preview Match Results panel.

11. You can preview the records before you import the file. Click Show Preview. 

12. Click Match. 

The match job completes.

13. After the match process is complete, click the My Jobs window to display the match results. 

14. To download the list of matched records as an Excel or CSV file, click Download. 

Match Results
When you perform an ad hoc match, Data Director generates the match results that contain details of the 
matched, unique, skipped and all records. You can review the match results to determine whether to import 
the system suggested records.

The match results show the following information:

• Number of matched records

• Number of unique records

• Skipped records

• All records
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The following image shows the sample match results and a list of matched records:

The following table describes the tabs of the Match Results panel:

Tab Name Description

Matching Records Lists the input records and the existing matched records as matched pairs and assigns a 
confidence level. For example, an import record with the last name 'Smith' and an existing record 
with the last name 'Smith' are assigned a 100% confidence level and paired together. You can 
click the confidence level score to view the match rules applied.

Unique Records Lists the unmatched input records.

Skipped Lists the records that are not processed by the system.

All Records Lists the matched, unmatched and skipped records.

You can download the match reports as a Microsoft Excel file or a CSV file that lists the matched, unique and 
all records.
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C h a p t e r  9

Resolving Duplicate Records
This chapter includes the following topics:

• Resolving Duplicate Records Overview, 89

• Scenario for Duplicate Records, 93

• Resolving Duplicate Records, 93

• Resolving Duplicate Child Records in a Single Record, 97

Resolving Duplicate Records Overview
Your organization might have data that originates in multiple systems, resulting in duplicate, hard to merge 
records. To resolve the duplicate records, you can use the Matching Records view in Data Director. You can 
identify the duplicates, and merge the best version of the data into a single master record.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

When you merge duplicate records, you can preview what the merged record would look like. If you are 
satisfied with the preview, you can merge the records.

You must have the required privileges to view and merge the records. You can see only the business entities 
for which you have the required privileges. To request additional role privileges, contact your MDM 
administrator.

Matching Records View
You can resolve duplicate records by using the basic Matching Records view or the advanced Matching 
Records view. Your application might have one or both the Matching Records views configured.

Basic Matching Records View

You can use the basic Matching Records view to merge only the duplicate parent records.
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The following image shows a sample basic Matching Records view:

Advanced Matching Records View

You can use the advanced Matching Records view to merge the duplicate parent and child records.

The following image shows a sample advanced Matching Records view that is displaying the parent-level 
records:

The following image shows a sample advanced Matching Records view that is displaying the child-level 
records:
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Matching Records and Match Rules
Data Director depends on match rules to determine the matching records. An MDM administrator configures 
match rules based on the data characteristics and the requirements for matching and merging records.

The match rules determine whether the matching records have identical values or similar values. Also, match 
rules determine the records that are automatically merged and the records that appear on the Matching 
Records view.

For example, consider a match rule that is based on addresses. Based on the match rule, John Smith and 
Jane Smith are identified as matching records, because they share the same address. Though their address 
is the same, they are unique people. Their records are not duplicates and must not be merged.

The records that appear on the Matching Records view have a match score associated with them. The match 
scores are based on the match rules. A high match score indicates that the record is a close match. A low 
match score indicates that the record is a distant match.

Note: When a match job runs, the matching records are identified. If a match job was not run recently, the 
Matching Records view might not contain all the possible matches. If you upgrade from an earlier version, 
the match scores are set to null for the existing matching records. The match scores are displayed only for 
the new matches. 

For more information about match rules, see the Multidomain MDM Configuration Guide.

Best Version Of the Truth and Trust Scores
Best version of the truth is the result of merging the most trustworthy field values from the duplicate records. 
Data Director uses trust scores to evaluate and determine the most trustworthy field values. When you 
prepare to merge duplicate records, you can finalize the best version of the truth.

You can finalize the best version of the truth by promoting or overriding the values in the Merge Preview 
column with values that you think are correct. For the values that you override to take effect, the MDM 
administrator must have configured trust for the Admin system. When you merge records, if child-level 
records with values that you override are also being merged, an additional cross-reference record, which is 
called an edit record might be created or updated. An edit record is created or updated when you override 
values in the Merge Preview column. The edit record contains only the field values that you override.

To identify an edit record, look for the following field values:

• Source system. The value is Admin.

• Source primary key. The value is generated by the MDM Hub and is the same as the Record ID or has the 
format SYS:<number>.

If trust is configured for your environment, the records that appear on the Matching Records view have trust 
scores associated with the fields for which trust is enabled. Trust scores are a measure of the relative 
trustworthiness associated with field values based on their source system, change history, and other 
business rules. Trust scores range from zero to 100. A field value with a higher trust score is more 
trustworthy than a field value with a lower trust score.

For more information about the best version of the truth and trust scores, see the Multidomain MDM 
Configuration Guide.
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Merging Duplicate Records
To resolve duplicates, you merge the records that you identify as duplicates. When you merge duplicate 
records, a single master record is created.

The records that you want to merge consist of a parent record level and might consist of multiple child 
record levels. The child records can have a one-to-one or a one-to-many relationship with the parent record. 
For example, John Smith's record consists of name, date of birth, and gender details at the parent record 
level. The child record level includes addresses, email, and phone numbers.

Note: IDD application developers define the parent-to-child relationships when they define the structure of a 
business entity.

When you merge records, the duplicate parent records merge into a single parent record. If the records to 
merge have child records, you need to identify your scenario and act accordingly.

The following table describes the child record scenarios, the related actions, and the results of each action:

Child Record Scenario Action Result

Duplicate child records with 
one-to-one relationship

Automatic merge. The one-to-one child records from each parent record 
automatically become the child record of the merged parent 
record.

Some duplicate child records 
with one-to-many relationship

Select duplicate 
child records to 
merge.

The duplicate child records merge to become the child record 
of the merged parent record. The child records that are not 
selected become the child records of the merged parent 
record.

Unique child records with 
one-to-many relationship

Automatic 
inheritance.

The child records from each of the parent records become the 
child records of the merged parent record.

Example

Let's consider merging three duplicate records, where each record has a parent-level with name, date of birth, 
and gender details. The child record level includes the home address and phone numbers.

The following image shows how the three person records are merged:
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Scenario for Duplicate Records
You work for an insurance organization. A customer, Paula Laine, calls to review her home insurance policy. 
You ask Ms. Laine for her policy number, and enter the policy number in the Search box.

In the search results, you select the record that contains the policy number, and open the record in the 
Business Entity view. You confirm a few personal details and then answer Ms. Laine's questions about her 
policy.

After you answer her questions, you ask Ms. Laine if she has any other policies. Ms. Laine tells you that she 
has an automobile policy registered with a subsidiary of your organization. You enter the automobile policy 
number in the Search box, and the search returns the record that contains the automobile policy. You verify 
that the personal data matches the data in the other record.

After you end the conversation, you open the record that contains the home policy in the Matching Records 
view. From the similar records, you select the entity that contains the automobile policy. You click Preview 
and verify that both policies appear in the Policies section. In addition, you can see that the merged record is 
more complete overall, with data such as Ms. Laine's middle name and her mobile phone number coming 
from different source records. When you are satisfied that the merge preview represents the best version of 
the truth, you start the merge process.

Resolving Duplicate Records
Use the Matching Records view to identify duplicate records. You can resolve the duplicate records by 
merging them. To merge records, your user role must include the merge permission.

You can resolve the duplicate records by using the basic Matching Records view or the advanced Matching 
Records view. Use the basic Matching Records view when you want to merge only the duplicate parent 
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records. To merge the duplicate parent and child records, use the advanced Matching Records view. Your 
application might have one or both the Matching Records views configured.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

By Using the Basic Matching Records View

To resolve duplicate records using the basic Matching Records view, perform the following tasks:

1. Identify duplicate parent records.

2. Finalize the best version of the truth for parent records.

3. If child records exist, identify duplicate child records.

4. Finalize the best version of the truth for child records.

5. Merge duplicate records.

By Using the Advanced Matching Records View

To resolve duplicate records using the advanced Matching Records view, perform the following tasks:

1. Identify duplicate parent records.

2. Finalize the best version of the truth for parent records.

3. Merge duplicate records.

Identifying Duplicate Parent Records
To identify duplicate records, open the target record in the Matching Records view. The target record appears 
along with the matching records in the Matching Records view. Start by identifying duplicates at the parent 
record level.

1. Open the target record, and then select the Matching Records tab. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.

The matching records appear in the Matching Records view.

2. For the advanced Matching Records view only. Optionally, view only the records that satisfy a specific 
match rule. 

a. Click the Filter tab. 

b. Select Specify a match rule. 

c. Click in the field and select the match rule from the list. 

3. If duplicate records that you want to merge with the target record are missing in the Matching Records 
view, manually add the records. 

If you use queries to find records that you want to add, the queries must be created before you perform 
this step.

a. Click Add Candidate. 

The search user interface appears.

b. Find and select the records that you want to add. 

c. Click Select. 

The records are added to the Matching Records view.
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4. Optionally, to show more information that might be helpful in determining duplicates, click Show, and 
select the options. 

Option Description

System fields Displays system fields. This option is not available in the basic Matching Records view.

Selected records Displays only the records that you select for merging. This option is not available in the basic 
Matching Records view.

Trust scores Displays trust scores for all the trust-enabled fields. Trust settings are managed by the MDM 
administrator.

5. Identify the duplicate records that you want to merge with the target record. 

a. Compare the data of each matching record with the target record. 

b. Select the duplicate records. 

Note: You cannot select records if your user role does not include permission to merge the records. 
To request changes to your role privileges, contact your MDM administrator.

The Merge Preview column shows the result of merging the records.

6. Optionally, remove records that you do not want to merge or are not duplicates. 

a. To remove a manually added record from the Matching Records view, from the Actions menu of the 
record, click Remove Candidate. 

b. To remove a system matched record from the Matching Records view and dissociate it as a match 
of the target record, from the Actions menu of the record, click Not a match. 

When you dissociate a matching record, the record does not automatically match again.

Finalizing the Best Version Of the Truth
After you identify the duplicate records that you want to merge, finalize the best version of the truth. The 
Merge Preview column in the Matching Records view displays the best version of the truth based on the trust 
scores. You can finalize the best version of the truth by promoting or overriding the values in the Merge 
Preview column with values that you think are correct.

1. Review the values in the Merge Preview column. 

2. If an incorrect value is displayed in the Merge Preview column, review the values for the field in the 
matching records, and perform one of the following actions: 

Action Description

Click the correct value The correct value appears in the Merge Preview column. Data Director promotes 
the correct value over the incorrect value.

Enter the correct value in 
the Merge Preview column

Data Director overrides the incorrect value with the value that you enter in the 
Merge Preview column.
Note: You can only edit fields for which you have edit privileges.

Identifying Duplicate Child Records
If you use the advanced Matching Records view, you can identify the duplicate child records by reviewing the 
child records and their descendant records in the Matching Records view. Select a target child record with 
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which you compare the child records of other parent records. Select the duplicate child records that you want 
to merge.

Note: As you work with the child records, you might find data that makes you decide that a parent record is 
not a duplicate. You can return to the record overview and clear the check box for that parent record. The 
data in the Merge Preview column is refreshed.

1. In the Navigate panel, expand a node and select a child record as the target record. 

The target child record appears next to the Merge Preview column. The remaining child records appear 
in the other columns.

Tip: If the record shows a pending status, the record cannot be merged with other records.

2. Select the duplicate child records that you want to merge with the target child record. 

Tip: If the record shows a pending status, you cannot select the record to merge with other records.

The Merge Preview column shows the result of merging the target child record with the duplicate child 
records.

3. If the target child record can be further expanded, then expand the record and select the node that is 
exposed. 

All the fields of the child records are displayed.

4. Repeat the process on the remaining child records. Optionally, you can perform the same process on 
descendant records. 

5. Click Merge. 

6. In the Merge Duplicates dialog box, confirm the merge. 

A manual merge request is saved in an internal change list.

Merging Duplicate Records
After you identify the duplicate records and finalize the best version of the truth, you can merge the duplicate 
records.

1. Optionally, preview the result of merging the records. 

a. Click Preview. 

The Record Preview appears.

b. Review the record. 

c. To return to the Matching Records view, click Back. 

2. Merge the duplicate records manually or queue the duplicate records for an Automerge job. 

• To manually merge the duplicate records, click Merge.

Based on your user role privileges, one of the following actions occur:

User Role Privilege Result

Requires a review process to 
merge records

The duplicate records that you selected go through the merge review 
workflow. The records remain in the active state, but the records are 
merged only after the merge proposal is approved.

Does not require a review 
process to merge records

The duplicate records that you selected are merged into a single record 
and remain in the active state.
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• To automatically merge the duplicate records, click the Actions menu, and then click Queue for 
Merge.

The records are queued for merge, and the records merge when the Automerge job runs. The 
Automerge job is run by the MDM administrator.

Note: If your user role does not have the privileges to merge records, the Queue for Merge menu item 
is not available.

Related Topics:
• “Establish the Best Version of the Truth” on page 100

• “Identifying Duplicate Parent Records” on page 94

Resolving Duplicate Child Records in a Single Record
To resolve duplicate child records within a single record, open the record in the Matching Records view. Do 
not select any other records.

1. Open the record that has duplicate child records, and then select the Matching Records tab. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.

The record appears in the Matching Records view.

2. In the Navigate panel, expand a node and select a child record as the target record. 

The target child record appears next to the Merge Preview column. The remaining child records appear 
in the other columns.

3. Select the duplicate child records that you want to merge with the target child record. 

The Merge Preview column shows the result of merging the target child record with the duplicate child 
records. The most trustworthy field values are highlighted. The highlighted values appear in the Merge 
Preview column.

4. Review the values in the Merge Preview column. 

5. If an incorrect value is displayed in the Merge Preview column, review the values for the field in the 
matching records, and perform one of the following actions: 

Action Description

Click the correct value The correct value appears in the Merge Preview column. Data Director promotes 
the correct value over the incorrect value.

Enter the correct value in 
the Merge Preview column

Data Director overrides the incorrect value with the value that you enter in the 
Merge Preview column.
Note: You can only edit fields for which you have edit privileges.

6. Repeat the process on the remaining child records. Optionally, you can perform the same process on 
descendant records. 

7. Merge the duplicate records manually or queue the duplicate records for an Automerge job. 

• To manually merge the duplicate records, click Merge.
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Based on your user role privileges, one of the following actions occur:

User Role Type Outcome

Requires a review process to 
merge records

The duplicate records that you selected go through the merge review 
workflow. The records remain in the active state, but the records are 
merged only after the merge proposal is approved.

Does not require a review 
process to merge records

The duplicate records that you selected are merged into a single record 
and remain in the active state.

• To automatically merge the duplicate child records, click the Actions menu, and then click Queue for 
Merge.

The child records are queued for merge, and the records merge when the Automerge job runs. The 
Automerge job is run by the MDM administrator.

Note: If your user role does not have the privileges to merge records, the Queue for Merge menu item 
is not available.
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C h a p t e r  1 0

Establishing the Best Version of 
the Truth

This chapter includes the following topics:

• Master Records and the Best Version of the Truth, 99

• Scenario, 100

• Establish the Best Version of the Truth, 100

• Understand Manual Updates to a Master Record, 101

• Unmerge Cross-reference Records, 102

Master Records and the Best Version of the Truth
Master records in the MDM Hub maintain the best version of the truth. The MDM Hub consolidates the most 
trustworthy data from several source systems into each master record to achieve the best version of the 
truth.

The MDM Hub stores source data in cross-reference records. In the Cross-reference Records view, a data 
steward can examine these cross-reference records and investigate which source data contributes to the 
master record. Data stewards can then make adjustments to how source data is consolidated to ensure that 
the master record represents the best version of the truth.

The MDM Hub calculates a trust score for the fields in the cross-reference records. The trust calculation is 
based on settings and rules that are establish by an administrator. For more information about configuring 
the rules that govern trust score calculations, see the Multidomain MDM Configuration Guide.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.
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Scenario
A data steward investigates why customer data in a master record does not represent the best version of the 
truth.

The phone number for a customer has recently changed to 555-5555. None of the cross-reference records 
contain this phone number, so the data steward selects the phone number field in the master record and 
enters the correct phone number.

A master record for a customer record shows the middle name of a customer as 'Stacy'. In fact, the correct 
spelling of the middle name is 'Stacey'. The data steward sees that a cross-reference record contains the 
correct spelling but does not contribute to the master record. The data steward selects the field with the 
correct spelling as the contributor to the master record.

The master record that represents Joe Smith actually contains two cross-reference records that represent 
customers who are not Joe Smith. The data steward unmerges these two mismatched cross-reference 
records from the master record representing Joe Smith. Master records are created from the unmerged 
cross-reference records.

Establish the Best Version of the Truth
Data stewards can use the Cross-reference Records view to examine the composition of the master record. 
Data stewards can then make adjustments to ensure the master record genuinely represents the best version 
of the truth.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

If the most trusted fields do not contain the best data, a data steward can perform the following actions to 
establish the best version of the truth:

Action Description How-to

Enter the correct 
value

If the correct value does not exist in any cross-
reference record, a data steward can enter the correct 
value in the master record.

Click the incorrect value in the Master 
Record column, and then enter the 
correct value. Press Enter, and then 
click Save.

Select the correct 
contributing field

If the field with the highest trust score does not 
contain the best version of the truth, a data steward 
can select the field that does contain the correct data 
to contribute the data to the master record.

Click the field that contains the correct 
data. Click Save

Remove 
mismatched 
source data

If a cross-reference record should not be associated 
with a particular master record, a data steward can 
unmerge the cross-reference record. A new master 
record is created from the unmerged cross-reference 
record.

Select the checkbox for the cross-
reference records that contain the 
mismatched data, and then click 
Unmerge.
For more information about 
unmerging, see “Unmerge Cross-
reference Records” on page 102.
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The following image shows the ways in which data stewards can establish the best version of the truth:

1. Enter the correct value
2. Select the correct contributing field
3. Select a cross-reference record to unmerge

Understand Manual Updates to a Master Record
In the Cross-reference Records view, the highlighted cells indicate the values with the highest trust score. 
You can manually update a value, regardless of the trust score for the field. When you manually update a 
value in the master record, the Master Record column shows the changed value. The cell highlight continues 
to identify the value with the highest trust score.

For example, consider a gender code field with the possible values: UNKNOWN, MALE, and FEMALE. In the 
following image, the gender code in the Master Record column is UNKNOWN, but the most trusted value is 
MALE:

1. The value in the master record is UNKNOWN.
2. The most trusted value (80%) is MALE.

The value in the Master Record column is the updated value of UNKNOWN. In the Admin column, the value 
UNKNOWN has a trust score of 45, because a validation rule downgrades the trust score whenever the value 
of the Gender Cd field is UNKNOWN.

Tip: Another way to update a value in the master record is to call the Put API with the TrustOverrideField 
parameter. After the update, the Put process recalculates the best version of the truth for all fields except the 
field with the trust override.
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Unmerge Cross-reference Records
If a cross-reference record should not be associated with a particular master record, a data steward can 
unmerge the cross-reference record. A new master records is created from the unmerged cross-reference 
record.

The following illustration shows the unmerge behaviour when a cross-reference record is unmerged from a 
master record that is comprised of five cross-reference records:
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C h a p t e r  1 1

Investigating Data Changes
This chapter includes the following topics:

• Investigating Data Changes Overview, 103

• Investigating Data Changes Scenario, 103

• Investigating Data Changes in a Record, 104

Investigating Data Changes Overview
You can compare the best version of the truth at different moments in time for a particular record or a record 
version. If you suspect that the data in the record or record version has changed inappropriately, you can use 
the History view to identify the data event that caused the data change.

The History view displays a chronology of data changes over the lifespan of the record or a record version. 
You can view the data that existed in the record or record version at any point in time in the chronology. View 
the data before a data event and after a data event to determine if the event caused the inappropriate data 
change. A data event is any action that changes the data in a record, such as an edit or a merge operation.

Investigating Data Changes Scenario
A customer reports that he recently changed his email address and he wants to confirm that you have his 
current contact details. You look in the History view for the record that represents this customer.

The customer stated that he changed his address in October of the current year, so you look for data events 
in the History view chronology that occurred around that time. You see that multiple data events occurred in 
October for the record that represents the customer. You navigate to the Email child record and compare the 
data before and after the data events. You see that the new email address for the customer was added. After 
further investigation, you see that the middle name of the customer was added.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.
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Investigating Data Changes in a Record
Use the History view to investigate data changes in a record.

1. With the record open, select the History tab. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.

The History view opens. Changes to the record appear on the timeline.

2. Optionally, select filters to show or hide different types of events. 

3. Optionally, select a time unit to group data events. To do this, click Options and choose a different 
timescale. For example, select M to select a monthly timescale. 

The following image shows data events grouped under the month of October:

4. Click the event labeled Email. 

The event details panel shows the record details before and after the event and the time when the record 
was updated. In this example, the email address has changed from jsmith@example.com to 
jxsmith88@example.com.
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5. Click the event labeled SMITH, JOHN. 

The following image shows that the display name of the record changed from John Smith to John 

Xavier. 
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Investigating Relationships
This chapter includes the following topics:

• Investigating Relationships Overview, 106

• User Interfaces, 106

• Managing Hierarchy Relationships, 109

• Managing Network Relationships, 114

Investigating Relationships Overview
You can view how records are related to one another by viewing the relationships for records. You can create 
and manage two types of relationships: hierarchy relationships and network relationships. Hierarchy 
relationships define parent-child relationships between records, while network relationships define related 
records.

User Interfaces
Use Data Director interfaces to manage hierarchy relationships and network relationships for a record.

Hierarchy View
The Hierarchy view displays the hierarchy relationships for the open record. Use the Hierarchy view to view, 
create, and manage relationships.

You can submit your hierarchy changes for review and approval. When you edit a hierarchy, your changes are 
highlighted in the Hierarchy view.

You can view the hierarchies for a record, including the hierarchy relationships in each hierarchy. You can 
view the hierarchy for an effective date, or compare the current version of the hierarchy with a version at 
another date. You can also export the hierarchy.

The following image shows a sample Hierarchy view for a record:
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1. Hierarchy panel

2. Relationship panel

Hierarchy Panel

The following table lists the user interface elements of the hierarchy panel:

User Interface Element User Interface Element

Hierarchy tabs Shows hierarchies to which the record belongs.

Graph Shows the tree of hierarchy relationships for the open record based on the selected 
hierarchy.

A record can belong to multiple hierarchies. If you define a default hierarchy for the hierarchy component, the 
Hierarchies panel loads the default hierarchy for the record. Otherwise, the Hierarchies panel loads the list of 
hierarchies to which the record belongs.

Relationship Panel

The following table lists the user interface elements of the relationship panel:

User Interface 
Element

Description

Related tab Shows the parent and child relationships for the open record based on the selected hierarchy 
tab.

Quick View tab Optional. Shows a condensed summary of the record details for the open record.
Note: Your MDM administrator configures the Quick View tab. Contact your MDM 
administrator to configure the view.

Network View
The Network view displays all relationships for the open record, including network relationships and hierarchy 
relationships. Use the Network view to view, create, and manage network relationships and to view hierarchy 
relationships.

You can view the network of relationships for a record for an effective date. You can show, hide, and filter 
relationships and records in the network graph. You can also export the network graph.
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The following image shows a sample Network view for a record:

1. Network panel
2. Relationship panel

Network Panel

The network panel contains the canvas that shows the network of relationships for the open record. You can 
expand, collapse, and rearrange nodes on the canvas. You can also add relationships and records to the 
network.

You can visualize the relationships as a connected graph or a tree graph.

The network layout visualizes relationships in a connected graph. The following image shows the 
relationships as a connected graph in the network layout:

The hierarchy layout visualizes relationships in a tree graph. The following image shows the relationships as 
a tree graph in the hierarchy layout:
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Relationship Panel

The following table lists the user interface elements of the relationship panel:

User Interface 
Element

Description

Active tab Shows the active network relationships for the open record based on the effective date.

Inactive tab Shows the inactive network relationships for the open record based on the effective date.

Quick View tab Optional. Shows a condensed summary of the record details for the open record.
Note: Your MDM administrator configures the Quick View tab. Contact your MDM 
administrator to configure the view.

Managing Hierarchy Relationships
A record can belong to multiple hierarchies. A hierarchy contains hierarchy relationships between records. 
For example, the John Smith record might be part of the Organization hierarchy and the Household hierarchy.

Use the Hierarchy view to view and manage hierarchy relationships for a record. For example, when you view 
the John Smith record, you might see that the record belongs to the Organization hierarchy and the 
Household hierarchy. In the Organization hierarchy for the John Smith record, there is a hierarchy relationship 
from the Informatica record to the United States record, and then a hierarchy relationship from the United 
States record to the John Smith record.

You can compare the current version of hierarchy relationships with another date. You can set the start or 
end date of a relationship. If you want to see more information about a record, you can use the Quick View 
tab or open the record in an entity tab.
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Opening a Record in the Hierarchy View
Use the Hierarchy view to examine the hierarchy relationships between the open record and other records.

To open a record in the Hierarchy view, perform one of the following actions:

• In the Search tab search results, click the More Options icon and select Hierarchy.

• In the Query tab search results, click the More Options icon and select Hierarchy.

• In the record view that displays an opened record, click Hierarchy.

Viewing Records and Relationships in a Hierarchy
View records and relationships in a hierarchy by expanding or collapsing nodes, viewing the parent and child 
relationships for a record, and viewing the relationship properties.

1. To navigate the hierarchy, click the arrow icon beside nodes to expand or collapse nodes. 

The child relationships for the selected nodes show or hide.

2. To view the parent relationships and child relationships for a record, select a node on the canvas. 

The Related tab displays the parent relationships and child relationships for the selected record.

3. To filter the relationships, in the relationship panel, click the Filter icon, and then add filters. 

The list of relationships in the relationship panel updates.

4. To search for a record, in the hierarchy panel, enter a search term in the Search field, and then click 
Search. To clear the search term and cancel the search, click Cancel Search. 

Note: You can only search for the first 1000 nodes in a hierarchy.

Adding a Hierarchical Relationship
To add a hierarchical Relationship to a hierarchy, find the record to which you want to configure a 
relationship, and then define the relationship.

1. In the Hierarchy view, hover over a node on the canvas, and then click the Add New Relationship to 
Selected Entity icon. 

The Add Related Records window appears.

2. To find the record to which you want to create a relationship, perform the following actions: 

a. In the relationship list, select a relationship. 

b. Run a query to find a related record. 

c. In the search results, select a record and then click Select. 

Tip: To select multiple records, press Ctrl and select records.

3. Optionally, define the attributes of the relationship. 

4. Click Save. 

You added a hierarchical relationship to a record. The record appears in the hierarchy as a child of the 
selected node.

When you are done editing the hierarchy, you submit your changes for approval. For more information, see 
“Submitting Hierarchy Changes” on page 112.
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Deleting a Hierarchy Relationship
Delete a hierarchy relationship that you no longer need.

If a hierarchy relationship is no longer active, you can set the end date for a relationship. For more 
information, see “Setting Today as the End Date for a Hierarchy Relationship” on page 111.

u In the Hierarchy view, hover over a node on the canvas, and then click the Delete Selected Relationship 
icon. 

The hierarchy relationship to the record no longer appears in the hierarchy. In the relationship panel, the 
deleted relationship is highlighted in red.

When you are done editing the hierarchy, you submit your changes for approval. For more information, see 
“Submitting Hierarchy Changes” on page 112.

Editing the Relationship Properties of a Hierarchy Relationship
Edit the relationship fields or the start or end date of the relationship.

1. In the Hierarchy view, to edit the properties of a relationship, perform one of the following actions: 

a. Hover over a node on the canvas and click the Edit Selected Relationship icon. 

b. Select a node on the canvas. In the relationship panel, hover over a relationship, click the More 
Actions icon, and then select Edit. 

The Edit Relationship panel opens.

2. Optionally, edit the relationship fields. 

Note: Your MDM administrator configures the available relationship fields for the relationship. Contact 
your MDM administrator to change the fields.

3. Optionally, edit the start date or end date of the relationship. 

4. Click Apply. 

Setting Today as the End Date for a Hierarchy Relationship
Configure today as the end date for a relationship to indicate the relationship as inactive.

1. In the Hierarchy view, select a node on the canvas. 

2. In the relationships panel, hover over a relationship, click the More Actions icon, and then select Set 
Today as End Date. 

Comparing with Effective Date or History Date
Compare the current version of the hierarchy with a version of the hierarchy at another effective date or 
history date.

1. In the Hierarchy view, click the Compare icon. 

The Compare from panel and Compare to panel appear.

2. In the Compare to panel, select the type of date. 

3. Select a date. 

4. Click Compare. 

In the Compare from panel, the current version of the hierarchy and hierarchy relationships appear. In the 
Compare to panel, the version of the hierarchy and hierarchy relationships for the selected date appears. 
Changes are highlighted.
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The following table explains the highlights:

Highlight Indicates

Green New relationship

Yellow Edited relationship

Red Deleted relationship

Viewing Records from the Hierarchy View
You can open a record in the entity tab to view the record details.

1. In the Hierarchy view, select a node on the canvas. 

2. In the relationships panel, hover over a relationship, click the More Actions icon, and then select Open. 

The record opens in an entity tab.

Exporting a Hierarchy
Export all nodes in the hierarchy or export only the expanded nodes in the hierarchy to a CSV file.

Note: Your MDM administrator configures the fields included in the export. Contact your MDM administration 
to change your export settings.

1. In the Hierarchy view, click the Export icon. 

2. Select one of the following export options: 

Option Description

All Export all nodes in the hierarchy, including collapsed nodes.

Expanded Export expanded nodes in the hierarchy.

3. Save the CSV file. 

Submitting Hierarchy Changes
When you are done making changes to a hierarchy, submit your changes.

1. In the Hierarchy view, click Submit. 

The Submit Hierarchy Changes window appears.

2. Review your changes. 
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The following table explains the highlights:

Highlight Indicates

Green New relationship

Yellow Edited relationship

Red Deleted relationship

3. Click Accept. 

If your user role permits you to save data without a review, the application saves the hierarchy. Otherwise, the 
application saves the hierarchy changes as a pending changes and initiates the review process associated 
with your role. For example, a workflow is triggered and a hierarchy task is created for managers to approve 
or reject your changes.

Managing Multiple Hierarchy Relationships
Manage multiple hierarchy relationships in the relationship panel. You can edit or delete multiple 
relationships, and move multiple relationships from one parent to another.

Editing Multiple Hierarchy Relationships
You can edit the properties of multiple active child relationships of the same relationship type. For example, 
you might want to use the same end date for multiple relationships.

1. In the relationship panel, select the records that you want to edit. 

2. Hover over one of the selected records, click the More Actions icon, and then select Edit. 

3. Edit the properties that you want to change. 

4. Click Apply. 

5. Click Submit. 

The Submit Hierarchy Changes window appears.

6. Click Accept. 

Deleting Multiple Hierarchy Relationships
You can delete multiple active child relationships that you no longer need.

1. In the relationship panel, select the records that you want to delete or select Select All to select all the 
records. 

2. Hover over one of the selected records, click the More Actions icon, and then select Delete. 

3. Click Submit. 

The Submit Hierarchy Changes window appears.

4. Click Accept. 

Moving Multiple Records
You can move multiple active child relationships from one parent to another.

1. In the relationship panel, select the records that you want to move. 
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2. Hover over one of the selected records, click the More Actions icon, and then select Move To. 

3. In the Move to field, select the More Actions icon. 

The Add Related Record window appears.

4. Search for the target business entity, and then click Select. 

5. In the Existing Related Records field, select End relationships or Delete relationships. 

6. Click Apply. 

7. Edit the properties that you want to change. 

8. Click Apply. 

9. Click Submit. 

The Submit Hierarchy Changes window appears.

10. Click Accept. 

Managing Network Relationships
You can view the network of relationships for a record. For example, the John Smith record might be related 
to the X100 Keyboard record. The Informatica record might be related to the John Smith record because 
Informatica employs John Smith.

Use the Network view the hierarchy relationships and network relationships for a record. You can also create 
additional network relationships in the Network view.

You can view the network of relationships for a record for an effective date. You can set the start or end date 
of a relationship. If you want to see more information about a record, you can use the Quick View tab or open 
the record in an entity tab.

Opening a Record in the Network View
Use the Network view to examine the network relationships and hierarchy relationships between the open 
record and other records.

To open a record in the Network view, perform one of the following actions:

• In the Search tab search results, click the More Options icon and select Network.

• In the Query tab search results, click the More Options icon and select Network.

• In the record view that displays an opened record, click Network.

Viewing Records and Relationships in the Network
View records and relationships in a network by expanding or collapsing nodes, viewing active and inactive 
relationships, or showing or hiding relationships on the canvas.

1. To expand a node, double-click on the node. 

2. To change the details on the canvas, in the Layout list, select a layout. 
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Use one of the following values:

• Network. Displays the relationships in a connected graph. Default is Network.

• Hierarchy. Displays the relationships in a tree graph.

3. To filter the business entities or relationships in the network graph, click the Filter icon, and then add 
filters. 

4. To filter the relationships, in the Active tab, click the Filter icon, and then add filters. 

5. To view relationships in the network for an effective date, in the Effective Date field, select a date. 

6. To hide relationships in the canvas, in the Active tab, hover over a row, click the More Actions icon, and 
then click Hide on Canvas. 

The relationship is hidden in the canvas, and the Shown on Canvas icon disappears in the row.

7. To show relationships in the canvas, in the Active tab, hover over a row, click the More Actions icon, and 
then click Show on Canvas. 

The relationship appears in the canvas, and the Shown on Canvas icon appears in the row.

8. To filter records shown on the canvas, in the relationship panel, click Add Field, and then select the filter. 
You can filter by business entity, relationship, or node visibility. You can also use up to three filters. 

The relationship panel displays the records according to the filter used.

Note: The filter option is available for active and inactive relationships.

Adding a Network Relationship to a Record
To add a network relationship to a hierarchy, find the record to which you want to configure a relationship, 
and then define the relationship.

1. In the Network view, select the node to which you want to add a relationship. 

2. To add a relationship, perform any of the following actions: 

• In the network panel, hover over a node on the canvas, and then click the Add icon.

• In the relationship panel, click the Add Business Entity Record icon.

The Add Related Records window appears.

3. To find the record to which you want to create a relationship, perform the following actions: 

a. In the relationship list, select a relationship. 

b. Run a query to find a related record. 

c. In the search results, select a record and then click Select. 

Tip: To select multiple records, press Ctrl and select records.

4. Optionally, define the attributes of the relationship. 

5. Click Save. 

You added a network relationship to a record. The relationship and record appears in the network.

Adding a Record to the Network
Add a related record to the network.

1. In the Network view, click the Add Business Entity Record icon in the toolbar. 

The saved queries window opens.

2. Run a query to find a related record. 

3. Select a record and then click Select. 
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The record node appears in the Network view. The Edit Relationship panel appears for you to define the 
relationship. Or, create a network relationship to the record.

Next, create a network relationship to the record.

Creating a Relationship between Records in the Network
Add a network relationship to an unconnected record in the network.

1. In the Network view, hover over a node, and then click the Arrow icon. 

2. Drag and release the arrow on a record node to which you want to create a relationship. 

The Edit Relationship panel opens.

3. Optionally, if there are relationship fields, specify the relationship attributes. 

4. Optionally, if timeline is enabled, configure the start date or end date. 

Setting Today as the End Date for a Network Relationship
Configure today as the end date for a relationship to indicate the relationship as inactive.

1. In the Network view, select a node in the canvas. 

2. In the relationships panel, hover over a relationship, click the More Actions icon, and then select Set 
Today as End Date. 

Deleting a Network Relationship
Delete a network relationship that you no longer need.

u In the Network view, hover over a node on the canvas, and then click the Delete Selected Relationship 
icon. 

Editing the Relationship Properties of a Network Relationship
Edit the relationship fields or the start or end date of the relationship.

1. In the Network view, to edit the properties of a relationship, select a node in the canvas. 

2. In the relationships panel, hover over a relationship, click the More Actions icon, and then select Edit. 

The Edit Relationship panel opens.

3. Optionally, edit the relationship fields. 

Note: Your MDM administrator configures the available relationship fields for the relationship. Contact 
your MDM administrator to change the fields.

4. Optionally, edit the start date or end date of the relationship. 

5. Click Apply. 

Opening Related Records from the Network View
You can open a record to view the details of the record.

u To open a record, in the relationship panel, perform any of the following actions: 

• Select a record, and then click the Open icon.
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• Hover over the record, click the More Actions icon, and then select Open.

Exporting a Network
Export an image of the network.

Note: Your MDM administrator configures the fields included in the export. Contact your MDM administration 
to change your export settings.

1. In the Network view, click the Export Graph icon. 

2. Save the PNG file. 

Managing Multiple Network Relationships
Manage multiple network relationships in the relationship panel. You can edit and delete multiple 
relationships, and move multiple relationships from one node to another.

Editing Multiple Network Relationships
You can edit the properties of multiple relationships of the same relationship type. For example, you might 
want to use the same end date for multiple relationships.

1. In the relationship panel, select the records that you want to edit. 

2. Hover over one of the selected records, click the More Actions icon, and then select Edit. 

3. Edit the properties that you want to change. 

4. Click Apply. 

5. Click Submit. 

The Change Network Summary window appears.

6. Click Accept. 

Deleting Multiple Network Relationships
You can delete multiple network relationships that you no longer need.

1. In the relationship panel, select the records that you want to delete. 

2. Hover over one of the selected records, click the More Actions icon, and then select Delete. 

3. Click Submit. 

The Change Network Summary window appears.

4. Click Accept. 

Moving Multiple Records
You can move multiple network relationships from one node to another.

Note: You cannot move hidden relationships in the network panel.

1. In the relationship panel, select the records that you want to move. 

2. Hover over one of the selected records, click the More Actions icon, and then select Move to. 

3. In the Move to field, select the More Actions icon. 

The Add Related Record window appears.
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4. Search for the target business entity, and then click Select. 

5. In the Existing Related Records field, select End relationships or Delete relationships. 

6. Click Apply. 

7. Edit the properties that you want to change. 

8. Click Apply. 

9. Click Submit. 

The Change Network Summary window appears.

10. Click Accept. 
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C h a p t e r  1 3

Investigating Data Change Events 
for Effective Periods

This chapter includes the following topics:

• Investigating Data Change Events for Effective Periods Overview, 119

• Investigating Data Change Events Scenario, 119

• Viewing Data Change Events, 120

• Adding Data Change Events, 121

• Removing Data Change Events, 122

Investigating Data Change Events for Effective 
Periods Overview

A data change event is a change to data such as marital status, address, and phone number that is effective 
for a time period. Records can have multiple data change events. Use the Timeline view to investigate data 
change events of records.

The changes to data result in new effective periods or updates to an existing or a future effective period. You 
can use the Timeline view to view changes to data over a period of time. Also, you can add and remove data 
change events to and from the timeline. To manage the data change events, use the Business Entity view or 
the Data view.

Note: The Timeline view is available only to customers who upgraded from the subject area model to the 
business entity model. If timeline is enabled for base objects in the MDM Hub Store, the Timeline view is 
available for business entities that belong to the base objects.

Investigating Data Change Events Scenario
Your organization wants to renew and also offer a new insurance package to Alex Sam. To offer a suitable 
package, you need to investigate the data change events for the record for Alex Sam.

You open the record for Alex Sam in the Timeline view. You specify a specific point in time for which you 
want to view the data change events for Alex Sam. The data change events that occurred up to the date you 
specify appear in the Timeline view. You select data change events and view the details. You find that in the 

119



past, Alex Sam was single and went by the name Alex Johns. You now have the information that will help you 
offer a suitable insurance package that will benefit Alex and the organization.

Viewing Data Change Events
You can view the data change events for a record in the Timeline view.

1. From the Data view, click Effective Periods. 

The record opens in the Timeline view. The data change events of the record that occur up to the current 
date appear in the view.

2. Optionally, to identify the data change events that occurred up to a specific point in time other than the 
current date, use the calendar to select a date range using the From: and To: fields. 

The data change events that occur up to the specified point in time for the record appear in descending 
order.

The following image shows the data change events that occurred from July 01, 2019 up to January 03, 
2020 for the record, Adam, Mary:

3. To select a time unit to group data events, click Options and choose a different timescale. For example, 
select Y to select a yearly timescale or select M to select a monthly timescale. 
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The following image shows the data events that occurred from the month of January 2019 up to July 
2019:

4. To view the existing values of a data event for a specific date, click the event, and then click Open for 
Effective Date. 

The data event opens in the Data view and displays the existing values for the specified effective date.

The following image shows the existing data event values for Adam, Mary that is effective on October 
01, 2019:

Adding Data Change Events
You can add the data change events of a child record to the timeline in the Timeline view.

1. Open a record in the Timeline view. 

2. To view the child record, click the child record tab. 

The data change events for the child record appear.

3. Select the data change event that you want to add to the timeline, and then click Add Record to 
Timeline. 

The data change event of the child record is added to the timeline.
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Removing Data Change Events
You can remove data change events for a child record from the timeline in the Timeline view.

1. Open a record in the Timeline view. 

2. Optionally, to identify the data change events that occurred up to a specific point in time other than the 
current date, use the calendar in the History date up to field to select a date. 

The data change events that occur up to the specified point in time for the record appear.

3. To move into view the portion of the timeline that has the data change events that you want to inspect, 
enter a date range or use the slider. 

4. To remove a data change event, right-click the event, and then click Remove record from timeline. 

The data change event is removed from the timeline.
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Part II: Data Director with Subject 
Areas

This part contains the following chapters:

• Adding Subject Area Records, 124

• Investigating Data Changes in the History View (Legacy), 127

• Merging Records in the Matches View, 132

• Unmerging Records in the XREF View, 137

• Search Queries from the Data Tab, 143

• Working with Records in the Data Tab, 154

• Investigating Hierarchies and Relationships, 161

• Investigating Timeline Data in the Effective Periods View, 174

• Importing Data, 177
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Adding Subject Area Records
This chapter includes the following topics:

• Adding Records in the Data View Overview, 124

• Creating Records in the Data View, 125

Adding Records in the Data View Overview
To create records based on a subject area, use the New tab with the Subject Area option and select a subject 
area.

Note: To use the New tab, your user role must include the Create permission for subject areas.

Note: In the New window, if you see both the Business Entity option and Subject Area option, ask the MDM 
administrator which one to use. The Business Entity option opens an entity tab while the Subject Area option 
opens the Data tab.

Example of Adding Subject Areas in the Data View
You are an insurance agent for a large insurance company. You have a new customer, Anthony Lomax, on the 
phone. You want to add Mr. Lomax to the database.

To add Anthony Lomax, you perform the following steps:

1. You check for an existing record by running a search. The search returns no results.

2. In the navigation bar, click New. In the New window, select Person as the subject area.

3. In the Data view, you type in Mr. Lomax's information in the form.

124



Creating Records in the Data View
To add a record based on a subject area, start from the New tab and select the subject area. The MDM 
administrator defines the subject areas and the types of data that you need to enter for the subject area.

1. In the navigation bar, click New. In the New window, select a subject area. 
For example, the application for an insurance company defines a Person subject area within a Customer 
subject area group. To add Anthony Lomax as a customer, a business user clicks New and then selects 
Customer > Person.

The Data tab contains a New Person tab with an empty data entry form. A field name with a red asterisk 
indicates a required field.

2. For each required field, click the field and type the value. 

3. For each optional field for which you have data, click the field and type the value. 

4. Optionally, type the URL to an image file in the image_url field. For best results, link to an image that is a 
maximum of 200 x 200 pixels. 

Note: For images, the MDM Hub stores the URL, not the file. If the location of the file changes, you must 
update the URL.

The following image shows some data for a record:

5. Click Apply. 

The application validates the data. If there are errors, correct them.

6. Add data to sections in the Data view. 

a. Expand a section, such as Address or Telephones. 

b. Click the Add icon. 

c. Fill in the fields. 
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The following image shows the Telephones section:

d. Click Apply. 

7. If you need to change the value of a field, click the Edit icon, edit the fields, and click Apply. 

8. After you finish adding data, save the data. 

• If your user role permits you to save data without a review, click Save. The application saves the 
record to the MDM Hub Store in active records.

• Otherwise, click Send for Approval. In the Create Task dialog box, review the task details, edit the 
details as required, and click OK. The application saves the record in pending records and initiates a 
review process.
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Investigating Data Changes in the 
History View (Legacy)

This chapter includes the following topics:

• Investigating Data Changes Overview, 127

• Opening the History View, 128

• Viewing Data Events in the History View, 128

• Comparing Data Before and After Data Events, 130

Investigating Data Changes Overview
You can compare the best version of the truth at different moments in time for a particular record or a record 
version. If you suspect that the data in the record or record version has changed inappropriately, you can use 
the History view to identify the data event that caused the data change.

The History view displays a chronology of data changes over the lifespan of the record or a record version. 
You can view the data that existed in the record or record version at any point in time in the chronology. View 
the data before a data event and after a data event to determine if the event caused the inappropriate data 
change. A data event is any action that changes the data in a record, such as an edit or a merge operation.

Scenario for Investigating Data Changes
A customer reports that they recently began receiving electricity bills for a property that does not belong to 
them. You suspect that the record that represents this customer was updated inappropriately. You look in the 
History view for the customer to determine which data event caused the problem.

The customer stated that the billing issue started in June of the current year, so you look for data events in 
the History view chronology that occurred around that time. You see that the record was merged in June. You 
compare the data before the merge and after the merge. A record for customer Joe Smith was merged with a 
record for customer John Smith. These records should be two distinct records because they represent two 
different customers.
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Opening the History View
Use the History view to investigate changes to master data.

To open a record in the History view, perform the following action:

1. In a Search tab that displays the search results, select a record. Click Open. 

The record opens in the Data view.

2. Click the History icon. 

The History view opens.

Viewing Data Events in the History View
You can view the data changes that a record has undergone in the History view. Data events appear in 
descending order.

1. Open a record in the History view. 

The changes to the record up to the current date appear.
The following image shows the history of data change events that occurred from January 01, 2008 up to 
June 07, 2020 for the record, Dunn, Samuel:

2. To view additional details about the history of the data change events, expand the data event. 
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The following image shows the expanded data change events for the record, Dunn, Samuel:

3. Optionally, to identify the data change events that occurred up to a specific point in time other than the 
current date, use the calendar to select a date range using the From: and To: fields. 

The history of data change events that occurred up to the specified point in time for the record appear in 
descending order.

4. Use filters to show or hide different types of events. 

The following image shows the available filters:
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Comparing Data Before and After Data Events
You can view the best version of the truth for a record at a specific points in time, and then compare the 
differences. View the data before and after a data event to determine how the data event affected the data in 
the record.

1. Open the record in the History view. 

Changes to the record appear on the timeline.

2. Optionally, select filters to show or hide different types of events. 

3. Optionally, select a time unit to group data events. To do this, click Options and choose a different 
timescale. For example, select M to select a monthly timescale. 

The following image shows data events grouped under the month of October:

4. Click the event labeled Email. 

The event details panel shows the record details before and after the event and the time when the record 
was updated. In this example, the email address has changed from jsmith@example.com to 
jxsmith88@example.com.
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5. Click the event labeled SMITH, JOHN. 

The following image shows that the display name of the record changed from John Smith to John 
Xavier.
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C h a p t e r  1 6

Merging Records in the Matches 
View

This chapter includes the following topics:

• Merging Records Overview, 132

• Opening the Match Merge Comparison View, 134

• Selecting Merge Candidates, 134

• Overriding the Merge Preview Results, 135

• Merging Records in the Matches View, 136

Merging Records Overview
You can merge two or more records that contain data for the same record, such as a customer, into a single 
consolidated record. The record that results from the merge represents the best version of the truth for that 
record.

Before you merge similar records, you can view the matches for the record in the Matches view. When you 
open a record in the Matches view, the SearchMatch API searches for matching records based on the match 
columns and rule definitions. The IDD application displays the matching record that the SearchMatch API 
retrieves and the matching record from the matches table.

When you merge record, the root records of the record are consolidated into a single root record. The child 
records from each of the root records become child records of the merged root record.
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The following image shows the effect of a merge on the root records and child records:

You can open a record in the Match Merge Comparison view. You can view similar records that are potential 
matches. You can then select records that are potential matches as merge candidates. You can preview the 
result of a merge between the record and the merge candidates that you select.

If you want to change the winning field value, select a winning field from a different record or manually enter 
a new value for a field. After you are satisfied that the values in the Merge Preview column are the most 
correct, you can send a proposal to merge the candidates or merge the candidates immediately.

Example of Merging Records
You are on the phone with a customer. When you open the record, you see similar records that potentially 
represent the same customer. You select potential matches as merge candidates, and then preview the result 
of the merge.

The merge preview looks good, except that you confirm with the customer that the following values are 
incorrect:

• The records contain two different birth dates for the customer: 23 June 1970 and 19 June 1970. 
Informatica Data Director selects 23 June 1970 as the correct birthday, but the customer's birthday is 19 
June 1970. You manually select 19 June 1970 as the correct birth date.

• The customer mentions that the spelling of the first name that you have on file is incorrect. You override 
the merge result for the first name and manually enter the correct spelling.

After you are satisfied that the merge preview represents the best version of the truth, you send the proposed 
merge for review.
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Opening the Match Merge Comparison View
Use the Match Merge Comparison view to investigate records with similar data.

u To open a record in the Match Merge Comparison view, perform one of the following actions: 

• In a Search tab that displays search results, select two or more records. Click Actions > Compare.

• Open a record and click the Matches icon.

The Match Merge Comparison view opens. Potential matches for the record appear with a merge 
preview.

Selecting Merge Candidates
You can use the Match Merge Comparison view to see if Data Director has identified any records that 
potentially match another record. You can then select the potential matches as merge candidates.

The Match Merge Comparison view displays the values for the record to which you are comparing in the left 
hand column. Any records that are potential matches appear in columns to the right of the current record. 
The merge preview shows the values for the record that would result if you merged the current record with 
any records that you have selected as merge candidates. When the Match Merge Comparison view first 
appears, the potential matches are not selected as merge candidates.

1. In the Match Merge Comparison view, review the values in the potential matches. 

2. Select the check box for each record that you determine is a duplicate of the current record. 

The Merge Preview column displays the record that would result from a merge of the current record and 
the records that you selected as merge candidates. The highlighted fields contribute data to the preview 
of the merged record.
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Overriding the Merge Preview Results
Informatica Data Director determines which field contains the best version of the truth based on the trust 
score of the field. The field with the highest trust score is considered the most trustworthy. The trust 
calculations are configured in the MDM Hub Console. You can manually select or enter a value to override the 
trust calculation.

1. In the Merge Preview column, move the pointer over the right-side of a field to reveal the Trust Override 
button. 

2. Click the Trust Override button. 

A dialog box opens. The name of the field appears in the title bar of the dialog box.

3. To choose the value that is the most trustworthy, select the value. 

4. To enter a new value, select the empty field, and then enter the new value. 

5. Click OK. 
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The values you selected and entered are considered to be the most trustworthy and appear in the preview of 
the merged record.

Merging Records in the Matches View
After you are satisfied with the merge results in the Merge Preview column, you can merge the records or 
send a merge proposal for review.

1. Ensure you are satisfied with the results in the Merge Preview column. 

2. If you want to merge the records, click Actions > Merge. 

The record is merged.

3. If you want to send a merge proposal for review, perform the following steps: 

a. Click Actions > Create Merge Task. 

The Create Task dialog box appears.

b. Enter a meaningful title for the merge task and change any default task attributes. 

c. Optionally, add comments or attachments for the task reviewer, and click OK. 

Note: The File Attachments section is available only if your IDD global properties are configured to 
enable attachments for tasks. For more information, see the Multidomain MDM Data Director 
Implementation Guide.

A merge review process begins.
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C h a p t e r  1 7

Unmerging Records in the XREF 
View

This chapter includes the following topics:

• Unmerging Records Overview, 137

• Opening the XREF View, 140

• Sending an Unmerge Proposal for Review, 141

Unmerging Records Overview
You can unmerge a record that was merged with another record. Use the XREF view to see the records that 
contribute to the best version of the truth for a record. If you identify a cross-reference record that should not 
be merged with the record, you can unmerge the record if you have permission or you can create an unmerge 
task. You can unmerge the cross-reference record only or you can unmerge the cross-reference record with 
lineage.

When you unmerge the cross-reference record only, the child records that were associated with the cross-
reference record you unmerge continue to be associated with the merged record.
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The following image shows the result when you unmerge the cross-reference record only:

When you unmerge the cross-reference record with lineage, the child records are associated with the 
unmerged record, just as they were before the merge.
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The following image shows the result when you unmerge the cross-reference with lineage:

You can unmerge record in the XREF view. The cross-reference view shows the best version of the truth for 
the record and the cross-reference records that have merged with the record. The cross-reference records 
are organized by the source system from which they originated. The highlighted fields show which values 
contribute to the best version of the truth. You can select a cross-reference record and create an unmerge 
task for the record to be unmerged from the record.
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The following image shows the XREF view:

1. Best version of the truth
2. Contributing cross-reference records

Example of Unmerging Record
You realize that two records should not be merged into a single record. You want to undo the merge 
operation.

You look at the record in the XREF view to see which cross-reference records should be unmerged. One 
cross-reference record represents Joe Smith and the other cross-reference record represents John Smith. 
The child record contains address information that applies to Joe Smith. You create an unmerge task and 
recommend to the task reviewer that the cross-reference record be unmerged with lineage. Unmerge with 
lineage associates the appropriate address records with the unmerged record.

Opening the XREF View
Use the XREF view to unmerge merged records. You can also view the source systems and pending cross-
reference records.

u To open a record in the XREF view, open a record and click the XREF icon. 

The XREF view opens. Fields display the master data for the selected record. The source systems 
connected to the record appear below the fields.
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Sending an Unmerge Proposal for Review
Use the XREF view to examine the cross-reference records that are consolidated into a record. You can select 
a cross-reference record to unmerge.

1. View the record in the XREF view. 

2. Examine the cross-reference records in the lower half of the view. Identify the cross-reference record to 
unmerge. 

You can click the Details tab to view child record data.

3. Right-click the cross-reference record and select Create Unmerge Task. 

The Create Task dialog box opens.

4. In the Title field, enter a meaningful title for the merge task. 
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For example, enter Unmerge Joe Smith from John Smith.

5. Change any default task attributes. 

6. Optionally, add comments or attachments for the task reviewer. 

Note: The File Attachments section is available only if your IDD global properties are configured to 
enable attachments for tasks. For more information, see the Multidomain MDM Data Director 
Implementation Guide.

7. Click OK. 

An unmerge review process begins.
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C h a p t e r  1 8

Search Queries from the Data Tab
This chapter includes the following topics:

• Search Queries from the Data Tab Overview, 143

• Types of Searches, 143

• Basic and Extended Search Queries, 144

• Advanced Search Queries, 146

• Search Results, 149

• Saved Search Queries, 150

Search Queries from the Data Tab Overview
Use the Search Form to run a search query in the Data tab. When you run a query, a search tab opens with the 
search results. Each search tab is labeled by the search query name, so that you can distinguish each search 
action. You can open multiple search tabs to perform different types of data search within subject areas and 
across subject area groups.

You can search using any of the following search types: Basic, Extended, and Advanced. The current search 
criteria is displayed at the top of your search results for easy reference. If you use a query frequently, 
consider setting this as your default query. Depending on your environment, in addition to searching with a 
subject area, you might be able to search across all subject areas within a subject area group.

Types of Searches
In the Data tab, you can perform the following types of searches:

• Basic Search. Search text, with or without a wildcard.

• Extended Search. Search match-enabled attributes. Supports fuzzy logic matching.

• Advanced Search. Search using a query statement.

Basic Search
Basic Search uses simple text comparisons to retrieve data based on your search criteria. Basic Search is 
case sensitive, so you must be careful to use uppercase letters and lowercase letters in the way you expect 
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them to appear in the master data. You can use a wildcard character in place of a character that could be 
either uppercase or lowercase. Example: %upplies.

Note: 

• In Microsoft SQL Server environments, Basic Search is not case sensitive.

• In Microsoft SQL Server environments, you cannot use square brackets ([]) and a like operator in a search 
request. To use square brackets in a search query, enclose the first square bracket ([) in an extra pair of 
square brackets ([[]). For example, to look for a record that starts with a first name like %[ABC123]%, use 
the following search query:

first_name like '%[[]ABC123]%'
Consider using a Basic Search in the following circumstances:

• You can get reliable results by providing exact text matches and wildcard patterns (or lookup values) in 
your search criteria.

• You need to search on all available attributes.

Extended Search
Extended Search uses matching logic and match-enabled attributes to search for records. Extended Search is 
not case sensitive.

Consider using an Extended Search in the following circumstances:

• You want to expand your search because you did not get the expected results from a Basic Search.

• You want to search using fuzzy logic, which can make reliable matches by taking into account spelling 
variations, possible misspellings, and other differences that can make matching data non-identical. For 
example, using fuzzy logic, you can match on variations of the word "Street", such as "St." or "St".

If you use Extended Search, note the following restrictions:

• Fewer attributes might be available to search on. For Extended Search, you can search only on attributes 
that are configured as match-enabled attributes. On the Search tab, attributes that are not match-enabled 
are unavailable (grayed out) for search.

• If Extended Search is not available (grayed out) on the Search tab, it means that the selected subject area 
or subject area group does not have an available match-enabled attribute.

• On the Search tab, one attribute (identified by an asterisk) is always required.

Note: 

• To optimize results and performance, you must define extended searches appropriately.

• When running an Extended Search, you can view the match score for the searched query. You can use the 
match score to determine how proximate the search result is when compared to the searched query. The 
maximum value for a match score is 100.

Advanced Search
Use the Advanced Query Builder to construct complex query statements.

Basic and Extended Search Queries
You can easily switch between constructing a Basic Search or an Extended Search query.
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Wildcards in Basic Search
In your search criteria for Basic Search, wildcards are special search symbols that allow you to specify a text 
pattern instead of specific characters. You would use wildcards to increase your chances of finding the data 
you want, particularly if you did not know the exact text or were searching for text that is very similar.

Note: Wildcards are used in Basic Search only. They are not needed in Extended Search because searching is 
fuzzy by default.

IDD allows you to use two different wildcard characters

• asterisk (*)

• percent sign (%)

Their usage and effect on search is identical. These characters are interchangeable, so you can use either 
one.

You can use wildcards in two different ways:

Wildcard Represents Description

Placeholder for all 
characters to the end

The search looks for the characters to the left of the wildcard, and accepts any 
characters thereafter. For example, if you specified the following search criteria for First 
Name:
Mar*
or
Mar%
IDD could return results for:
Mary, Mark, Marilyn, Marty

Placeholder for a single 
character

The search accepts any single character in the position of the wildcard. For example, if 
you specified the following search criteria for First Name:
T*m
or
To*
IDD could return results for:
Tim, Tom 

Tip: When using wildcards in Basic Search, make sure that you have positioned the wildcard character 
correctly. Incorrect placement can yield unexpected search results.

Specify Search Criteria
After you have an open query on the Search tab, you can specify the search criteria that describes the data 
you are looking for.

• You must specify search criteria for any required attribute, which is indicated by an asterisk (*).

• If Extended Search is not available (grayed out), it means that the selected subject area does not have 
available match-enabled attributes.

• If you select Extended Search, only match-enabled attributes will be available. Unavailable attributes are 
grayed out. You will not be able to specify search criteria for unavailable attributes.

• For Basic Search, you can use wildcards to specify text patterns for searching.

• If a selected attribute is configured as a lookup (for example, a list of countries), you will see a drop-down 
list of values to search on.
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Note: 

• For a timeline-enabled primary object, you can perform a search query for an effective date by specifying 
the search criteria and the effective date in the Search workspace.

• If you are performing a search for a timeline-enabled record and if the effective period is blank, the data in 
the search result is based either on the current effective date or from the base object value.

• To clear the search criteria, select Reset from the Actions menu. To clear the selection in a drop-down list, 
click DELETE or BACKSPACE.

Creating Basic or Extended Queries
To create a query, open the Search Form.

1. To open the Search Form, in the navigation bar, click Data. 

2. If the Search Form is not visible, click Search Form. 

3. From the Actions menu, click New > Standard for Basic and Extended queries. 

4. In the Query Builder window, select the subject area or subject area group through which you want to 
search. 

5. Expand the Available Attributes list and select the attributes that you want to include as search criteria 
for this query. 

Based on how the application developer configured Informatica Data Director, you can search for data 
that is outside the selected subject area or subject area group, such as cross-reference data or other 
subject areas.

6. In the Added Attributes list, rearrange the sequence of the attributes so that they appear in the order you 
want in the search query screen. 

7. If available, select the attribute by which you want the results table sorted, and specify a sort order of 
ascending or descending. 

8. Click OK. 

The query appears in the Search tab.

9. To use the query again, save the query before you build or open another query. 

Advanced Search Queries
Use the Advanced Query Builder to construct complex queries using free form query text. Advanced Search 
provides capabilities for specify search conditions that go beyond the capabilities of standard (basic and 
extended) queries. Advanced search criteria are used in the query's SQL WHERE clause.

Advanced Search uses SQL syntax and supports:

• Logical operators - AND/OR/NOT

• EXIST, NOT EXISTS, and COUNT conditions

• Comparisons operators range comparison (=, >, <, >=, <=, BETWEEN)

Be sure to validate your query syntax. You cannot save a query with invalid syntax.
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Logical Operators
Use logical operators when a search query contains multiple conditions.

The following table describes the operators that you can use and provides an example for each operator:

Operator Description Example

AND Evaluates two conditional expressions and:
- Returns TRUE if both conditions are TRUE.
- Returns FALSE if either condition is FALSE
- Otherwise returns UNKNOWN.

MATCH_PATH_COMPONENT.C_MT_ADDRESS|CITY_NAME 
= 'New York' AND COLUMN.C_PARTY|
ORGANIZATION_NAME = 'Informatica LLC'

OR Evaluates two conditional expressions and:
- Returns TRUE if either condition is TRUE.
- Returns FALSE if both conditions are 

FALSE.
- Otherwise, returns UNKNOWN.

MATCH_PATH_COMPONENT.C_MT_ADDRESS|CITY_NAME 
= 'London' OR 
MATCH_PATH_COMPONENT.C_MT_ADDRESS|CITY_NAME 
= 'Paris'

NOT Negates the conditional expression that 
follows.
- Returns TRUE if the following condition is 

FALSE.
- Returns FALSE if the following condition is 

TRUE.
- If it is UNKNOWN, it remains UNKNOWN.

MATCH_PATH_COMPONENT.C_MT_ADDRESS|
COUNTRY_CODE = 'USA' and NOT 
MATCH_PATH_COMPONENT.C_MT_ADDRESS|CITY_NAME 
= 'Los Angeles'

Conditional Operators
Use conditional operators to restrict your search results based on a supported condition.

The following table describes the operators that you can use and provides an example for each operator:

Operator Description Example

EXISTS Returns true if at least one row 
meets the specified condition in the 
subquery. NOT EXISTS is also a 
valid construct.

EXISTS(C_MT_PERSON_DETAILS, 
MATCH_PATH_COMPONENT.C_MT_PERSON_DETAILS|
BIRTH_CITY = 'NEW YORK') 

COUNT Returns the number of rows that 
meet the specified condition.

COUNT(C_MT_ADDRESS, 
MATCH_PATH_COMPONENT.C_MT_PARTY_ADDRESS_REL|
ADDRESS_TYPE = 'Shipping')
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Comparison Operators
Use comparison operators when you want to restrict the search results based on the values for the attribute 
you search on.

The following table describes the operators that you can use and provides an example for each operator:

Operator Description Example

= equals MATCH_PATH_COMPONENT.C_MT_CUSTOMER|ACCOUNT_CD = 
'123456879'

> greater than MATCH_PATH_COMPONENT.C_MT_ADDRESS|POSTAL_CD > 42000

< less than MATCH_PATH_COMPONENT.C_MT_ADDRESS|POSTAL_CD < 30000

>= greater than or equals MATCH_PATH_COMPONENT.C_MT_CUSTOMER|SALES >= 1000000

<= less than or equals MATCH_PATH_COMPONENT.C_MT_CUSTOMER|SALES <= 1000000

BETWEEN between two values (inclusive) MATCH_PATH_COMPONENT.C_MT_ADDRESS|POSTAL_CD BETWEEN 
94000 AND 96000

Date Syntax in Advanced Search Queries
You must use the correct syntax to ensure a query returns the expected results when the query contains date 
system columns.

All date system columns, such as the CREATE_DATE column, have a granularity of milliseconds. If you use 
the '=' comparison operator in a query, you must specify the date to a granularity of milliseconds.

For example, the following query does not return results for records created on August 23, 2013 because it 
does not specify a date with a granularity of milliseconds:

Person.CREATE_DATE = '23/Aug/2013' 
To run a query for a specific date without specifying a granularity of milliseconds, you can run a query on a 
range for that date.

For example, the following query returns records created on August 23, 2013:

Person.Create Date >= '23/Aug/2013' AND Person.Create Date < '24/Aug/2013' 

Creating Advanced Search Queries
To create an advance query, use the Advanced Query Builder.

1. In the navigation bar, click Data. 

In the Data tab, a new tab opens with the Search Form displayed.

2. From the Actions menu, select New > Advanced. 

The Advanced Query Builder - New Query dialog box opens.

3. Select the subject area that you want to search from the Subject Area list. 

4. Select the attributes that you want to include in the search from the Available Attributes field. 

• To include a count for the attribute in your results, click Insert COUNT.
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• To check for the existence of data, click Insert EXISTS.

When you select an attribute, the attribute appears in the Query Filter Criteria field.

5. Add logical operators, conditional operators, and comparison operators to the query as required. 

6. Optionally, select a sort option from the Sort Results By list and select an ascending or descending sort 
order. 

7. Optionally, enable Case Insensitive search. 

8. To verify the query syntax, click Validate Query. 

• If the query contains syntax errors, the Query Validation Error dialog box opens with a description of 
the syntax errors. Click Close, correct all syntax errors, and then revalidate the query.

• If the query does not contain syntax errors, a message confirms that the query is valid. Click Close.

9. Click OK. IDD revalidates the query to ensure no query syntax errors exist. 

If IDD does not detect syntax errors, a search tab opens in the Data tab.
If IDD detects syntax errors, the Query Validation Error dialog box opens. Resolve the query issues and 
then click OK again.

10. Click Run Search. 

The query results appear in the Search tab.

Example of an Advanced Search Query
COLUMN.C_PARTY|LAST_NAME like 'H%'
MATCH_PATH_COMPONENT.C_MT_PERSON_DETAILS|REMARKS is not NULL
COLUMN.C_PARTY|GENDER_CD = 'M'

Search Results
After you run a search, the search results appear in a search tab. You can open a business entity from the 
search results. You can also export search results.

Opening Records from Search Results
To investigate a record, you can select it from the search results and open the record in the Data tab. You 
search by using the search form in the Data tab, by clicking Queries, or by using the Search box in the header.

When you open a record that is timeline-enabled, specify an effective period for which to view the record. The 
default value in the field for the effective date is the current date. If you leave the effective date field empty, 
all the record versions are opened.

1. Search for the record. 

2. In the search results, select the record. 

3. Open the record in one of the following views: 

View Description

Data To view and edit the record, click Open.
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View Description

Matches To compare the record with potentially duplicate records, click Actions > Compare.

Hierarchy To view a diagram of the relationships between records, click Open Hierarchy.

Business Entity To view and edit the record in context with other sources of information about the record, click 
Entity View.

4. If prompted, specify the effective period that you want to investigate. 

The record opens in the view.

Related Topics:
• “Resolving Duplicate Records” on page 89

Exporting Search Results
If available in your environment, you can export all or selected search results to a CSV file.

• To export all results, click Actions > Export > All Results.

• To export some of the results, press the Ctrl key and click the records. Click Actions > Export > Selected 
Results.

Saved Search Queries
Consider saving the search queries that you expect to reuse.

To run a query, you must first open it so that it appears in the search form. You can open any available query 
in the list of saved queries. Available queries are queries that you have created, in addition to queries that 
others have made public.

You must have read privileges on the columns in the query, read privileges on the subject area, and read 
privileges on the package that is configured as the search package in the configuration manager tool for the 
subject area.

Saving Search Queries
To save a query so you can use it again, save it in the query builder. When you save a query, Informatica Data 
Director recognizes you as the owner of the query.

1. On the Search tab, select Save from the Actions menu. If you want to save it under a different name, 
click Save As instead. 

2. In the Save window, you can specify a different query name. 

3. Indicate whether you want to make this your default query. 

4. Depending on your environment and role, you might have the option to mark this query as Public, which 
allows others to use it as well. 

5. Click Save. 
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Running Saved Search Queries
You run saved search queries from the Search Form.

1. At the top of the Search Form, select Saved Queries. 

2. Select a saved query or use the default query. 

3. Click Open Query. 

4. Enter values in the fields if required for your search. 

5. Click Run Search. 

The search results appear.

Viewing Details About Saved Queries
You can view query details, such as creation date and owner.

1. At the top of the Search Form, select Saved Queries.

2. Pause over a query.
A popup window displays information about the query.

Setting Your Default Query
The default query is the query that appears when you open a Search tab. Usually, the default query is the 
query that you expect to use most frequently in your job. Each user can set their own default query.

By default, no default query is defined. You must explicitly designate the saved query that you want to use. 
You can change the default query later if you find that you are using another query more frequently.

1. At the top of the Search Form, select Saved Queries.

2. Select the query that you want to designate as the default query.

3. From the Actions menu, click Set As Default.
The query name changes to a bold font.

Renaming Saved Queries
If you created a saved query, you can change the name of the query.

1. At the top of the Search Form, select Saved Queries.

2. Right-click the query name, and then click Rename.

3. Type a different name.

4. Click Save

Editing Saved Queries
To change a query that you created, you can edit it and save the changes. You cannot edit queries that you do 
not own.

1. Open the query that you want to edit. 

2. From the Actions menu in the search form, click Edit. 

3. In the Query Builder window, make the changes you want. 
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4. Click OK. 

5. Save your changes. 

Deleting Saved Queries
It is a best practice to delete queries you no longer need. You must be the creator of the query to be able to 
delete it.

1. At the top of the Search Form, select Saved Queries.

2. Right-click the query name, and then click Delete Query.

Sharing Saved Queries
You can share queries with colleagues by making the queries public or by sharing a bookmark link.

Making Saved Queries Public
Any Informatica Data Director user can use saved public queries. Only the owner can change their public 
queries.

1. In the Search Form, select Saved Queries. 

2. Right-click the saved query, and then click Mark as Public / Private. 

3. To ensure that the query is public, pause on the query. In the popup window, verify that the Visibility 
setting is set to Public. 

Sharing Query Bookmarks
To share a specific query with colleagues, copy the bookmark link and paste it in a text or email. When the 
user follows the bookmark link, the Informatica Data Director opens, prompts the user to log in, and then 
displays the bookmarked search query.

1. In the Search Form, open the query you want to share. 

2. From the Actions menu, click Show Bookmark. 

3. Copy the bookmark link. Share the link with another user. 

The user can follow the link to view the query.

Exporting Saved Queries
When you migrate an Informatica Data Director configuration from one environment to another, the saved 
search queries are not migrated. You can export the saved queries to the target environment if you need to 
use them.

1. Open the Search Form, and then select Saved Queries. 

2. Right-click the query that you want to export, and then click Export Queries. 

The query XML file is downloaded to your browser's default download location.
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Importing Saved Queries
When you migrate an Informatica Data Director configuration from one environment to another, the saved 
search queries are not migrated. You can import the saved queries from the source to the target 
environment.

If a query has the same name as the query that is being imported and is owned by the same user, the import 
process overwrites the query. If a query has the same name as the query that is being imported but is a 
public query that is owned by another user, the import process creates a version of the query with the same 
name for the user that imports the query.

If a query has errors, the import process ignores the queries. When queries are ignored, the message Some of 
the queries were not imported appears. To view the errors, check the Hub server log files.

1. At the top of the Search Form, select Saved Queries. 

2. Right-click in the Search Form, and then click Import Queries. 

3. In the Import Queries dialog box, click Browse. Select the XML file that contains the saved queries. 

4. Click Import. 
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C h a p t e r  1 9

Working with Records in the Data 
Tab

This chapter includes the following topics:

• Working with Records in the Data Tab Overview, 154

• Opening Records from Search Results, 155

• Creating Filters for Child Records, 156

• Switching Between Form and Table View, 157

• Viewing System Columns, 157

• Copying a Record, 157

• Editing Data In Records, 158

• Editing Effective Periods, 158

• Adding an Effective Period, 159

• Display Aggregated Period for Timeline-Enabled Record, 159

• Investigating a Record, 159

• Deleting a Record, 160

Working with Records in the Data Tab Overview
Use the Data tab to investigate records.

From the Data view in the Data tab, you can review and edit records. You can also use the left navigation 
icons to view the history of a record, its cross-reference records, and possible merge candidates.

You can use the Search Form in the Data view to find records. For more information about searching from the 
Data tab, see “Search Queries from the Data Tab Overview” on page 143.

Pending Records in the Data Tab
A pending record contains data that is pending approval.

In the Data tab, pending records are treated in the following ways:

• In search results, records with pending records appear in the results.
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• In the Data view, when you open a newly created record that is pending approval, the view contains the 
pending data in the parent record and all its child records.

• In the Data view, when you open a record with pending changes to the parent record, the view contains the 
approved data, not the pending changes.

• In the Data view, when you open a record with pending changes to child records, the view contains the 
approved data, not the pending changes.

• In the Data view, when you open a record with new pending child records, the view does not contain the 
new pending child records.

Opening Records from Search Results
To investigate a record, you can select it from the search results and open the record in the Data tab. You 
search by using the search form in the Data tab, by clicking Queries, or by using the Search box in the header.

When you open a record that is timeline-enabled, specify an effective period for which to view the record. The 
default value in the field for the effective date is the current date. If you leave the effective date field empty, 
all the record versions are opened.

1. Search for the record. 

2. In the search results, select the record. 

3. Open the record in one of the following views: 

View Description

Data To view and edit the record, click Open.

Matches To compare the record with potentially duplicate records, click Actions > Compare.

Hierarchy To view a diagram of the relationships between records, click Open Hierarchy.

Business Entity To view and edit the record in context with other sources of information about the record, click 
Entity View.

4. If prompted, specify the effective period that you want to investigate. 

The record opens in the view.
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Related Topics:
• “Resolving Duplicate Records” on page 89

Creating Filters for Child Records
In the child tab, if there are multiple child records, you can filter the child records based on the column name 
and its values to view only a specific (or subset) of entries. All the filters created in the data view are only 
temporary for that session, when the record is closed, you will lose all the created filters.

Filtering option is only available for One:Many and Many:Many child relationships. Also, if multiple filter 
conditions are applied, the result contains all the records that satisfy the AND condition and if multiple 
conditions are set for the same column, the result contains all the records that satisfy the OR condition.

1. In the Data view, click the child tab and click the Filter button. 

The Filter dialog box appears.

2. In the Column drop-down list, select a column value. 

Note: 

• Only column names of strings and numbers data types are supported for display in the Column drop-
down list.

• Lookup values are not displayed in the Column drop-down list.

3. Select one of the following filter conditions from the drop-down list: 

Available for Data Type Condition Description

Strings and Numbers = Column value must be equal to the filter criteria

Strings and Numbers != Column value must not be equal to the filter criteria

Numbers > Column value must be greater than the filter criteria

Numbers < Column value must be lesser than the filter criteria

Numbers >= Column value must be greater than or equal to the filter criteria

Numbers <= Column value must be lesser than or equal to the filter criteria

Strings and Numbers Is NULL Column value must be null for inclusion in the filter results

Strings and Numbers Is not NULL Column value must not be null for inclusion in the filter results

Strings Starts with Column value must start with the filter criteria

Strings Ends with Column value must end with the filter criteria

Strings Contains Column value must contain the filter criteria

Numbers Between Column value must be between the filter criteria

4. In the Value field, enter a filter criteria. 
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5. If you want to create an additional filter condition, click the add button (green plus button). 

Note: If you want to delete a filter condition, click the delete button (red cross button).

6. Click Apply. 

Note: If you want to clear filter, click the Clear Filter button.

Switching Between Form and Table View
In certain cases, you can switch between two different views of data:

• Form View shows a single record, with the record attributes displayed vertically, like a paper form. Click 
Switch to Form View if you want to isolate your investigation to a single record.

• Table View shows a list of records (one or more) in a tabular form. Each row in the table represents a 
separate record. Click Switch to Table View to see a summary list of all the associated records.

Note: 

• For subject area children, the default view (form or table) may vary depending on how your IDD is 
configured.

• For the selected child record, only associated grandchild records are displayed either in form or table 
view.

Viewing System Columns
To view system columns for the record that appears in the Data view, select System Columns from the 
Actions menu. Data Director opens a window that displays the system column details.

You can view system columns to view record metadata, such as the date on which the record was created, 
who created the record, and the row ID.

Copying a Record
You can copy a parent record and some of its children to create a record that is similar to an existing record. 
You cannot copy a timeline-enabled record.

1. In the Data tab, open the record in the Data view. 

2. Click Actions > Copy. 

3. In the new record window, change the attribute data you want. 

4. Select Save or Send for Approval, as applicable. 
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Editing Data In Records
You can edit data in a record. When you edit data, you cannot change the effective period for the record.

1. Open a record for which you want to edit the data. 

You cannot edit a record that is in the pending state because it is part of a workflow and is pending 
approval.

2. Click Actions > Edit Data. 

3. Edit the data. 

4. Click Apply. 

The fields that you edit appear highlighted.

5. Click Save. 

Data Director writes the changes to the database.

Editing Effective Periods
To correct an incorrect effective period, edit the effective period of the record. You can edit the effective 
periods for records for which you track data change events. When you edit the effective period for a record, 
Data Director saves the record with the changed effective period.

1. Open the record version for which you want to edit the effective period. 

You cannot edit a record that is in the pending state because it is part of a workflow and is pending 
approval.

a. Open the record that has the effective period that you want to edit. 

b. Click the Show Effective Periods link for the record. 

c. In the Effective Date field, use the date chooser to select a date that is within the effective period 
that you want to edit. 

d. Click Apply. 

The record version that is valid for the effective period that you want to edit opens.

2. Click Actions > Edit Period Dates. 

3. In the Edit Effective Period date fields, use the date chooser to select the correct start date and end date 
of the effective period. 

4. Select the primary and child records that you want to include in the record version that you update. 

5. Click Save. 

Data Director saves the record version with the updated effective period.
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Adding an Effective Period
You can add a record version that is applicable for a new effective period. The effective period that you add 
must be adjacent to the existing effective period. You can add effective periods to records for which you 
track data change events.

1. Open a record for which you want to add an effective period. 

2. Select the record version that you want to copy to the new effective period. 

3. Click Actions > Create New Period. 

4. In the Create New Effective Period date fields, use the date chooser to select the effective start and end 
dates. 

5. Select the primary and child records that you want to include in the new record version. 

6. Click Save. 

Data Director creates a new record version with the effective period that you specify.

Display Aggregated Period for Timeline-Enabled 
Record

For a timeline-enabled record, you can click the link Show Effective Periods to view the calculated 
aggregated period of effective periods for the record. Aggregated period is the time period where the data of 
the record does not change for any of the object (parent, children, and grandchildren). It is the intersection of 
all the effective periods for the record.

For example, if you save the effective period for the parent record for a time period 01-May-2012 to 31-
May-2012 and then you save the effective period of the child record of the same record for a time period 01-
May 2012 to 15-May-2012. The aggregated period for the record as on 01-May-2012 is 01-May 2012 to 15-
May-2012.

Note: 

• The link Show Effective Periods is available after the Save operation is completed.

• In the Data view, after you click the link Show Effective Periods, you can view the effective start date and 
effective end date of the object (parent, children, and grandchildren).

• The aggregated period displayed for the record is directly related to the date selected in the Effective Date 
field.

Investigating a Record
In the Data tab, you can change your view of the record. You can view the history of a record, its cross-
reference records, its possible merge candidates, and a diagram of related records.

1. Open the record in the Data view. 

2. If prompted, specify the effective period that you want to investigate. 

3. Based on your investigation path, select one of the following views: 
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• To view and edit the record, click the Data icon. The Data view opens.

• To view pending changes, click the XREF icon. The XREF view opens.

• To view a history of changes to the record, click the History icon. The History view opens.

• To compare the record with potentially duplicate record, click the Matches icon. The Match Merge 
Comparison view opens.

• To view a diagram of the relationships within and between records, click the Open Hierarchy button. 
The Hierarchy view opens.

• To view and edit the record in context with other sources of information about the record, click the 
Entity View button. An entity tab opens. The tab displays the name of the record.

Deleting a Record
You can delete a record that you want to remove. To delete the record displayed in the Data view, select 
Delete from the Actions menu.

Data Director marks the record as deleted and no longer displays the record, but does not remove the record 
from the database. When you delete a parent record, Data Director does not mark the child records as 
deleted. When you delete a timeline-enabled record, Data Director marks the record as deleted for all the 
effective periods.
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C h a p t e r  2 0

Investigating Hierarchies and 
Relationships

This chapter includes the following topics:

• Investigating Relationships Overview, 161

• Opening a Record in the Network View, 161

• Displaying Records and Relationships on the Canvas, 162

• Investigating Related Records, 167

• Changing Records and Relationships for a Record, 169

• Sharing the Hierarchy View of a Record, 173

Investigating Relationships Overview
A record can have relationships with other records. When the Hierarchy view is enabled, you can view a graph 
that shows how a record is related to other records.

Use the Hierarchy view to investigate relationships and the related records.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

Opening a Record in the Network View
Use the Network view to examine the network relationships and hierarchy relationships between the open 
record and other records.

u To open a record in the Network view, perform one of the following actions: 

• In the Search tab search results, select one or more records and click Open Hierarchy.

• In the Data tab, open a record and click Open Hierarchy.

The Network view opens. The selected record and the related record appear on the canvas.
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Displaying Records and Relationships on the Canvas
You can change the way that records and relationships appear on the Hierarchy canvas. You can change the 
layout, create and apply filters, hide or show related records, or change other canvas display options.

Selecting a Layout
Different layouts can reveal different insights into record relationships. You can customize the size and 
spacing in some of the layouts.

1. In the canvas, click the Layouts tab. 

The Layout panel opens.

2. Click a layout icon. 

Layout Layout Name

Hierarchy.

Tree.

Circular.

Taxonomy.

Network.

Explorer View.

3. Click Apply. 

The canvas displays the record relationships in the selected layout. If you can customize the layout, one 
or more options appear in the Layouts panel.

4. To customize the layout, set the layout options. 

• To increase a value, move the slider to the right, and then click Apply.
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• To decrease a value, move the slider to the left, and then click Apply.

• In the Network layout, you can choose whether to show spheres of influence. When selected, the 
Sphere of influence option encloses each record in a circle. The size of the circle reflects the number 
of direct relationships held by each record. The more direct relationships, the larger the circle.

Filtering Records and Relationships
Use filters to show or hide a set of records and relationships. For example, you might want to simplify the 
view so that you can focus on a particular relationship.

Defining a Filter
Use the Filters panel below the canvas to select filter options to apply to the canvas.

To enable a filter option, select the option check box. To disable a filter option, clear the check box. Filter 
options are cumulative. You can select as many or as few as you need to clarify the relationships on the 
canvas. In logical terms, filters are joined by the AND operator.

1. In the Hierarchy view, click the filter icon tab that is located below the canvas. 

The Network View Filter panel opens.

2. In the Hierarchies section, select the check boxes for one or more types of business entities. 

The filter affects all selected types of business entities.

3. Click the name of a business entity type. 

The relationship filter options for the selected business entity type appear to the right. The Data Director 
application developer defines the list of filter options.

4. Optionally, change the relationship filter options for the record. 

5. Optionally, click General and change the general filter options: 

Option Description

Hide unconnected entities Hides records with no relationship to the selected record.

Show pending relationships Shows relationships that are currently under review.

6. Optionally, click Relationship Directions and change the directional filter options: 

Option Description

Show Parents Shows the parents of the selected record.

Show Children Shows the child entities of the selected record.

Show Unknown Shows records where the relationship between the records is unknown.

Show Undirected Shows related records where the type of relationship is not specified.

Show Bidirectional Shows related records where the direction of the relationship goes both ways.

7. Click Apply. 

The application applies the selected filter options to the canvas.
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Saving a Filter
If you expect to reuse the filter options that you applied to the canvas, save the options as a filter. After you 
save a filter, you can choose to make the filter the default filter whenever the selected record is displayed in 
the canvas.

1. In the Filters panel, click Saved Filters. 

2. Type a name in the Filter Name field. 

3. To share the filter with colleagues, select Public. 

4. Click Save. 

The filter options that are currently applied to the view are saved.

5. To always apply this filter with the selected record, click the Default for Entity button. 

Applying a Saved Filter
When you apply a saved filter, the filter applies to the types of business entities selected in the filter.

1. In the Filters panel, click Saved Filters. 

2. Select the filter from the Filter Name list. 

The filter options reflect the settings in the selected filter.

3. Click Apply. 

The canvas reflects the settings in the applied filter.

Applying a Default Hierarchy Filter
When you apply a default hierarchy filter, the filter applies to the selected business entity type.

1. In the Filters panel, click Defaults. 

2. Select the filter from the Default hierarchy list. 

The filter options reflect the settings in the selected filter.

3. Click Apply. 

The canvas reflects the settings in the applied filter.

Deleting a Saved Filter
You can delete saved filters that you no longer use. If the filter is public, check with colleagues before you 
delete it.

1. In the Filters panel, click Saved Filters. 

2. Select the filter from the Filter Name list. 

The filter options reflect the settings in the selected filter.

3. Click Delete. 
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Hiding and Showing Records on the Canvas
You can hide or show selected records and records relationships on the canvas. When you hide a record in 
the canvas, the record relationship to the primary record remains intact, but the record relationship is not 
shown on the canvas.

After you hide a record, the Hierarchy view updates the remaining records that are related to the hidden 
record. In the canvas, the related records show the number of visible relationships out of the total number of 
relationships, and display a plus sign icon to show that some relationships are hidden. In the relationship 
table, the row that represents the hidden entity does not have a canvas icon.

Showing Direct and Indirect Relationships
In the Hierarchy view, direct and indirect relationships between records are expressed in hops. A hop is a 
relationship between records. A direct relationship is one hop, while an indirect relationship is more than one 
hop. For example, given records A, B, C, and D, the relationship A--D is one hop, A--B--D is two hops, and A--B--
C--D is three hops. You can change the number of hops that appears for a selected record.

1. In the canvas, click a record. 

The Actions menu appears.

2. Perform one of the following actions: 

• To view direct relationships, click Actions > Fetch > One Hop.

• To view direct and indirect relationships, click Actions > Fetch > Many Hops (#).

3. Optionally, you can change the number of hops that are shown by the Many Hops (#) option. 

a. Click Actions > Fetch > Preferences. 

b. In the Show Many Hops dialog box, set a value between 2 and 20. 

c. Click Execute. 

d. In the entity box, click the Actions menu. 

The Many Hops (#) menu item reflects the value that you set.

e. To apply the new number of hops to the canvas, click Fetch > Many Hops (#). 

Hiding a Record
If the graph is complex, you can simplify the graph by hiding records that are not meaningful to your 
investigation. When you hide a record, the record and the record relationships are hidden. You cannot hide 
the primary record or a record that functions as the anchor of the graph in the canvas.

1. In the canvas, click the record. 

The entity Actions menu appears.

2. Click Actions > Hide > Hide Entity. 

In the canvas, the record and the record relationships are hidden.

Hiding Selected Records
Select one or more records to hide. You cannot hide the primary record or a record that functions as the 
anchor of the graph in the canvas.

1. In the canvas, select records by pressing the Ctrl key and clicking the records. 

Selected records are highlighted.
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2. On the toolbar, click Actions > Hide Selected Entities. 

In the canvas, the selected records and the record relationships are hidden.

Hiding the Children of a Record
You can hide the children of a selected record. To qualify as a child record, the Direction type of the child 
record must be Child.

1. In the canvas, click the record. 

The entity Actions menu appears.

2. Click Actions > Hide > Hide Children. 

In the canvas, the children of the selected records are hidden.

Showing a Hidden Record
You can show a hidden record and the record relationships in the canvas.

1. In the canvas, click a record. 

2. If the relationship table is closed, click the arrow button to open the relationship table. 

The relationship table displays all records that are directly related to the selected record.

3. In the relationship table, select the hidden record that you want to show in the canvas. 

4. Right-click and click Add to Canvas. 

In the canvas, the record and the record relationships are displayed.

Showing All Hidden Record Relationships
When a entity box includes a plus sign icon in the lower left corner, the record has relationships to hidden 
record. You can show all the hidden records.

u To show all hidden records, click the Show icon in the entity box. 

The hidden records and the record relationships are shown on the canvas.

Navigating the Canvas
In the canvas, you can zoom in or out on the graph, move around the graph, or move quickly to another part of 
the graph.

• To zoom in or out on the graph, move the slider up or down.

• To view hidden adjacent parts of the graph, use the direction arrows to move the hidden records into view.

• To navigate quickly through a large hierarchy graph, click the Navigation tab and click a different area of 
the graph. The area appears in the canvas.

Setting Canvas Options
You can set options that control the canvas.

• To increase the height of the canvas, click the Full Screen Mode icon. The application header and 
workspace bar are hidden.
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• To show the canvas legend, click the Other tab. The legend appears on the left.

• To use simple graphics in the canvas when the number of records exceeds a threshold, click the Other 
tab, set a threshold value, and click Apply.

Investigating Related Records
As you investigate the relationships for the selected record, you might need to review the details for a related 
record or for a relationship.

You can view the following kinds of details:

• Record data

• Source systems and pending records

• System columns

• Relationship details

• Hierarchy

• History of changes

Viewing Record Data
If you need more information about a record, you can view the record data. For example, when the hierarchy 
contains similar records, you might want to confirm that you have the correct record before taking an action.

1. In the canvas, click a record. 

The entity Actions menu appears.

2. Click Actions > View > Details. 

3. In the Entity Details window, review the summary details. 

• If the details are sufficient to allow you to continue your work, click Close.

• If you need more information about the record, click More Details. The record opens in a new tab. 
You can review all the data about the record and, if necessary, edit the data.

Viewing Source Systems and Pending Changes
You can view information about contributing source systems and pending changes for a selected record.

In the MDM Hub Store, the information is stored as cross-reference (XREF) records.

1. In the canvas, click a record. 

The entity Actions menu appears.

2. Click Actions > View > Cross References. 

3. In the Cross References dialog box, review records. 

• If the details are sufficient to allow you to continue your work, click Cancel.

• If you need to make changes, edit values, and then click Save.
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Viewing System Columns
Data stewards might be interested in viewing the values in the system columns for a selected record. For 
example, you can view values for the Rowid Object column and Creator column.

1. In the canvas, click a record. 

The entity Actions menu appears.

2. Click Actions > View > System Columns. 

3. In the System Columns window, review the values. 

4. When you are finished, click Close. 

Viewing and Editing Relationship Details
If you need more information about a relationship, you can view details about the relationship, such as the 
relationship type.

1. In the canvas, click a relationship line. 

The relationship Actions menu appears.

2. Click Actions > View Relationship Details. 

3. In the Edit Relationship dialog box, review the details about the relationship. 

Option Description

Diagram Displays a diagram of the related records and the direction of the relationship.

Hierarchy The type of the business entity, such as organization or household.

Relationship Type The type of relationships that are possible between the records, such as employee or 
relative.

Rel Start Date The start date of the relationship. If the date occurs in the past, the relationship is active. If 
the date occurs in the future, the relationship will start on the specified date. If the field is 
empty, a start date was not set.

Rel End Date The end date of the relationship. If the date occurs in the past, the relationship has ended 
and is inactive. If the date occurs in the future, the relationship will end on the specified 
date. If the field is empty, the relationship is currently considered permanent.

Switch Entities You can switch the order of the record to change the direction of the relationship. The 
Switch Entities button is enabled for some Relationship Types.

Other fields Additional fields might appear for some Relationship Types.

4. Optionally, to change the relationship details, edit options and click Save. 

Viewing the Hierarchy for a Related Record
To view the relationships for a related record, you can open the related record in a Hierarchy view.

1. In the canvas, click a record. 

The entity Actions menu appears.
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2. Click Actions > Open in New Tab. 

A tab opens and displays the hierarchy for the selected record.

Viewing a History of Relationship Changes
You can investigate how relationships have changed for the record that appears in the Hierarchy view.

1. On the toolbar, click Actions > Show History. 

2. In the Change History window, below the timeline, drag the timeline slider to the period that you want to 
investigate. You can expand the period by extending the edges of the timeline slider. 

A box highlights the selected time period.

3. Right-click the timeline and click Select a Date. 

4. In the Select a Date dialog box, select a date and time, and then click OK. 

An orange line marks the comparison date on the timeline. The left-side graph changes to reflect the 
graph as it looked on the selected date and time. The right-side graph continues to show the current 
version of the graph.

5. In the Relationships row of the timeline, look for change boxes. 

• If the row is empty, there are no changes.

• Otherwise, pause on a change box to see a change summary. To see details, right-click the box and 
click View Event Details. In the Event Details window, review changes, and then click Close.

6. After you finish your investigation, click Close. 

The Change History window closes.

Changing Records and Relationships for a Record
In the Hierarchy view, you can add, edit, and delete related records and relationships for the selected records. 
If an effective date is set, the update is valid for the selected effective date.

Adding a Record to the Canvas
To create a relationship to a record that is not on the canvas, search for the record and add it to the canvas.

1. On the toolbar, click Add to Canvas. 

If you navigated to the Hierarchy view from the View list in an entity tab, the Search dialog box opens. If 
you navigated to the Hierarchy view from the legacy Data tab, the Search dialog box opens.

2. If the Search dialog box opens, perform the following steps: 

a. Optionally, select the type of business entity. 

b. Type the search term. 

c. Click Search. 

If the search process finds matches, the matching records appear in the search results.

d. Optionally, use the filters to narrow the search results. 
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e. If the record appears in the search results, select the record and click Select. 

The record appears on the canvas.

3. If the legacy Search dialog box opens, perform the following steps: 

a. Enter the search criteria. 

b. Click Run Search. 

c. If the record appears in the search results, select the record and click Add to Canvas. 

The record appears on the canvas.

4. Next steps. Create a relationship between the added record and other records. 

Adding a Relationship
You can create a relationship between two unrelated records as long as a relationship type exists for the 
business entity types.

1. Ensure that both records are visible on the canvas. You might need to use the slider to zoom out the 
canvas. 

2. Drag and drop one entity box on top of the other entity box. 

3. In the Add Relationship dialog box, configure the following options: 

Option Description

Diagram Displays a diagram of the related records and the direction of the relationship.

Hierarchy The type of the business entity, such as organization or household.

Relationship Type The type of relationships that are possible between the records, such as employee or 
relative.

Rel Start Date The start date of the relationship. If the date occurs in the past, the relationship is active. If 
the date occurs in the future, the relationship will start on the specified date. If the field is 
empty, a start date was not set.

Rel End Date The end date of the relationship. If the date occurs in the past, the relationship has ended 
and is inactive. If the date occurs in the future, the relationship will end on the specified 
date. If the field is empty, the relationship is currently considered permanent.

Switch Entities You can switch the order of the record to change the direction of the relationship. The 
Switch Entities button is enabled for some Relationship Types.

Other fields Additional fields might appear for some Relationship Types.

4. Click Save. 

In the canvas, a relationship line appears between the two records. If the relationship is directional, the 
line includes an arrowhead to show the direction.
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Editing a Record from the Hierarchy View
As you work with related records in the Hierarchy view, you might find that you need to edit data.

1. In the canvas, click a record. 

The entity Actions menu appears.

2. Click Actions > Edit > Edit Entity. 

A tab opens and displays the record in the Business Entity view.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

3. Edit data as required and save the changes. 

4. To return to the Hierarchy view, click the tab that contains the Hierarchy view. 

Finding Duplicate Records from the Hierarchy View
Data tab only. When you open the Hierarchy view from within the Data tab, you can select a record and 
search the master data for potential duplicates of the record.

1. In the canvas, click a record. 

The entity Actions menu appears.

2. Click Actions > Find > Duplicates. 

The application searches for similar records. A new tab contains the results of the search.

3. To return to the Hierarchy view, click the tab that contains the Hierarchy view. 

Initiating a Merge from the Hierarchy View
While working with a graph, you might identify potential merge candidates among the related records. Or, as 
you investigate a related record, you might want to check for merge candidates. If you find merge candidates, 
you can initiate the merge from the Hierarchy view.

Merge candidates must be of the same type of business entity. For example, to merge customers, both 
records must be of type Customer.

1. If you see two records in the graph that you want to merge, initiate the merge. 

a. In the Hierarchy view, ensure that both records are visible on the canvas. You might need to use the 
slider to zoom out the canvas. 

Note: If your MDM administrator created a custom view for this purpose, the name of the view might 
be different.

b. Click one of the records. 

c. Press the Alt key while you drag the record onto the other record. An arrow icon indicates that you 
can merge the records. An X icon indicates that you cannot merge the records. 

A tab opens and displays the merge candidates. The view contains the destination record, the 
dragged record, and a merge preview.

2. Data tab only. Alternatively, you can search the master data for possible merge candidates for a selected 
record. 

a. In the canvas, click a record. 

The entity Actions menu appears.
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b. Click Actions > Find > Merge Candidates. 

c. In the Search window, enter search criteria, and then click Run Search. 

d. In the search results, select candidates for the merge. 

e. Click OK. 

The view contains the record, the selected candidates, and a merge preview.

3. Review the merge preview, make changes as required, and initiate the merge. 

4. To return to the Hierarchy view, click the tab that contains the Hierarchy view. 

Deleting a Record from the Hierarchy View
As you work with related records in the Hierarchy view, you might find that you want to delete a record. When 
you delete a record, the record is removed from the view, and the record is marked for deletion in the MDM 
Hub Store. All the relationships between the deleted record and the selected record are also deleted. You 
cannot delete the record whose hierarchy you are viewing.

1. In the canvas, click the record that you want to delete. 

The entity Actions menu appears.

2. Click Actions > Edit > Detete Entity. 

The record and the record relationships are removed from the canvas and the relationship table. The 
record is marked for deletion in the MDM Hub Store.

Deleting a Relationship
You can delete relationships between records. You can delete the relationship immediately, or you can cause 
the relationship to expire with an end date.

The End Date Relationship option is available under the following circumstances:

• The end date is empty.

• The relationship belongs to the current source system specified for the application.

• One cross-reference record persists in the database for the current effective period where the record does 
not intersect with effective periods from other source systems.

You delete relationships from the canvas.

1. In the canvas, click the relationship line. 

The relationship Actions menu appears.

2. Click Actions. 

3. Choose how you want to delete the relationship. 

• To delete the relationship and mark it with an end date, click End Date Relationship. When prompted 
for confirmation, click Yes. The end date is set to the date before the selected effective date.

• To delete the relationship from the selected effective period without adding an end date, click Delete 
Relationship.

• To delete the relationship for all effective dates, click Delete All Relationship Periods.

The relationship line disappears and the relationship is deleted from both affected records.
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Sharing the Hierarchy View of a Record
You can share the Hierarchy view of a record either as a bookmark or as an image. For example, if you want 
to share a graph with a colleague who has access to Data Director, share a bookmark. If you want to 
communicate with other colleagues, you can create an image of the graph and insert in a document or other 
text-based communication tool.

If you want to communicate with other colleagues, you can create an image of the graph and insert in a 
document or other text-based communication tool.

Note: If your MDM administrator created a custom view for this purpose, the name of the view might be 
different.

Sharing a Bookmark to the Hierarchy View
Data tab only. If you want to share the Hierarchy view of a record with other Data Director users, you can 
send the users a bookmark URL. The user needs to log in to Data Director.

The bookmark is a fully qualified URL. You can copy the URL to any text-based communication tool, such as 
email, text message, instant message, or document.

1. Open a record in the Hierarchy view. 

2. On the toolbar, click the Actions > Show Bookmark. 

3. In the Bookmark URL window, select the entire URL, right-click, and click Copy. 

4. Click Close. 

5. Open the target text-based communication tool, and paste the URL. 

Saving an Image of the Graph
If you want to share a graph with colleagues, you can export it in JPEG format. You can then use the image in 
a report or in an email to interested colleagues.

The export process saves images to the browser's default directory for downloads.

1. With the record open, from the View list, select Hierarchy. 

Note: The tabs that appear in the open record depend on the Data Director configuration and your user 
role privileges.

2. If you want to capture a portion of the graph, display the portion of the graph in the canvas. 

3. On the toolbar, click Actions > Export to JPG. 

4. In the Export Graph dialog box, choose how much of the graph to capture. 

• To capture the visible portion of the graph, select View Port.

• To capture the entire graph, select Fit. Optionally, you can change the width and height of the image 
by using the sliders.

5. Click Export. 

The export process creates the image and saves the image to the downloads directory.
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Investigating Timeline Data in the 
Effective Periods View

This chapter includes the following topics:

• Investigating Data Change Events for Effective Periods Overview, 174

• Opening the Effective Periods View, 175

• Viewing Data Change Events, 175

Investigating Data Change Events for Effective 
Periods Overview

A data change event is a change to data such as marital status, address, and phone number that is effective 
for a time period. Records can have multiple data change events. Use the Effective Periods view to 
investigate data change events of records.

The changes to data result in new effective periods or updates to an existing or a future effective period. You 
can use the Effective Periods view to view changes to data over a period of time. Also, you can add and 
remove data change events to and from the timeline. To manage the data change events, use the Data view.

Note: If timeline is enabled for base objects in the MDM Hub Store, the Effective Periods view is available for 
those base objects.

Example of Viewing Data Change Events
Your organization wants to renew and also offer a new insurance package to Adam Mary. To offer a suitable 
package, you need to investigate the data change events for the business entity Adam Mary.

You open the business entity for Adam Mary in the Effective Periods view. You specify a specific point in time 
for which you want to view the data change events for Adam Mary. The data change events that occurred up 
to the date you specify appear in the view. You select data change events and view the details. You find that 
in the past, Adam Mary was single and went by the name Alex Mary. You now have the information that will 
help you offer a suitable insurance package that will benefit Adam Mary and the organization.
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Opening the Effective Periods View
Use the Effective Periods view to investigate data with effective dates.

Note: This view is available only if your administrator enabled the timeline feature.

To open a record in the Effective Periods view, perform the following action:

1. In a Search tab that displays the search results, select a record. Click Open. 

The record opens in the Data view.

2. Click the Effective Periods icon. 

The Effective Periods view opens.

Viewing Data Change Events
You can view the data change events for a record in the Effective Periods view.

1. Open a record in the Effective Periods view. 

The data change events of the record that occurred to the current date appear in the view.

2. Optionally, to identify the data change events that occurred up to a specific point in time other than the 
current date, use the calendar to select a date range using the From: and To: fields. 

The data change events that occurred up to the specified point in time for the record appear in 
descending order.

The following image shows the data change events that occurred from July 01, 2019 up to January 03, 
2020 for the record, Adam, Mary:

3. To select a time unit to group data events, click Options and choose a different timescale. For example, 
select Y to select a yearly timescale or select M to select a monthly timescale. 
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The following image shows the data events that occurred from the month of January 2019 up to July 
2019:

4. To view the existing values of a data event for a specific date, click the event, and then click Open for 
Effective Date. 

The data event opens in the Data view and displays the existing values for the specified effective date.

The following image shows the existing data event values for Adam, Mary that is effective on October 
01, 2019:
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Importing Data
This chapter includes the following topics:

• Data Import Overview, 177

• Importing Source Data from a File, 178

Data Import Overview
An MDM administrator can permit authorized users to import data from a source file by using Data Director. 
You can import up to 10,000 records from a single source file.

Note: The data import feature is available only when you use Data Director with subject areas.

You import data to perform the following tasks:

• Create multiple primary, child, and grandchild records in a single bulk operation.

• Update multiple primary, child, and grandchild records in a single bulk operation.

To import data, you need the source file and a data import template. The data import template contains 
import profiles that map the data in the source file to columns in base object tables.

Data Director does not perform a match for duplicates operation for the data that you import.

For more information about configuring Data Import, see the Multidomain MDM Configuration Guide.

Source File
You import data from a source file.

You can use one of the following file formats to contain your source data:

• .csv. A flat file with the data separated by a delimiter, such as a comma.

• .xlsx. A Microsoft Excel workbook with the data organized by columns in a spreadsheet.
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Importing Source Data from a File
Use the import wizard to import the data from the source file to the Operational Reference Store. Data 
Director uses the Services Integration Framework Put API to import the data.

Important: You cannot roll back changes after you start the import process.

1. In the navigation bar, click New. Select Data Import and the type of subject area. 

Note: If you do not see the Data Import option, the IDD application is not configured to show the option 
and enable data import. Contact the MDM administrator.

The General page of the import wizard opens.

2. If the template contains more than one import profile, select the import profile that you want to use from 
the list. 

3. Click Browse and select the source file. 

4. Click Next. 

The Import Properties page opens.

5. If the source file is a .csv file, specify the following properties: 

Property Description

Delimiters Specify the character that represents the break between data values in the source file.

Code page Specify the character encoding to use to interpret the data in the source file.

Text qualifier If quotes appear around text strings, specify the type of quotes.

6. If the source file is an .xlsx file, from the Worksheet name list, select the worksheet that contains the 
data. 

7. To control what data is imported from the source file, set the following properties: 

Property Description

Header If you want to omit the first line or row because it contains headings rather than data, 
select First line is header.

Start value import at 
line

If you want to start the import somewhere other than the first line or row, enter the line 
number.

8. Review the preview of the data. 

9. Click Next. 

The Import Progress page opens.

10. Click Start. 

The import process starts. When the import process ends, a message appears.

Note: For worksheets, the process attempts to import rows that contain data, rows that are empty but 
formatted, and rows that are empty but appear between rows that contain data. Data Director rejects the 
empty rows without processing them.

11. Click Finish. 
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Part III: Tasks and Reviews
This part contains the following chapters:

• Tasks, 180

• Participating in Review Processes, 188

• Managing Tasks, 201

• Review Processes Reference, 212
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Tasks
This chapter includes the following topics:

• Tasks Overview, 180

• Task Manager, 180

• Potential Owners, 186

• Potential Task Actions, 186

• Finding Tasks, 186

• Exporting Tasks , 187

Tasks Overview
A task is an activity that must be completed, such as reviewing an edited record, reviewing a merge proposal, 
or approving a new record. A workflow consists of multiple tasks linked together.

Tasks are generated by review processes. A review process is an automated business process. When a user 
adds, edits, merges, or unmerges records, the action can initiate a review process. A review process ensures 
that business managers or data stewards review and ultimately approve the data before it becomes master 
data.

A task includes the task details and the associated record that requires review. Tasks require you to take an 
action, such as accepting or rejecting edits to a record, merging records, or unmerging records. You can work 
on a task by claiming the task. You can manage tasks by performing task administration actions, such as 
assigning, releasing, or editing tasks. You can also manage tasks by taking an actions, such as accepting or 
rejecting.

Note: If you require different task types, triggers, or workflows, contact your MDM administrator. The MDM 
administrator can edit your task configurations.

Task Manager
Use the Task Manager to organize, claim, and resolve tasks that are generated by review processes. You can 
also perform task administration actions, such as assigning, releasing, or editing tasks.

To go to the Task Manager, in the navigation bar, click Task Manager. Alternatively, you can click the title of a 
task from the task inbox in the Home page. In this case, the Task Manager displays the selected task and the 
associated record. 
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The following image shows the Details View of the Task Manager with two tasks selected: 

1. Selected list
2. Custom filters
3. Quick filters tabs
4. View
5. Search
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The following table describes the user interface elements of the Task Manager:

User 
Interface 
Element

Description

Selected list Performs task administration action on the selected tasks. To use the Selected list, select the check 
box beside multiple tasks.
You can perform the following task administration actions:
- Assign
- Release
- Edit
- Claim
- Task actions, such as Accept, Reject, or Disclaim
Note: The available task administration actions depend on your selected tasks and the ActiveVOS 
workflows.

Custom filters Filters the tasks based on the filters that you select. To use custom filters, click the Filters icon, and 
then add filters.
You can use any combination of the following filters:
- Business Entity
- Hierarchies
- Creation Date
- Due Date
- Owner
- Priority
- Task Title
- Task Type

View Shows the list of tasks in the Details View or List View. To toggle the views, use the Details View or 
List View icons in the Task Manager toolbar.

Quick filter 
tabs

Shows tasks based on the predefined filter criteria for the tab.
Use one of the following filters:
- My Assigned Tasks. Shows your open assigned tasks.
- My Closed Tasks. Shows the tasks that you closed.
- Available Tasks. Shows all unassigned tasks that are available to your user group.
- All Assigned Tasks. Shows all the tasks that the users in your user group are assigned.
- All Closed Tasks. Shows all the tasks that the users in your user group closed.
- All Tasks. Shows all the closed, assigned, and unassigned tasks that are available to your user 

group.
- Tasks Created by Me. Shows the tasks that you created.

Search Searches the tasks for the search text. 

Details View
The Details View displays a list of tasks and the record associated to the selected task. The tasks are filtered 
based on the quick filters. You can further filter the tasks by using custom filters and search terms.

The following image shows a task selected in the Details View in the Task Manager:
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1. Task panel

2. Review panel

Task Panel
The task panel lists tasks based on the quick filter, custom filters, and search term. You can only view the 
task panel in the Details View.

When you open the Task Manager from the navigation bar, the task panel displays the tasks filtered by the 
first quick filter. When you open a task from the task inbox of the Home page, the task panel displays only the 
details of the selected task. 

The following table lists the details that the task panel can display:

Task Detail Description

Task Title A link that displays a short description of the review task. To review the record and take action on 
the task, click the task title. The task opens in the Task Manager and displays the associated 
record in the review panel. If your role permits it, you can edit the record from this view before 
taking action on the task. 

Type Name of a people activity within the process. 

Priority Priority of the task. The task priority can be Low, Normal, or High. When generating tasks, the 
review process assigns the same priority to all tasks of the same type. 

Task Status and 
Due Date

Status of the task and the date the task is due.
Status of the task can be Open or Closed. When the task status is Open, you can view the record 
associated with the task.
The review process calculates a default due date based on the task creation date plus a 
predefined time period.
The due date of each task is prefixed with one of the following colored dots:
- Green. Indicates that the task is not overdue.
- Red. Indicates that the task is overdue.
- Amber. Indicates that the task will be overdue in the next 24 hours.
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Task Detail Description

Owner Name of the signed-in user. 

ID Instance ID of the review process that generated the task. 

Submitted Date 
and Creator

Name of the user who created the task, and the date on which the user created the task. 

Note: If you require different task details, contact your MDM administrator. The MDM administrator can 
update the application to display the relevant task details.

Review Panel
Use the review panel to review the changed record, the comments added to the task, and the workflow 
diagram. The content of the review panel differs based on the type of change that was made to the record. 

Note: If you are a task administrator, you might not have permissions to review the changes in the review 
panel.

The following table describes the elements in the review panel: 

Element Description

Record Details Displays the details of the record associated with the task. 

Comments Displays a list of comments added to the task. 

Workflow Diagram Displays a graphical representation of the process flow associated with the task. 
You can view the workflow diagram only if you have the ActiveVOS abAdmin role assigned. 

Task Details Displays the task details in edit mode. 

Actions Actions that you can perform on the task. The possible actions depend on the task definitions in 
the review process. Sample actions can be Approve, Reject, and Disclaim.

More Actions Additional actions that you can perform on the task. 

Edit Opens the record in edit mode. 

Open Opens the record in a separate tab. 

List View
The List View displays a list of tasks filtered based on the quick filters. You can further filter the tasks by 
using custom filters and search terms.

The following image shows the Task Manager with a task selected in the List View:
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The following table lists the details that the task list can display:

Task Detail Description

Task Title A link that displays a short description of the review task. To review the record and take action on 
the task, click the task title. The task opens in the Task Manager and displays the associated 
record in the review panel. If your role permits it, you can edit the record from this view before 
taking action on the task. 

Type Name of a people activity within the process. 

Priority Priority of the task. The task priority can be Low, Normal, or High. When generating tasks, the 
review process assigns the same priority to all tasks of the same type. 

Task Status and 
Due Date

Status of the task and the date the task is due.
Status of the task can be Open or Closed. When the task status is Open, you can view the record 
associated with the task.
The review process calculates a default due date based on the task creation date plus a 
predefined time period.
The due date of each task is prefixed with one of the following colored dots:
- Green. Indicates that the task is not overdue.
- Red. Indicates that the task is overdue.
- Amber. Indicates that the task will be overdue in the next 24 hours.

Owner Name of the signed-in user. 

ID Instance ID of the review process that generated the task. 

Submitted Date 
and Creator

Name of the user who created the task, and the date on which the user created the task. 

Note: If you require different task details, contact your MDM administrator. The MDM administrator can 
update the application to display the relevant task details.
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Potential Owners
A potential owner is an user who belongs to a user group that can work on a task. The potential owners for a 
task depend on the selected task and your task definitions.

To work on a task, you claim the task. You can only claim tasks for which you are a potential owner. The 
Available Tasks tab of the Task Manager shows all the unassigned tasks for which you are a potential owner.

You can assign or reassign tasks to users who are potential owners of the task. When you assign or reassign 
multiple tasks, the possible assignees are the potential owners shared by all the selected tasks.

For example, you might want to reassign a review task for the John Smith record and a merge task for the 
Jane Smith record. The potential owners for review tasks are users assigned the Data Steward role, Manager 
role, or Senior Manager role. The potential owners for merge tasks are users assigned the Manager role and 
Senior Manager role. When reassigning these tasks together, the potential owners are users assigned the 
Manager role or Senior Manager role.

If you are assigning or reassigning a variety of tasks, there might be no potential owners shared by all the 
tasks. To increase the amount potential owners, manage tasks of the same task type. For example, you might 
want to manage merge tasks.

Note: If you and your colleagues require different user roles, task definitions, workflow triggers, or ActiveVOS 
workflows, contact your MDM administrator. The MDM administrator can change your configurations.

Potential Task Actions
A potential task action is an action that can be performed on a task. The potential task actions for a task 
depend on the selected task and your ActiveVOS workflows.

When you are working on multiple tasks, the potential task actions are the task actions shared by all the 
selected tasks. For example, you might be reviewing merge and unmerge tasks related to the John Smith 
record. The potential task actions for merge tasks are Merge, Cancel, and Disclaim. The potential task 
actions for unmerge tasks are Unmerge, Cancel, and Disclaim. When you take an action on these tasks 
together, the potential task actions are Cancel and Disclaim.

If you reviewing a variety of tasks, there might be no potential task actions shared by all the tasks. To 
increase the amount of task actions, review tasks of the same task type. For example, you might want to 
review and take an action on merge tasks.

Note: If you and your colleagues require different user roles, task definitions, workflow triggers, or ActiveVOS 
workflows, contact your MDM administrator. The MDM administrator can change your configurations.

Finding Tasks
You can use quick filters, custom filters, or search in the Task Manager to find tasks to work on or manage. 
The task panel updates as you select quick filters, add custom filters, and enter search terms.

For example, you might want to find high priority tasks related to the Peter Smith record. To find these tasks, 
you might use the Available Tasks quick filter, add a custom filter for priority, and search for Peter Smith.

The following image shows an example of how you might find a task:
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Note: To use the Search box in the Task Manager, your Data Director application with business entities must 
be configured to use Elasticsearch. Contact your MDM administrator to enable Elasticsearch and configure 
searchable fields.

Exporting Tasks
You can export the workflow tasks from the Task Manager.

Before you can export the workflow tasks, ensure you navigate to the table view in the Task Manager. Use the 
Export as Excel icon to download the required workflow tasks.

The following image displays the Export as Excel icon in the Task Manager:
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Participating in Review Processes
This chapter includes the following topics:

• Participating in Review Processes Overview, 188

• Claiming a Task, 189

• Resolving a Task, 190

• Organizing Work on Tasks, 198

Participating in Review Processes Overview
When a business user changes data in Data Director, the change might trigger a review process. A review 
process is an automated business process workflow that notifies business managers and data stewards 
when changes are ready for their review. 

Note: If the Task Manager is not enabled in your application, your user role might not have permission to 
participate in a review process. In some cases, the review process might not be required in your environment.

The type of review process depends on how the MDM administrator configured your application and whether 
the default review processes are in use. By default, there are different review processes for edits, merges, 
and unmerges.

Example of a Review Process for Edits
The staff in the Finance department use Data Director to keep supplier banking information up to date. A 
supplier representative contacts a Finance staff member and requests a change to the supplier's banking 
information.

In the Finance department, each Data Director user credential includes one of the following user roles:

• User. Staff members have permission to add and change records, but the changes must go through a 
review process before the master data is updated.

• Manager. A manager is a type of business user with additional permissions. A manager reviews changes, 
but cannot approve changes. If a manager agrees with a change, he escalates it to a senior manager.

• SrManger. A senior manager is a type of manger with additional permissions. A senior manager reviews 
changes and has the authority to approve them.
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A staff member edits the supplier data as requested by the supplier representative. The following steps 
describe what happens during the review process.

1. A staff member changes the banking information of the supplier and saves the change. In the MDM Hub 
Store, the state of the supplier records changes from active to pending. The proposed edit is saved in a 
cross-reference record. The save action initiates the review process.

2. An instance of a review process starts and begins executing activities.

3. When the review process reaches the first people activity, it generates a task notification for managers. 
For example, in the default review process, the first people activity is Review No Approve. All managers 
with the role of Manager receive a task notification in the task inbox with the task type of Review No 
Approve.

4. A manager claims the task. The task is assigned to the manager and the task disappears from the task 
inboxes of the other managers.

5. The manager opens the supplier record, reviews the edit, and agrees with the edit. The manager resolves 
the task by clicking Escalate.

6. The review process marks the task as complete, and follows the Escalate flow to the next activity.

7. When the review process reaches the next people activity, the process generates a task notification for 
senior managers. For example, in the default review process, the second people activity is Final Review. 
All senior managers with the role of SrManager receive a task notification in the task inbox with the task 
type of Final Review.

8. A senior manager claims the task. The task is assigned to the senior manager and the task disappears 
from the task inboxes of the other senior managers.

9. The senior manager opens the supplier record, reviews the edit, and agrees with the edit. The senior 
manager resolves the task by clicking Approve.

10. The review process marks the task as complete, and follows the Approve flow. The review process 
notifies the MDM Hub that the change is approved, and then the review process ends. The MDM Hub 
changes the banking information in the supplier banking record. The supplier records change to the 
active state.

Claiming a Task
Multiple users can share the same reviewer role. To work on a task, you must claim the task to ensure that 
other users cannot work on the task while you work on it. Before you can claim a task, check for comments 
or attachments. 

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click Available Tasks. 

The task panel lists all the unassigned tasks for your user group.

3. Select a task that you want to claim. 

The record appears in the review panel.

4. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 
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c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

5. Click Claim. 

The task panel updates. The task appears in the My Assigned Tasks tab. Your user name appears in the 
Owner field of the task.

Resolving a Task
You resolve a task by reviewing the new or changed record and then taking an action. The possible actions 
depend on the task definitions in the review process. 

Reviewing an Edited Record
When you open a task to review an edited record, the fields that contain edited values are marked. 

In the MDM Hub Store, the proposed edits are contained in a cross-reference record that is set to the pending 
state. 

1. In the task inbox of the Home page, click a task that is a request to review an edited record. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

3. Look for highlighted fields and decide if the edits are valid. 

4. If you see a typographical error or an incorrect value for which you know the correct value, click Edit, and 
edit the field. 

Note: The next step depends on whether you have enough information to resolve the task or if you think 
someone else should assess it.

5. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Approve If you agree with the edits and the task type permits you to approve changes, click Approve. The 
ActiveVOS Server marks the related Final Review people activity as completed and performs the next 
activity in the process. 
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Action Description

Escalate If you agree with the edits, but the task type does not permit approval at this point in the workflow, 
click Escalate. The ActiveVOS Server marks the related Review No Approve people activity as 
completed and performs the next activity in the process. 

Reject If you disagree with the one or more edits, click Reject and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who edited the record. 
Note: If a source system updates the rejected record, the record goes through the approval process 
again.

<Other> If you see other options in the menu, then your organization uses a custom business process. If the 
purpose of the option is not clear and your role permits access to the ActiveVOS console, you can 
open the process to understand the workflow. Otherwise, contact the person who created the 
business process.

The task is closed.

6. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.
Note: If this option is not available, use the Release button.

Release To return the task to the pool of available tasks, click Release and type an explanation in the 
Comment box.
Note: The release action is a task administration action. To release multiple tasks, from the Selected 
list, select Release.

The task remains open, but is no longer assigned to you.

7. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

Related Topics:
• “Claiming a Task” on page 189

• “Task Manager” on page 180
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Reviewing a New Record
When you open a task to review a new record, all field values in the record need to be validated. If you are one 
reviewer in a progressive multiple step review process, validate only the fields that you are responsible for 
validating.

In the MDM Hub Store, the parent record and child records are in the pending state until the new record is 
approved. 

1. In the task inbox of the Home page, click a task that is a request to review a new record. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

3. Determine if the values in the record meet your business requirements. 

Note: The next step depends on whether you have enough information to resolve the task or you think 
someone else should assess it.

4. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Approve If you think the record is acceptable, and the task type permits you to approve it, click Approve. The 
ActiveVOS Server marks the related Final Review people activity as completed and performs the next 
activity in the process.

Escalate If you think the record is acceptable, but the task type does not permit approval at this point in the 
workflow, click Escalate. The ActiveVOS Server marks the related Review No Approve people activity 
as completed and performs the next activity in the process.

Reject If you disagree with the one or more values, click Reject and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who added the record.
Note: If a source system updates the rejected record, the record goes through the approval process 
again.

<Other> If you see other options in the menu, then your organization uses a custom business process. If the 
purpose of the option is not clear and your role permits access to the ActiveVOS console, you can 
open the process to understand the workflow. Otherwise, contact the person who created the 
business process.

The task is closed.
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5. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.
Note: If this option is not available, use the Release button.

Release To return the task to the pool of available tasks, click Release and type an explanation in the 
Comment box.
Note: The release action is a task administration action. To release multiple tasks, from the Selected 
list, select Release.

The task remains open, but is no longer assigned to you.

6. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

Related Topics:
• “Claiming a Task” on page 189

• “Task Manager” on page 180

Reviewing a Merge Task
When you open a task to review a merge task, the primary record appears beside the records that are 
selected for the merge.

1. In the task inbox of the Home page, click a task that is a request to review a merge proposal. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

3. Review the merge preview and determine if the merge is valid. The fields that appear in the merge 
preview are highlighted. 

Note: The next step depends on whether you have enough information to resolve the task or if you think 
someone else should assess it.
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4. If required, make changes to the proposed merge task. 

a. To change the proposed merge task, perform any of the following tasks: 

Task Procedure

Add records that you want 
to merge.

Click Add Candidate. You can search for records and add the records to the 
view.

Remove records that you do 
not want to merge.

From the Actions menu, select an option:
- Remove Candidate. Removes a manually added record from the review 

panel.
- Not a Match. Removes a system matched record from the review panel 

and dissociates it as a match of the target record.

Finalize the best version of 
the truth.

Select the field with the correct value or enter the correct value in the Merge 
Preview column.

b. Click Update. 

The merge task is updated.

5. To resolve the task, select one of the following actions: 

Option Description

Merge If you agree with the merge proposals and the task types permits you to approve changes, click Merge. 
The ActiveVOS Server marks the related Merge people activity as completed and performs the next 
activity in the process.
Note: If your environment uses the BE ActiveVOS adapter, click Task Actions > Merge. If your 
environment uses the Informatica ActiveVOS adapter, click Actions > Merge.

Cancel If you disagree with the merge proposals, click Cancel and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who proposed the merge.

<Other> If you see other options, then your organization uses a custom business process. If the purpose of the 
option is not clear and your role permits access to the ActiveVOS console, you can open the process to 
understand the workflow. Otherwise, contact your MDM administrator.

The task is closed.

6. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.
Note: If this option is not available, use the Release button.
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Action Description

Release To return the task to the pool of available tasks, click Release and type an explanation in the 
Comment box.
Note: The release action is a task administration action. To release multiple tasks, from the Selected 
list, select Release.

The task remains open, but is no longer assigned to you.

7. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

Related Topics:
• “Claiming a Task” on page 189

• “Task Manager” on page 180

• “Resolving Duplicate Records” on page 93

Reviewing an Unmerge Task
When you open a task to review an unmerge tasks, a preview shows the result of the unmerge.

1. In the task inbox of the Home page, click a task that is a request to review an unmerge proposal. 

The unmerge preview for the record appears in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

3. Review the unmerge preview and determine if the unmerge is warranted. The fields that appear in the 
preview are highlighted. 

Note: The next step depends on whether you have enough information to resolve the task or if you think 
someone else should assess it.

4. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Action Description

Unmerge If you agree with the unmerge proposal and the task type permits you to approve changes, click 
Unmerge. The ActiveVOS Server marks the related Unmerge people activity as completed and 
performs the next activity in the process.

Cancel If you disagree with the unmerge proposal, click Cancel and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who proposed the unmerge.
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Action Description

<Other> If you see other options in the menu, then your organization uses a custom business process. If the 
purpose of the option is not clear and your role permits access to the ActiveVOS console, you can 
open the process to understand the workflow. Otherwise, contact the person who created the 
business process.

The task is closed.

5. To change the ownership of the task without resolving the task, click an appropriate action button, or 
click More Actions and select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The task is reassigned to the selected person.
Note: If this option is not available, click Task Details and select the user from the Assignee list.

Disclaim To return the task to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.
Note: If this option is not available, use the Release button.

Release To return the task to the pool of available tasks, click Release and type an explanation in the 
Comment box.
Note: The release action is a task administration action. To release multiple tasks, from the Selected 
list, select Release.

The task remains open, but is no longer assigned to you.

6. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

Related Topics:
• “Claiming a Task” on page 189

• “Task Manager” on page 180

Reviewing a Hierarchy Task
Review the proposed changes to a hierarchy by marking the changes that you want to accept and reject, and 
then performing a task action.

1. In the Task Manager, select a task that is a request to review an edited hierarchy. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 
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e. Click Cancel. 

3. Review the changes in the hierarchy. 

4. To accept or reject the proposed changes, click the appropriate icon beside the change: 

Option Description

Accept icon Accept the proposed change to the hierarchy.

Reject icon Reject the proposed change to the hierarchy.

By default, all changes are mark as accepted.

5. To resolve the task, click an appropriate action button, or click More Actions and select one of the 
following actions: 

Option Description

Approve If you think the proposed changes that you accepted and rejected are acceptable, click Approve. The 
ActiveVOS Server marks the related people activity as completed and performs the next activity in the 
process.

Cancel If you think the proposed changes are no longer needed, click Cancel. The ActiveVOS Server closes 
the task.

Reject If you want to send the proposed changes back for further review, click Reject. The ActiveVOS Server 
marks the related people activity as completed and sends the task back to the requester. The task 
displays the proposed changes that you marked as accept and reject.

Release To return the task to the pool of unassigned tasks, click Release and type an explanation in the 
Comment box. Someone with the same role needs to take action on the task.

Reviewing a Rejected Hierarchy Task
Review the proposed changes that were marked as accept and reject in the rejected hierarchy task.

1. In the Task Manager, select a task that is a request to review an edited hierarchy. 

The record opens in the review panel of the Task Manager.

Note: If you open an unassigned task, be sure to claim it before you start work.

2. Optionally, review the task details, comments, attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

3. Review the changes that were marked as accept and reject in the hierarchy. 
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4. To resolve the task, perform one of the following actions: 

Option Description

Submit If you think the proposed changes are acceptable, click Submit.

Cancel If you think the proposed changes are no longer needed, click Cancel. The ActiveVOS Server closes the 
task.

Open If you want to modify the proposed changes, click Open. Propose changes to the hierarchy and submit 
your changes for review.

Organizing Work on Tasks
When you have a long list of tasks, you can organize tasks by sorting and filtering the list, changing task 
properties, and assigning tasks to others. 

For example, you might want to work on the tasks that have the highest priority or on the tasks that are due 
soonest. After you filter the list of tasks, you might find tasks that need a higher priority or that can be 
postponed. You can edit the task properties to better reflect the urgency within the business to resolve tasks. 
And, if you have the authority to assign tasks to managers, you can assign the task to a manager from the 
task properties. 

Related Topics:
• “Task Manager” on page 180

Editing a Task
As you work with tasks, you might decide that some task properties need to be changed. For example, if 
changes are made to the record of an important client, you might want to increase the priority of the review 
task. Or, if you plan to be away and want to finish a set of tasks before you leave, you can change the due 
dates for the tasks to represent a date before your planned absence.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. In the task panel, select the task you want to edit. 

3. In the review panel, click Task Details. 

The following image shows the Task Details dialog box:
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4. Edit one or more of the following fields to change the task properties: 

Field Description

Task Title Enter a title that is more meaningful to you. A good title includes at least the name of the 
record and the change that initiated the review.

Priority Select a priority that reflects the urgency within the business to resolve this change.

Due Date Select a due date that reflects the urgency within the business to resolve the change.

Assignee Reassign this task to someone else.

File Attachment Attach files to provide additional information about the task. Attachments appear in the 
Task Details dialog box.
Note: The File Attachment field is available only if the task supports attachments.

Add Comment Add comments to explain edits to the task properties and to track questions and answers 
about the task. Comments appear in the Comments tab.

Assign Back to 
Pool

Return the task to the pool of unassigned tasks so that other users can claim the task.
Note: The Assign Back to Pool button is available only if the task belongs to another user.

5. Click Save. 
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Assigning Your Task to Another User
If the Assignee list is enabled in the Edit Task dialog box, you can reassign tasks.

Note: If you want to enable reassignments, contact your MDM administrator. The MDM administrator must 
implement a business process management (BPM) adapter that supports reassignments.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Select My Assigned Tasks. 

The task panel lists your assigned tasks.

3. In the task panel, select the task that you want to assign to another user. 

The record appears in the review panel.

4. To provide additional information about the task, click Task Details, and then add a comment or a file 
attachment. 

Note: If you do not have the options for comments or attachments, contact your MDM administrator to 
request that they enable comments and attachments.

5. To assign the task, select the user from the Assignee list. 

6. Click Save. 

Assigning a Task Back to the Pool
When a user in your user group is not available, you can send the user's tasks to the pool of unassigned tasks 
so that other users can claim them. The option to assign the tasks back to the pool is available only if the 
task belongs to another user.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. In the task panel, select the task that you want to send to the pool. 

The record appears in the review panel

3. In the review panel, click Task Details. 

4. Click Assign Back to Pool. 

Disclaiming a Task
If you claim or are assigned a task that you feel would be better handled by someone else, you can disclaim 
the task. Disclaimed tasks return to the pool of unassigned tasks. 

1. Click Task Manager. 

The task panel contains a list of tasks.

2. In the task panel, select an assigned task that you want to disclaim. 

The record appears in the review panel

3. In the review panel, click More Actions > Disclaim. 

4. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.
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C h a p t e r  2 5

Managing Tasks
This chapter includes the following topics:

• Managing Tasks Overview, 201

• Claiming Tasks, 202

• Resolving Tasks, 202

• Organizing Work on Tasks, 209

Managing Tasks Overview
You can manage tasks associated to business entity records by performing task administration actions. You 
can claim, assign, release, or edit tasks. Or, you can take an action on tasks, such as accept, reject, or 
disclaim. For example, you might want to release tasks claimed by an user on vacation or edit the priority of 
tasks related to the John Smith record.

The task administration actions that you can perform depend on your role and task definitions. Users 
assigned the Task Administrator role can manage all tasks, while other users can only manage tasks 
available to their user role.

If you are assigned multiple roles, you might be able to perform more task administration actions. For 
example, if you are assigned the Data Steward role and the Task Administrator role. You can manage tasks 
available to Data Stewards, and you can also manage all tasks as a task administrator.

The following table lists the task administration actions available to user roles:

User Role Task Administration Actions

Task Administrator Users can perform the following task administration actions on all tasks:
- Assign
- Release
- Edit

Other user roles Users can perform the following task administration actions on tasks available to their user role:
- Claim
Users can perform the following task administration actions on tasks based on whether they are 
assigned the tasks:
- Release
- Edit
- Task actions, such as Accept, Reject, or Disclaim
Note: The available task actions depend on the selected tasks and your ActiveVOS workflows.
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Note: If you and your colleagues require different user roles, task definitions, workflow triggers, or ActiveVOS 
workflows, contact your MDM administrator. The MDM administrator can change your configurations.

Claiming Tasks
Claim tasks that you want to work on. This ensures that other users cannot work on the tasks while you work 
on them.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click Available Tasks. 

The task panel lists all the unassigned tasks for your user group.

3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select a task and review the task details, comments, and attachments. 

a. Click the Comments tab, and then review the comments. 

b. Click Task Details. 

c. Review the details of the task, such as the priority and due date. 

d. Download attachments in the File Attachments section. 

e. Click Cancel. 

5. Repeat step 4 to find additional tasks that you want to claim. 

6. Select the check box beside the tasks that you want to manage. 

The Selected list appears.

7. From the Selected list, select Claim. 

The task panel updates. The tasks appear in the My Assigned Tasks tab. Your user name appears in the 
Owner field of the tasks.

Resolving Tasks
You can resolve tasks by reviewing tasks and then taking an action. The possible actions that you can 
perform depends on the selected tasks and your ActiveVOS workflows.

When you resolve multiple tasks, you can only take an action that is shared by all the selected tasks. To 
increase the amount of possible actions that you can perform, review tasks of the same task type.

For more information about the possible actions, see “Potential Task Actions” on page 186.
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Reviewing Edited Records
Review edited records and then resolve the tasks by taking an action. If you cannot resolve the tasks, 
disclaim the tasks to return the tasks to the pool of available tasks. Or, if you know another user who can 
resolve the tasks, reassign the tasks to that user.

Before you begin, claim the tasks that you want to work on.

When you review tasks for edited tasks, the fields that contain edited values are marked.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click My Assigned Tasks. 

The task panel lists your assigned tasks.

3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select a task and review the edited record in the review panel. 

a. Look for highlighted fields and decide if the edits are valid. 

b. If you see a typographical error or an incorrect value for which you know the correct value, click Edit, 
and edit the field. 

5. Repeat step 4 for each edited record that you want to review. 

6. Select the check box beside the tasks for which you want to take an action. 
For example, you select the check box beside the tasks with edits that you want to approve.

The Selected list appears.

7. From the Selected list, click More Actions.... 

The More Actions... dialog box appears.

8. To resolve the tasks, select one of the following actions: 

Option Description

Approve If you agree with the edits and the task types permits you to approve changes, click Approve. The 
ActiveVOS® Server marks the related Final Review people activity as completed and performs the next 
activity in the process.

Escalate If you agree with the edits, but the task types does not permit approval at this point in the workflow, 
click Escalate. The ActiveVOS Server marks the related Review No Approve people activity as 
completed and performs the next activity in the process.

Reject If you agree with the edits, but the task types does not permit approval at this point in the workflow, 
click Escalate. The ActiveVOS Server marks the related Review No Approve people activity as 
completed and performs the next activity in the process.

<Other> If you see other options, then your organization uses a custom business process. If the purpose of 
the option is not clear and your role permits access to the ActiveVOS console, you can open the 
process to understand the workflow. Otherwise, contact your MDM administrator.

The ta

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

Resolving Tasks       203



sks are closed.

9. To change the ownership of the tasks without resolving the tasks, select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The tasks are reassigned to the selected person.
Note: If this option is not available, close the More Actions... dialog box. From the More Actions..., 
select Edit, and then select the user from the Assignee list.

Disclaim To return the tasks to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Users with the same role can take action on the tasks.

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

The tasks remain open, but are no longer assigned to you.

10. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

The task panel updates. Based on your changes, some tasks might not appear in the task panel.

Reviewing New Records
Review new records and then resolve the tasks by taking an action. If you cannot resolve the tasks, disclaim 
the tasks to return the tasks to the pool of available tasks. Or, if you know another user who can resolve the 
tasks, reassign the tasks to that user.

Before you begin, claim the tasks that you want to work on.

When you review tasks for new records, all field values in the new record need to be validated.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click My Assigned Tasks. 

The task panel lists your assigned tasks.

3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select a task and determine if the values in the record meet your business requirements. 

5. Repeat step 4 for each new record that you want to review. 

6. Select the check box beside the tasks for which you want to take an action. 
For example, you select the check box beside the tasks for new records that you want to approve.

The Selected list appears.

7. From the Selected list, click More Actions.... 

The More Actions... dialog box appears.

8. To resolve the tasks, select one of the following actions: 
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Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

Option Description

Approve If you think the records are acceptable, and the task types permits you to approve it, click Approve. 
The ActiveVOS Server marks the related Final Review people activity as completed and performs the 
next activity in the process.

Escalate If you think the records are acceptable, but the task types do not permit approval at this point in the 
workflow, click Escalate. The ActiveVOS Server marks the related Review No Approve people activity 
as completed and performs the next activity in the process.

Reject If you disagree with the one or more values in the records, click Reject and type an explanation in the 
Comment box. The ActiveVOS Server notifies the person who added the record.
Note: If a source system updates the rejected record, the record goes through the approval process 
again.

<Other> If you see other options, then your organization uses a custom business process. If the purpose of 
the option is not clear and your role permits access to the ActiveVOS console, you can open the 
process to understand the workflow. Otherwise, contact your MDM administrator.

The tasks are closed.

9. To change the ownership of the tasks without resolving the tasks, select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The tasks are reassigned to the selected person.
Note: If this option is not available, close the More Actions... dialog box. From the More Actions..., 
select Edit, and then select the user from the Assignee list.

Disclaim To return the tasks to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Users with the same role can take action on the tasks.

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

The tasks remain open, but are no longer assigned to you.

10. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

The task panel updates. Based on your changes, some tasks might not appear in the task panel.

Reviewing Merge Tasks
Review merge tasks and then resolve the tasks by taking an action. If you cannot resolve the tasks, disclaim 
the tasks to return the tasks to the pool of available tasks. Or, if you know another user who can resolve the 
tasks, reassign the tasks to that user.

Before you begin, claim the tasks that you want to work on.
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When you review a merge task, the primary record appears beside the records that are selected for the 
merge.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click My Assigned Tasks. 

The task panel lists your assigned tasks.

3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select a merge task, and then review the merge task and determine if the merge is valid. The fields that 
appear in the merge preview are highlighted. 

5. If required, make changes to the proposed merge task. 

a. To change the proposed merge task, perform any of the following tasks: 

Task Procedure

Add records that you want 
to merge.

Click Add Candidate. You can search for records and add the records to the 
view.

Remove records that you do 
not want to merge.

From the Actions menu, select an option:
- Remove Candidate. Removes a manually added record from the review 

panel.
- Not a Match. Removes a system matched record from the review panel 

and dissociates it as a match of the target record.

Finalize the best version of 
the truth.

Select the field with the correct value or enter the correct value in the Merge 
Preview column.

b. Click Update. 

The merge task is updated.

6. Repeat steps 4 through 5 for each merge task that you want to review. 

7. Select the check box beside the tasks for which you want to take an action. 
For example, you select the check box beside the merge tasks that you want to approve.

The Selected list appears.

8. From the Selected list, click More Actions.... 

The More Actions... dialog box appears.

9. To resolve the tasks, select one of the following actions: 
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Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

Option Description

Merge If you agree with the merge proposals and the task types permits you to approve changes, click Merge. 
The ActiveVOS Server marks the related Merge people activity as completed and performs the next 
activity in the process.
Note: If your environment uses the BE ActiveVOS adapter, click Task Actions > Merge. If your 
environment uses the Informatica ActiveVOS adapter, click Actions > Merge.

Cancel If you disagree with the merge proposals, click Cancel and type an explanation in the Comment box. 
The ActiveVOS Server notifies the person who proposed the merge.

<Other> If you see other options, then your organization uses a custom business process. If the purpose of the 
option is not clear and your role permits access to the ActiveVOS console, you can open the process to 
understand the workflow. Otherwise, contact your MDM administrator.

The tasks are closed.

10. To change the ownership of the tasks without resolving the tasks, select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The tasks are reassigned to the selected person.
Note: If this option is not available, close the More Actions... dialog box. From the More Actions..., 
select Edit, and then select the user from the Assignee list.

Disclaim To return the tasks to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Users with the same role can take action on the tasks.

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

The tasks remain open, but are no longer assigned to you.

11. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

The task panel updates. Based on your changes, some tasks might not appear in the task panel.

Reviewing Unmerge Tasks
Review unmerge tasks and then resolve the tasks by taking an action. If you cannot resolve the tasks, 
disclaim the tasks to return the tasks to the pool of available tasks. Or, if you know another user who can 
resolve the tasks, reassign the tasks to that user.

Before you begin, claim the tasks that you want to work on.

When you review an unmerge task, a preview shows the result of the unmerge.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click My Assigned Tasks. 

The task panel lists your assigned tasks.
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3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select an unmerge task, and then review the unmerge preview and determine if the unmerge is 
warranted. The fields that appear in the preview are highlighted. 

5. Repeat step 4 for each unmerge task that you want to review. 

6. Select the check box beside the tasks for which you want to take an action. 
For example, you select the check box beside the unmerge tasks that you want to approve.

The Selected list appears.

7. From the Selected list, click More Actions.... 

The More Actions... dialog box appears.

8. To resolve the tasks, select one of the following actions: 

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

Option Description

Unmerge If you agree with the unmerge proposals and the task types permits you to approve changes, click 
Unmerge. The ActiveVOS Server marks the related Unmerge people activity as completed and 
performs the next activity in the process.

Cancel If you disagree with the unmerge proposals, click Cancel and type an explanation in the Comment 
box. The ActiveVOS Server notifies the person who proposed the unmerge.

<Other> If you see other options, then your organization uses a custom business process. If the purpose of 
the option is not clear and your role permits access to the ActiveVOS console, you can open the 
process to understand the workflow. Otherwise, contact your MDM administrator.

The tasks are closed.

9. To change the ownership of the tasks without resolving the tasks, select one of the following actions: 

Action Description

Reassign To ask another person to review the proposed changes, click Reassign, select the user, and type an 
explanation in the Comment box. The tasks are reassigned to the selected person.
Note: If this option is not available, close the More Actions... dialog box. From the More Actions..., 
select Edit, and then select the user from the Assignee list.

Disclaim To return the tasks to the pool of available tasks, click Disclaim and type an explanation in the 
Comment box. Users with the same role can take action on the tasks.

Note: Only the potential task actions shared by all the tasks appear. For more information, see “Potential 
Task Actions” on page 186.

The tasks remain open, but are no longer assigned to you.

10. If prompted, add comments or attachments to provide additional information. 

Note: Whether you are prompted and required to add a comment or attachment depends on the Data 
Director configuration. A red line appears to indicate required fields.

The task panel updates. Based on your changes, some tasks might not appear in the task panel.
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Organizing Work on Tasks
You can organize tasks by assigning tasks to users, reassigning tasks to other users, or releasing tasks to 
the pool of available tasks. Also, you can edit the details of tasks, including the task title, due date, priority, 
comments, and attachments.

For example, you might want to reassign tasks that are assigned to an user on vacation to another user. Or, 
you might want to change the priority of tasks related to John Smith to high priority.

Assigning Tasks
Assign tasks to users who can work on the tasks. For example, you might want to assign tasks related to the 
John Smith record to a user with knowledge about the record.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. Click Available Tasks. 

The task panel lists all the unassigned tasks for your user group.

3. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

4. Select the check box beside the tasks that you want to manage. 

The Selected list appears.

5. From the Selected list, select Assign. 

The Assign dialog box appears.

6. From the Assignee list, select a user who you want to assign the tasks. 

Note: The Assignee list contains the potential owners shared by all selected tasks. For more information, 
see “Potential Owners” on page 186.

7. Optionally, add a comment. 

8. Click Assign. 

The task panel updates. The tasks appear in the My Open Tasks tab for the assigned user. The user name of 
the assignee appears in the Owner field of the tasks.

Reassigning Tasks
Reassign tasks to other users who can work on the tasks. If you are a task administration, you might want to 
reassign tasks claimed by an user that is unable to work on the tasks. You can only reassign tasks to users 
who are potential owners of the tasks.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. To reassign your assigned tasks, click My Assigned Tasks. 

The task panel lists all your assigned tasks.

3. To reassign assigned tasks, click All Assigned Tasks. 
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The task panel lists all assigned tasks.

4. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

5. Select the check box beside the tasks that you want to manage. 

The Selected list appears.

6. From the Selected list, select Assign. 

The Assign dialog box appears.

7. From the Assignee list, select a user to which you want to reassign the tasks. 

Note: The Assignee list contains the potential owners shared by all selected tasks. For more information, 
see “Potential Owners” on page 186.

8. Optionally, add a comment. 

9. Click Assign. 

The task panel updates. The reassigned tasks appear in the My Open Tasks tab for the assigned user. The 
user name of the assignee appears in the Owner field of the tasks.

Releasing Tasks
Release assigned tasks to the pool of available tasks so other users can work on the tasks. For example, you 
might want to release tasks that you cannot complete before the due date. If you are a task administrator, 
you might want to release all tasks assigned to an user on vacation.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. To release your tasks, click My Assigned Tasks. 

The task panel lists all your assigned tasks.

3. To release all assigned tasks, click All Assigned Tasks. 

The task panel lists all assigned tasks.

4. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

5. Select the check box beside the tasks that you want to manage. 

The Selected list appears.

6. From the Selected list, select Release. 

The Release dialog box appears.

7. Optionally, add a comment. 

8. Click Claim. 

The task panel updates. The tasks appear in the Available Tasks tab for users who are potential owners of 
the tasks. Those users can claim and work on the tasks.
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Editing Task Details
You can edit the details of tasks, such as increasing the priority or changing the due date.

1. Click Task Manager. 

The task panel contains a list of tasks.

2. To edit your assigned tasks, select My Assigned Tasks. 

The task panel lists your assigned tasks.

3. To edit all available tasks, select All Available Tasks. 

The task panel lists all available tasks.

4. Optionally, to find tasks to manage, use custom filters or search. 

• Click the Filters icon, and then add filters.

• In the search box, enter a search term, and then click the search icon.

For more information, see “Finding Tasks” on page 186.

5. From the Selected list, select Edit. 

The Edit dialog box appears.

6. Edit one or more of the following fields to change the task properties of the selected tasks: 

Field Description

Task Title Enter a title that is more meaningful to you. A good title includes at least the name of the 
record and the change that initiated the review.

Priority Select a priority that reflects the urgency within the business to resolve this change.

Due Date Select a due date that reflects the urgency within the business to resolve the change.

Assignee Reassign this task to someone else.
Note: Only potential owners shared by all the selected tasks appear. For more information, see 
“Potential Owners” on page 186.

File Attachment Attach files to provide additional information about the task. Attachments appear in the Task 
Details dialog box.
Note: The File Attachment field is available only if the task supports attachments.

Add Comment Add comments to explain edits to the task properties and to track questions and answers 
about the task. Comments appear in the Comments tab.

7. Click Save. 

The task panel updates. You can view the edited task details in the Task Details dialog box for each task. 
Based on your changes, some tasks might not appear in the task panel.
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C h a p t e r  2 6

Review Processes Reference
This chapter includes the following topics:

• Review Processes Reference Overview, 212

• Update With Approval Workflow, 213

• One Step Approval Workflow, 213

• Two Step Approval Workflow, 214

• Merge Workflow, 214

• Unmerge Workflow, 214

Review Processes Reference Overview
A review process is an automated business process. When a user adds, edits, merges, or unmerges records, 
the action can initiate a review process. A review process ensures that business managers or data stewards 
review and ultimately approve the data before it becomes master data. 

Your user role determines whether a change to the master data triggers a review. For example, if your user 
role permits you to add or edit data but not approve changes, then when you save an edit or merge records, 
the action triggers a review process.

Multidomain MDM ships with the following default review processes:

• Update with Approval Workflow

• One Step Approval Workflow

• Two Step Approval Workflow

• Merge Workflow

• Unmerge Workflow

Note: If you see different process names or task types in your task inbox, someone in your organization has 
changed the review processes or created custom processes.

The following sections describe the purpose of each review process and identify the people activities within 
each process. To view an entire process, open the process in the ActiveVOS Console.
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Update With Approval Workflow
In the Update With Approval Workflow process, a data steward reviews the changed entity before either 
canceling the update or sending the update through a two-step approval process.

The following table summarizes the people activities within the process:

People Activity Role Assigned Description

Update DataSteward A data steward reviews the update and either cancels the update or sends it 
through a two-step approval process.

Review No Approve Manager A manager reviews an update and either rejects it or sends it on for Final 
Review.

Final Review SrManager A senior manager reviews the update and either rejects it or approves it.

Notification DataSteward If approved, the data steward receives a notification that the update is 
approved.

One Step Approval Workflow
The One Step Approval Workflow process requires one senior manager to review and then approve or reject 
the update.

The following table summarizes the people activities within the process:

People Activity Role Assigned Description

Final Review SrManager A senior manager reviews an update and either approves it or rejects it.

Notification DataSteward If the update is approved, the record is flagged for promotion and the data 
steward is notified.

Update DataSteward If the update is rejected, the data steward is notified and can cancel the update.
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Two Step Approval Workflow
The Two Step Approval Workflow process requires at least two business managers to participate in the 
review and approval process.

The following table summarizes the people activities within the process:

People Activity Role Assigned Description

Review No Approve Manager A manager reviews an update and either rejects it or escalates it to Final 
Review.

Final Review SrManager A senior manager reviews the update and either approves it or rejects it.

Notification DataSteward If approved, the record is flagged for promotion and the data steward is 
notified.

Update DataSteward If rejected, the data steward is notified and can cancel the update.

Merge Workflow
When you select merge candidates, you can create a task that initiates the Merge Workflow process in the 
ActiveVOS Server.

The following table describes the people activity within the process:

People Activity Role Assigned Description

Merge DataSteward A data steward reviews the candidates and either merges the records or cancels 
the action.

Unmerge Workflow
When you unmerge records, you can create a task that initiates the Unmerge Workflow process in the 
ActiveVOS Server.

The following table describes the people activity within the process:

People Activity Role Assigned Description

Unmerge DataSteward A data steward reviews the candidate and either unmerges the records or 
cancels the action.
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